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1

Settlement of a circular footing on sand
In this chapter a first application is considered, namely the settlement of a circular foundation footing on sand.
This is the first step in becoming familiar with the practical use of PLAXIS 2D. The general procedures for the
creation of a geometry model, the generation of a finite element mesh, the execution of a finite element
calculation and the evaluation of the output results are described here in detail. The information provided in this
chapter will be utilised in the later tutorials. Therefore, it is important to complete this first tutorial before
attempting any further tutorial examples.
Objectives:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Starting a new project
Creating an axisymmetric model
Creating soil stratigraphy using the Borehole feature
Creating and assigning of material data sets for soil (Mohr-Coulomb model)
Defining prescribed displacements
Creation of footing using the Plate feature
Creating and assigning material data sets for plates
Creating loads
Generating the mesh
Generating initial stresses using the K0 procedure
Defining a Plastic calculation
Activating and modifying the values of loads in calculation phases
Viewing the calculation results
Selecting points for curves
Creating a 'Load - displacement' curve

1.1 Geometry
A circular footing with a radius of 1.0 m is placed on a sand layer of 4.0 m thickness as shown in Figure 1 (on
page 9). Under the sand layer there is a stiff rock layer that extends to a large depth. The purpose of the
exercise is to find the displacements and stresses in the soil caused by the load applied to the footing.
Calculations are performed for both rigid and flexible footings. The geometry of the finite element model for
these two situations is similar. The rock layer is not included in the model; instead, an appropriate boundary
condition is applied at the bottom of the sand layer. To enable any possible mechanism in the sand and to avoid
any influence of the outer boundary, the model is extended in horizontal direction to a total radius of 5.0 m.
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Settlement of a circular footing on sand
Case A: Rigid footing

2.0 m
Load

Footing

y

Sand

4.0 m
x

Figure 1: Geometry of a circular footing on a sand layer

1.2 Case A: Rigid footing
In the first calculation, the footing is considered to be very stiff and rough. In this calculation the settlement of
the footing is simulated by means of a uniform indentation at the top of the sand layer instead of modelling the
footing itself. This approach leads to a very simple model and is therefore used as a first exercise, but it also has
some disadvantages. For example, it does not give any information about the structural forces in the footing. The
second part of this tutorial deals with an external load on a flexible footing, which is a more advanced modelling
approach.

1.2.1 Create a new project
1.

Start PLAXIS 2D by double clicking the icon of the Input program

.

The Quick start dialog box appears in which you can create a new project or select an existing one.

PLAXIS
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Case A: Rigid footing

2. Click Start a new project.
The Project properties window appears with four tabsheets: Project, Model, Constants and Cloud
services

Note:
The first step in every analysis is to set the basic parameters of the finite element model. This is done in the
Project properties window. These settings include the description of the problem, the type of model, the
basic type of elements, the basic units and the size of the drawing area.
To enter the appropriate settings for the footing calculation follow the steps below.
3. In the Project tabsheet, enter Lesson 1 in the Title box and type Settlement of a circular footing
in the Comments box.
4. Click the Next button at the bottom or click the Model tab.
The Model properties are shown:

PLAXIS
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5. In the Type group the type of the model (Model) and the basic element type (Elements) are specified. Since
this tutorial concerns a circular footing, select the Axisymmetry and the 15-Noded options from the Model
and the Elements drop-down menus respectively.
6. In the Contour group set the model dimensions to xmin = 0.0, xmax = 5.0, ymin = 0.0 and ymax = 4.0.
7. Keep the default units in the Constants tabsheet.
8. Click the OK button to confirm the settings.
The project is created with the given properties. The Project properties window closes and the Soil mode view
will be shown, where the soil stratigraphy can be defined.
Note: The project properties can be changed later. You can access the Project properties window by selecting
the corresponding option from the File menu.

1.2.2 Define the soil stratigraphy
In the Soil mode of PLAXIS 2D the soil stratigraphy can be defined.
Information on the soil layers is entered in boreholes. Boreholes are locations in the drawing area at which the
information on the position of soil layers and the water table is given. If multiple boreholes are defined, PLAXIS
2D will automatically interpolate between the boreholes. The layer distribution beyond the boreholes is kept
horizontal. In order to construct the soil stratigraphy follow these steps:
Note: The modelling process is completed in five modes. More information on modes is available in the
1. Click the Create borehole button
in the side (vertical) toolbar to start defining the soil stratigraphy.
2. Click at x = 0 in the drawing area to locate the borehole.
The Modify soil layers window will appear.
3. Add a soil layer by clicking the Add button in the Modify soil layers window.
4. Set the top boundary of the soil layer at y = 4 and keep the bottom boundary at y = 0 m.
5. Set the Head to 2.0 m.
By default the Head value (groundwater head) in the borehole column is set to 0 m.

PLAXIS
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Case A: Rigid footing

Figure 2: Modify soil layers window
Next the material data sets are defined and assigned to the soil layers, see Create and assign material data sets
(on page 12).

1.2.3 Create and assign material data sets
In order to simulate the behaviour of the soil, a suitable soil model and appropriate material parameters must be
assigned to the geometry. In PLAXIS 2D, soil properties are collected in material data sets and the various data
sets are stored in a material database. From the database, a data set can be assigned to one or more soil layers.
For structures (like walls, plates, anchors, geogrids, etc.) the system is similar, but different types of structures
have different parameters and therefore different types of material data sets.PLAXIS 2D distinguishes between
material data sets for Soil and interfaces, Plates, Geogrids, Embedded beam rows and Anchors.
The sand layer that is used in this tutorial has the following properties:
Table 1: Material properties of the sand layer
Name

Value

Unit

Material model

Model

Mohr-Coulomb

-

Type of material behaviour

Type

Drained

-

Soil unit weight above phreatic level

γunsat

17.0

kN/m3

Soil unit weight below phreatic level

γsat

20.0

kN/m3

Parameter
General

Parameters
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Parameter

Name

Value

Unit

Young's modulus (constant)

E'

1.3 · 104

kN/m2

Poisson's ratio

ν'

0.3

-

c'ref

1.0

kN/m2

Friction angle

φ'

30.0

°

Dilatancy angle

ψ

0.0

°

Cohesion (constant)

To create a material set for the sand layer, follow these steps:
1.

Open the Material sets window by clicking the Materials button
the side toolbar.
The Material sets window pops up.

in the Modify soil layers window or in

2. Click the New button at the lower side of the Material sets window.
A new window will appear with these tabsheets: General, Parameters, Groundwater, Thermal, Interfaces
and Initial.
3. In the Material set box of the General tabsheet, write Sand in the Identification box.
The default material model (Mohr-Coulomb) and drainage type (Drained) are valid for this example.
4. Enter the proper values in the General properties box (Figure 3 (on page 14)) according to the material
properties listed in Table 1 (on page 12). Keep parameters that are not mentioned in the table at their default
values.

PLAXIS
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Case A: Rigid footing

Figure 3: The General tabsheet of the Soil window
5. Click the Next button or click the Parameters tab to proceed with the input of model parameters.
The parameters appearing on the Parameters tabsheet depend on the selected material model (in this case
the Mohr-Coulomb model).

Figure 4: The Parameters tabsheet of the Soil window of the Soil and interfaces set type
6. Enter the model parameters of Table 1 (on page 12) in the corresponding edit boxes of the Parameters
tabsheet (Figure 4 (on page 14)). A detailed description of different soil models and their corresponding
parameters can be found in the Material Models Manual.
Note: To understand why a particular soil model has been chosen, see Appendix B of the Material Models
Manual.
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7. The soil material is drained, the geometry model does not include interfaces and the default thermal and
initial conditions are valid for this case, therefore the remaining tabsheets can be skipped. Click OK to
confirm the input of the current material data set.
Now the created data set will appear in the tree view of the Material sets window.
8. Drag the set Sand from the Material sets window (select it and hold down the left mouse button while
moving) to the graph of the soil column on the left hand side of the Modify soil layers window and drop it
there (release the left mouse button).
9. Click OK in the Material sets window to close the database.
10. Click OK to close the Modify soil layers window.
Note:
• Existing data sets may be changed by opening the Material sets window, selecting the data set to be
changed from the tree view and clicking the Edit button. As an alternative, the Material sets window can
be opened by clicking the corresponding button in the side toolbar.
• PLAXIS 2D distinguishes between a project database and a global database of material sets. Data sets may
be exchanged from one project to another using the global database. The global database can be shown in
the Material sets window by clicking the Show global button. The data sets of all tutorials in the Tutorial
Manual are stored in the global database during the installation of the program.
• The material assigned to a selected entity in the model can be changed in the Material drop-down menu
in the Selection explorer. Note that all the material datasets assignable to the entity are listed in the
drop-down menu. However, only the materials listed under Project materials are listed, and not the ones
listed under Global materials.
• The program performs a consistency check on the material parameters and will give a warning message
in the case of a detected inconsistency in the data.

1.2.4 Define the footing
Structural elements and loads are created in the Structures mode of the program. In this exercise a uniform
indentation will be created to model a very stiff and rough footing.
Note:
Visibility of a grid in the drawing area can simplify the definition of geometry. The grid provides a matrix on the
screen that can be used as reference. It may also be used for snapping to regular points during the creation of the
geometry. The grid can be activated by clicking the corresponding button under the drawing area. To define the
size of the grid cell and the snapping options:
Click the Snapping options button
in the bottom toolbar. The Snapping window pops up where the size of
the grid cells and the snapping interval can be specified. The spacing of snapping points can be further divided
into smaller intervals by the Number of snap intervals value. Use the default values in this tutorial.
1. Click the Structures tab to proceed with the input of structural elements in the Structures mode.
2.
in the side toolbar.
Click the Create prescribed displacement button
3.
in the expanded menu.
Select the Create line displacement option
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Settlement of a circular footing on sand
Case A: Rigid footing
4.
5.
6.
7.
8.

In the drawing area move the cursor to point (0 4) and click the left mouse button.
Move along the upper boundary of the soil to point (1 4) and click the left mouse button again.
Click the right mouse button to stop drawing.
In the Selection explorer set the x-component of the prescribed displacement (Displacementx) to Fixed.
Specify a uniform prescribed displacement in the vertical direction by assigning a value of -0.05 to uy,start,ref,
signifying a downward displacement of 0.05 m.

Figure 5: Prescribed displacement in the Selection explorer
The geometry of the model is complete.
When the geometry model is complete, the finite element mesh can be generated. Proceed at Generate the mesh
(on page 16)

1.2.5 Generate the mesh
PLAXIS 2D allows for a fully automatic mesh generation procedure, in which the geometry is divided into
elements of the basic element type and compatible structural elements, if applicable.
The mesh generation takes full account of the position of points and lines in the model, so that the exact position
of layers, loads and structures is accounted for in the finite element mesh. The generation process is based on a
robust triangulation principle that searches for optimised triangles. In addition to the mesh generation itself, a
transformation of input data (properties, boundary conditions, material sets, etc.) from the geometry model
(points, lines and clusters) to the finite element mesh (elements, nodes and stress points) is made.
In order to generate the mesh, follow these steps:
1. Proceed to the Mesh mode by clicking the corresponding tab.
2. Click the Generate mesh button
in the side toolbar.
The Mesh options window pops up. The Medium option is by default selected as element distribution.
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Figure 6: The Mesh options window
3. Click OK to start the mesh generation.
4. As the mesh is generated, click the View mesh button.
A new window is opened displaying the generated mesh. Note that the mesh is automatically refined under
the footing.

Figure 7: The generated mesh in the Output window
5. Click on the Close tab to close the Output program and go back to the Mesh mode of the Input program.
Note:
• By default, the Element distribution is set to Medium. The Element distribution setting can be changed
in the Mesh options window. In addition, options are available to refine the mesh globally or locally (for
more information see the Reference Manual).
• The finite element mesh has to be regenerated if the geometry is modified.
• The automatically generated mesh may not be perfectly suitable for the intended calculation. Therefore it
is recommended that the user inspects the mesh and makes refinements if necessary.
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Once the mesh has been generated, the finite element model is complete.
After the mesh was generated, the calculation phases are defined and the calculation is done, see Initial phase
(on page 18) for instructions.

1.2.6 Define and perform the calculation
The calculation has to be defined in phases before the actual calculation can be performed. This example needs
two phases: the initial phase and one to simulate the settlement of the footing.

Initial phase
The 'Initial phase' always involves the generation of initial conditions. In general, the initial conditions comprise
the initial geometry configuration and the initial stress state, i.e. effective stresses, pore pressures and state
parameters, if applicable.
1. Click the Staged construction tab to proceed with the definition of calculation phases. The Flow conditions
mode may be skipped.
When a new project has been defined, a first calculation phase named ' Initial phase', is automatically created
and selected in the Phases explorer:

All structural elements and loads that are present in the geometry are initially automatically switched off;
only the soil volumes are initially active.
2.

Click the Edit phase button

or double click the phase in the Phases explorer.

In this tutorial lesson the properties of the Initial phase will be described. Below an overview is given of the
options to be defined even though the default values of the parameters are used.
By default the K0 procedure is selected as Calculation type in the General subtree of the
Phases window. This option will be used in this project to generate the initial stresses.
The Staged construction option is available as Loading type.
The Phreatic option is selected by default as the Pore pressure calculation type.
The Ignore temperature option is selected by default as the Thermal calculation type.
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Note: The K0 procedure should be primarily used for horizontally layered geometries with a horizontal
ground surface and, if applicable, a horizontal phreatic level. See the Reference Manual for more information
on the K0 procedure.
The other default options in the Phases window will be used as well in this tutorial.
The Phases window is displayed.

3. Click OK to close the Phases window.
4. In the Model explorer expand the Model conditions subtree.
For deformation problems two types of boundary conditions exist: Prescribed displacement and prescribed
forces (loads). In principle, all boundaries must have one boundary condition in each direction. That is to say,
when no explicit boundary condition is given to a certain boundary (a free boundary), the natural condition
applies, which is a prescribed force equal to zero and a free displacement.
To avoid the situation where the displacements of the geometry are undetermined, some points of the
geometry must have prescribed displacements. The simplest form of a prescribed displacement is a fixity
(zero displacement), but non-zero prescribed displacements may also be given.
5. Expand the Deformations subtree.
Note that the box is checked by default. By default, a full fixity is generated at the base of the geometry,
whereas roller supports are assigned to the vertical boundaries (BoundaryXMin and BoundaryXMax are
normally fixed, BoundaryYMin is fully fixed and BoundaryYMax is free).
6. Expand the Water subtree.
The initial water level has been entered already in the Modify soil layers window. The water level generated
according to the Head value assigned to boreholes in the Modify soil layers window
(BoreholeWaterLevel_1) is automatically assigned to GlobalWaterLevel
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The water level defined according to the Head specified for boreholes is displayed. Note that only the global
water level is displayed in both Phase definition modes. All the water levels are displayed in the model only in
the Flow conditions mode.

Figure 8: Initial phase in the Staged construction mode
Next, the calculation phase for the footing settlement is defined.

Phase 1: Footing
In order to simulate the settlement of the footing in this analysis, a plastic calculation is required. PLAXIS 2D has
a convenient procedure for automatic load stepping, which is called 'Load advancement'. This procedure can be
used for most practical applications. Within the plastic calculation, the prescribed displacements are activated to
simulate the indentation of the footing. In order to define the calculation phase follow these steps:
1.

PLAXIS
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in the Phases explorer.
A new phase, named Phase_1 will be added in the Phases explorer.
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2. Double click Phase_1 to open the Phases window. In the ID box of the General section, write (optionally) an
appropriate name for the new phase (for example Indentation).
The current phase starts from the Initial phase, which contains the initial stress state. The default options
and values assigned are valid for this phase.

Figure 9: The Phases window for the Indentation phase
3. Click OK to close the Phases window.
4. Click the Staged construction tab to enter the corresponding mode.
5. Right-click the prescribed displacement in the drawing area and select the Activate option in the appearing
menu.

Figure 10: Activation of the prescribed displacement in the Staged construction mode
Note: Calculation phases may be added, inserted or deleted using the Add, Insert and Delete buttons in the
Phases explorer or in the Phases window.

Execute the calculation
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Both calculation phases are marked for calculation, as indicated by the blue arrows. The execution order is
controlled by the Start from phase parameter.
1. Click the Calculate button
to start the calculation process. Ignore the warning that no nodes and stress
points have been selected for curves.
During the execution of a calculation, a window appears which gives information about the progress of the
actual calculation phase.

The information, which is continuously updated, shows the calculation progress, the current step number,
the global error in the current iteration and the number of plastic points in the current calculation step. It will
take a few seconds to perform the calculation. When a calculation ends, the window is closed and focus is
returned to the main window.
The phase list in the Phases explorer is updated. A successfully calculated phase is indicated by a check
mark inside a green circle
2.

.

Save the project by clicking the Save button

before viewing results.

Once the calculation has been completed, the results can be displayed in the Output program.

View the calculation results
In the Output program, the displacement and stresses in the full two-dimensional model as well as in cross
sections or structural elements can be viewed. The computational results are also available in tabular form. To
check the applied load that results from the prescribed displacement of 0.05 m:
1. Open the Phases window.
2. For the current application the value of Force-Y in the Reached values subtree is important. This value
represents the total reaction force corresponding to the applied prescribed vertical displacement, which
corresponds to the total force under 1.0 radian of the footing (note that the analysis is axisymmetric). In
order to obtain the total footing force, the value of Force-Y should be multiplied by 2π (this gives a value of
about 588 kN).
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The results can be evaluated in the Output program. In the Output window you can view the displacements
and stresses in the full geometry as well as in cross sections and in structural elements, if applicable. The
computational results are also available in tabulated form. To view the results of the footing analysis, follow
these steps:
3. Select the last calculation phase in the Phases explorer.
4.
Click the View calculation results button
in the side toolbar.
As a result, the Output program is started, showing the deformed mesh at the end of the selected calculation
phase:

Figure 11: Deformed mesh
The deformed mesh is scaled to ensure that the deformations are visible.
5. Select the menu Deformations > Total displacements > |u|.
The plot shows colour shadings of the total displacements. The colour distribution is displayed in the legend
at the right hand side of the plot.
Note: The legend can be toggled on and off by clicking the corresponding option in the View menu.
6. The total displacement distribution can be displayed in contours by clicking the corresponding button
in
the toolbar.
The plot shows contour lines of the total displacements, which are labelled. An index is presented with the
displacement values corresponding to the labels.
7. Click the Arrows button .
The plot shows the total displacements of all nodes as arrows, with an indication of their relative magnitude.
8. Click the menu Stresses > Principal effective stresses > Effective principal stresses.
The plot shows the effective principal stresses at the stress points of each soil element with an indication of
their direction and their relative magnitude:
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Figure 12: Effective principal stresses
9. Click the Table button
on the toolbar.
A new window is opened in which a table is presented, showing the values of the principal stresses and other
stress measures in each stress point of all elements.
Note:
• In addition to the total displacements, the Deformations menu allows for the presentation of Incremental
displacements. The incremental displacements are the displacements that occurred within one calculation
step (in this case the final step). Incremental displacements may be helpful in visualising an eventual failure
mechanism.
• The plots of stresses and displacements may be combined with geometrical features, as available in the
Geometry menu.

1.3 Case B: Flexible footing
The project is now modified so that the footing is modelled as a flexible plate. This enables the calculation of
structural forces in the footing. The geometry used in this exercise is the same as the previous one, except that
additional elements are used to model the footing. The calculation itself is based on the application of load rather
than prescribed displacement. It is not necessary to create a new model; you can start from the previous model,
modify it and store it under a different name. To perform this, follow these steps:

1.3.1 Modify the geometry
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1. In the Input program select the File > Save project as menu. Enter a non-existing name for the current
project file and click the Save button.
2. Go back to the Structures mode. Make sure you are in Select mode by clicking the Select button .
3. Right-click the prescribed displacement and select Line displacement > Delete.

4. In the model right-click the line at the location of the footing. Select Create > Plate.

A plate is created, which simulates the flexible footing.
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5. In the model right-click again the line at the location of the footing and select Create > Line load.

6. In the Selection explorer the default input value of the distributed load is -1.0 kN/m2 in the y-direction. The
input value will later be changed to the real value when the load is activated.

1.3.2 Add material properties for the footing
The material properties for the flexible footing are as follows:
Table 2: Material properties of the footing
Name

Value

Unit

Material type

-

Elastic

-

Isotropic

-

Yes

-

EA1

5 · 10 6

kN/m

Bending stiffness

EI

8.5 · 10 3

kNm2/m

Weight

w

0.0

kN/m/m

Poisson's ratio

ν

0.0

-

Prevent punching

-

No

-

Parameter

Axial stiffness

1.

Click the Materials button
in the side toolbar.
2. In the Material sets window, from the Set type drop-down menu, select Plates.
3. Click the New button.
A new window appears where the properties of the footing can be entered.

PLAXIS

26

PLAXIS 2D - Tutorial Manual

Settlement of a circular footing on sand
Case B: Flexible footing
4. Type Footing in the Identification box. The Elastic option is selected by default for the material type. Keep
this option for this example.
5. Enter the properties as listed in Table 2 (on page 26). Keep parameters that are not mentioned in the table at
their default values.
6. Note: The equivalent thickness is automatically calculated by PLAXIS 2D from the values of EA and EI. It
cannot be defined manually.
Click OK.
The new data set now appears in the tree view of the Material sets window.
7. Drag the set called Footing to the drawing area and drop it on the footing. Note that the shape of the cursor
changes to indicate that it is valid to drop the material set.
Note: If the Material sets window is displayed over the footing and hides it, click on its header and drag it to
another position.
8. Click OK to close the materials database.

1.3.3 Generate the mesh
In order to generate the mesh, follow these steps:
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Medium (default).
3. Click the View mesh button
to view the mesh.
4. Click the Close tab to close the Output program.
Note: Regeneration of the mesh results in a redistribution of nodes and stress points.

1.3.4 Calculations
1. Proceed to the Staged construction mode.
2. Leave the initial phase as is. The initial phase is the same as in the previous case.
3. Double-click the following phase (Phase_1) and enter an appropriate name for the phase ID. Keep the
Calculation type as Plastic and keep the Loading type as Staged construction.
4. Close the Phases window.
5. In the Staged construction mode activate the load and plate.
The model is shown as:
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Figure 13: Active plate and load in the model
6. In the Selection explorer assign -188 kN/m2 to the vertical component of the line load. Note that, this gives a
total load that is approximately equal to the footing force that was obtained from the first part of this tutorial.
(188 kN/m2 · π ·(1.0 m)2 ≈ 590 kN).

Figure 14: Definition of the load components in the Selection explorer
7. No changes are required in the Flow conditions tabsheet.
The calculation definition is now complete. Before starting the calculation it is advisable to select nodes or
stress points for a later generation of load-displacement curves or stress and strain diagrams. To do this,
follow these steps:
8. Click the Select points for curves button
in the side toolbar.
As a result, all the nodes and stress points are displayed in the model in the Output program. The points can
be selected either by directly clicking on them or by using the options available in the Select points window.
9. In the Select points window enter (0.0 4.0) for the coordinates of the point of interest and click Search
closest.
The nodes and stress points located near that specific location are listed.
10. Select the node at exactly (0.0 4.0) by checking the box in front of it. The selected node is indicated by Node
4* in the model when the Selection labels option is selected in the Mesh menu.
Note: Instead of selecting nodes or stress points for curves before starting the calculation, points can also be
selected after the calculation when viewing the output results. However, the curves will be less accurate since
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only the results of the saved calculation steps will be considered. To select the desired nodes by clicking on
them, it may be convenient to use the Zoom in option

on the toolbar to zoom into the area of interest.

11. Click the Update button on the top left to return to the Input program.
12. Check if both calculation phases are marked for calculation by a blue arrow . If this is not the case click the
symbol of the calculation phase or right-click and select Mark for calculation from the pop-up menu.
13. Click the Calculate button
to start the calculation.
14. Click the Save button

to save the project after the calculation has finished.

1.3.5 View the calculation results
1. After the calculation the results of the final calculation step can be viewed by clicking the View calculation
results button . Select the plots that are of interest. The displacements and stresses should be similar to
those obtained from the first part of the exercise.
2. Click the Select structures button
in the side toolbar and double click the footing.
A new window opens in which either the displacements or the bending moments of the footing may be
plotted (depending on the type of plot in the first window).
3. Note that the menu has changed. Select the various options from the Forces menu to view the forces in the
footing.
Note: Multiple (sub-)windows may be opened at the same time in the Output program. All windows appear in
the list of the Window menu. PLAXIS 2D follows the Windows standard for the presentation of sub-windows
(Cascade, Tile, Minimize, Maximize, etc).

1.3.6 Generate a load-displacement curve
In addition to the results of the final calculation step it is often useful to view a load-displacement curve. In order
to generate the load-displacement curve, follow these steps:
1. Click the Curves manager button
in the toolbar.
The Curves manager window pops up.
2. In the Charts tabsheet, click New.
The Curve generation window pops up.
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Figure 15: Curve generation window
3. For the x-axis, select Node 4* (0.00 / 4.00) from the drop-down menu. Select the Deformations > Total
displacements > |u|.
4. For the y-axis, select the Project option from the drop-down menu. Select the Multipliers > Σ Mstage option.
Σ Mstage is the proportion of the specified changes that has been applied. Hence the value will range from 0
to 1, which means that 100% of the prescribed load has been applied and the prescribed ultimate state has
been fully reached.
5. Click OK to accept the input and generate the load-displacement curve.
As a result the curve of is plotted:

Figure 16: Load-displacement curve for the footing
Note:
You can re-enter the Settings window (in the case of a mistake, a desired regeneration or modification) by:
• Double click the curve in the legend of the chart OR
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• Select the menu Format > Settings.
The properties of the chart can be modified in the Chart tab sheet whereas the properties curve can be modified
in the corresponding tab sheet.
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Submerged construction of an excavation
This tutorial illustrates the use of PLAXIS 2D for the analysis of submerged construction of an excavation. Most
of the program features that were used in Tutorial 1 will be utilised here again. In addition, some new features
will be used, such as the use of interfaces and anchor elements, the generation of water pressures and the use of
multiple calculation phases. The new features will be described in full detail, whereas the features that were
treated in Tutorial 1 will be described in less detail. Therefore it is suggested that Tutorial 1 should be
completed before attempting this exercise.
Objectives
•
•
•
•
•
•

Modelling soil-structure interaction using the Interface feature.
Advanced soil models (Soft Soil model and Hardening Soil model).
Undrained (A) drainage type.
Defining Fixed-end-anchor.
Creating and assigning material data sets for anchors.
Simulation of excavation (cluster de-activation).

Geometry
This tutorial concerns the construction of an excavation close to a river. The submerged excavation is carried out
in order to construct a tunnel by the installation of prefabricated tunnel segments which are 'floated' into the
excavation and 'sunk' onto the excavation bottom. The excavation is 30 m wide and the final depth is 20 m. It
extends in longitudinal direction for a large distance, so that a plane strain model is applicable. The sides of the
excavation are supported by 30 m long diaphragm walls, which are braced by horizontal struts at an interval of 5
m. Along the excavation a surface load is taken into account. The load is applied from 2 m from the diaphragm
wall up to 7 m from the wall and has a magnitude of 5 kN/m2/m.
The upper 20 m of the subsoil consists of soft soil layers, which are modelled as a single homogeneous clay layer.
Underneath this clay layer there is a stiffer sand layer, which extends to a large depth. 30 m of the sand layer are
considered in the model.
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Figure 17: Geometry model of the situation of a submerged excavation
Since the geometry is symmetric, only one half (the left side) is considered in the analysis. The excavation
process is simulated in three separate excavation stages. The diaphragm wall is modelled by means of a plate,
such as used for the footing in the previous tutorial. The interaction between the wall and the soil is modelled at
both sides by means of interfaces. The interfaces allow for the specification of a reduced wall friction compared
to the friction in the soil. The strut is modelled as a spring element for which the normal stiffness is a required
input parameter.

2.1 Create new project
1.
2.
3.
4.
5.
6.

Start PLAXIS 2D by double clicking the icon of the Input program
.
Click Start a new project.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet keep the default options for Model (Plane strain}, and Elements (15-Node).
Set the model Contour to xmin = 0.0 m, xmax = 65.0 m, ymin = -30.0 m and ymax = 20.0.
Keep the default values for units and constants and click OK.

The project is created with the given properties. The Project properties window closes and the Soil mode view
will be shown, where the soil stratigraphy can be defined.
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2.2 Define the soil stratigraphy
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Add the top soil layer and specify its height by setting the top level to 20 m and the bottom level to 0 m.
3. Add the bottom soil layer and specify its height by keeping the top level at 0 m and by setting the bottom
level to -30 m.
4. Set the Head in the borehole to 18.0 m.
Next the material data sets are defined and assigned to the soil layers, see Create and assign material data sets
(on page 12).

2.3 Create and assign material data sets
Two data sets need to be created; one for the clay layer and one for the sand layer.
The layers have the following properties:
Table 3: Material properties of the sand and clay layer and the interfaces
Name

Clay

Sand

Unit

Material model

Model

Soft soil

Hardening soil

-

Type of material behaviour

Type

Undrained (A)

Drained

-

Soil unit weight above phreatic level

γunsat

16.0

17

kN/m3

Soil unit weight below phreatic level

γsat

18

20

kN/m3

Initial void ratio

einit

1.0

0.5

-

Modified compression index

λ*

3.0 · 10-2

-

-

Modified swelling index

κ*

8.5 · 10-3

-

-

E50ref

-

4.0 · 104

kN/m2

Parameter
General

Parameters

Secant stiffness in standard drained triaxial test
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Parameter

Name

Clay

Sand

Unit

Tangent stiffness for primary oedometer loading

Eoedref

-

4.0 · 104

kN/m2

Unloading / reloading stiffness

Eurref

-

1.2 · 105

kN/m2

m

-

0.5

-

cref'

1.0

0.0

kN/m2

Friction angle

φ'

25

32

°

Dilatancy angle

ψ

0.0

2.0

°

Poisson's ratio

νur'

0.15

0.2

-

K0-value for normal consolidation

K0nc

0.5774

0.4701

-

Permeability in horizontal direction

kx

0.001

1.0

m/day

Permeability in vertical direction

ky

0.001

1.0

m/day

-

Manual

Manual

-

Rinter

0.5

0.67

-

-

Automatic

Automatic

-

Over-consolidation ratio

OCR

1.0

1.0

-

Pre-overburden pressure

POP

5.0

0.0

kN/m2

Power for stress-level dependency of stiffness
Cohesion (constant)

Groundwater

Interfaces
Interface strength
Strength reduction factor
Initial
K0 determination

To create the material sets, follow these steps:
1.

2.
3.
4.
5.
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Click the Materials button
in the Modify soil layers window.
The Material sets window pops up, where the Soil and interfaces option is selected by default as the Set
type.
Click the New button in the Material sets window to create a new data set.
For the clay layer, enter Clay for the Identification and select Soft soil as the Material model. Set the
Drainage type to Undrained (A).
Enter the properties of the clay layer, as listed in Table 3 (on page 34), in the General, Parameters and Flow
parameters tabsheets.
Click the Interfaces tab. Select the Manual option in the Strength drop-down menu. Enter a value of 0.5 for
the parameter Rinter.
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This parameter relates the strength of the soil to the strength in the interfaces, according to the equations:
tan ( φinterface ) = Rinter tan ( φsoil ) and cinter = Rinter csoil where: csoil = cref , see Table 3 (on page 34)

6.
7.
8.
9.
10.

Hence, using the entered Rinter-value gives a reduced interface friction (wall frictions) and interface cohesion
(adhesion) compared to the friction angle and the cohesion in the adjacent soil.
In the Initial tabsheet keep the default option for the K0 determination and the default value for the
overconsolidation ratio (OCR). Set the pre-overburden pressure (POP) value to 5.0.
For the sand layer, enter Sand for the Identification and select Hardening soil as the Material model. The
material type should be set to Drained.
Enter the properties of the sand layer, as listed in Table 3 (on page 34), in the corresponding edit boxes of the
General and Parameters tabsheet.
Click the Interfaces tab. In the Strength box, select the Manual option. Enter a value of 0.67 for the
parameter Rinter. Close the data set.
Assign the material datasets to the corresponding soil layers.
• When the Rigid option is selected in the Strength drop-down, the interface has the same strength
properties as the soil (Rinter = 1.0).
• Note that a value of Rinter < 1.0 , reduces the strength as well as the stiffness of the interface (for more info
see the corresponding section in the Reference Manual.
• Instead of accepting the default data sets of interfaces, data sets can directly be assigned to interfaces by
selecting the proper data set in the Material mode drop-down menu in the Object explorers.

2.4 Define the structural elements
The creation of diaphragm walls, strut, surface load and excavation levels is described below.
1. Click the Structures tab to proceed with the input of structural elements in the Structures mode.

2.4.1 To define the diaphragm wall:
A diaphragm wall with the following material properties has to be defined:
Table 4: Material properties of the diaphragm wall (plate)
Name

Value

Unit

Material type

-

Elastic

-

Isotropic

-

Isotropic

-

Axial stiffness

EA

7.5 · 10 6

kN/m

Bending stiffness

EI

1.0 · 10 6

kNm2/m

Parameter
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Parameter

Name

Value

Unit

Weight

w

10.0

kN/m/m

Poisson's ratio

ν

0.0

-

Prevent punching

-

No

-

1. Click the Create structure button in the side toolbar.
2. In the expanded menu select the Create plate.

3. In the drawing area move the cursor to position (50.0 20.0) at the upper horizontal line and click. Move 30 m
down (50.0 -10.0) and click. Click the right mouse button to finish the drawing.
4. Click the Show materials button
in the side toolbar. Set the Set type parameter in the Material sets
window to Plates and click the New button. Enter Diaphragm wall as an Identification of the data set and
enter the properties as given in Table 4 (on page 36).
5. Click OK to close the data set.
6. Drag the Diaphragm wall data set to the wall in the geometry and drop it as soon as the cursor indicates that
dropping is possible.
7. Click OK to close the Material sets window.
Note: In general, only one point can exist at a certain coordinate and only one line can exist between two
points. Coinciding points or lines will automatically be reduced to single points or lines. More information is
available in the Reference Manual

2.4.2 To define the interfaces:
1. Right-click the plate representing the diaphragm wall.
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Figure 18: Positive interface assignment to existing geometry
2. Select Create > Positive interface.
3. In the same way assign a negative interface as well.
Note:
• In order to identify interfaces at either side of a geometry line, a positive sign ( ⊕ ) or negative sign (⊖ )
is added. This sign has no physical relevance or influence on the results.
• A Virtual thickness factor can be defined for interfaces. This is a purely numerical value, which can be
used to optimise the numerical performance of the interface. To define it, select the interface in the
drawing area and specify the value to the Virtual thickness factor parameter in the Selection explorer.
Non-experienced users are advised not to change the default value. For more information about interface
properties see the Reference Manual - Chapter 5 - Advanced Geometric Modelling options.

2.4.3 To define the excavation levels:
1. Click the Create line button in the side toolbar.
2. To define the first excavation stage move the cursor to position (50.0 18.0) at the wall and click. Move the
cursor 15 m to the right (65.0 18.0) and click again. Click the right mouse button to finish drawing the first
excavation stage.
3. To define the second excavation stage move the cursor to position (50.0 10.0) and click. Move to (65.0 10.0)
and click again. Click the right mouse button to finish drawing the second excavation stage.
4. The third excavation stage is automatically defined as it corresponds to the boundary between the soil layers
(y = 0.0).

2.4.4 To define the strut:
You will define a strut with the following material properties:
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Table 5: Material properties of the strut (anchor)
Parameter

Name

Strut

Unit

Material type

-

Elastic

-

Axial stiffness

EA

2 · 10 6

kN

Lspacing

5.0

m

Out-of-plane spacing
1.

Click the Create structure button in the side toolbar and select the Create fixed-end anchor
in the
expanded menu.
2. Move the cursor to (50.0 19.0) and click the left mouse button. A fixed-end anchor is is added, being
represented by a rotated T with a fixed size.
3.
in the side toolbar. Set the Set type parameter in the Material sets
Click the Show materials button
window to Anchor and click the New button. Enter Strut as an Identification of the data set and enter the
properties as given in Table 5 (on page 39). Click OK to close the data set.
4. Click OK to close the Material sets.
5. Make sure that the fixed-end anchor is selected in the drawing area.
6. In the Selection explorer assign the material data set to the strut by selecting the corresponding option in
the Material drop-down menu.
The anchor is oriented in the model according to the Directionx and Directiony parameters in the Selection
explorer. The default orientation is valid in this tutorial.

Figure 19: Parameters for fixed-end anchors in the Selection explorer
7. Enter an Equivalent length of 15 m corresponding to half the width of the excavation.
Note: The Equivalent length is the distance between the connection point and the position in the direction
of the anchor rod where the displacement is zero.

2.4.5 To define the distributed load:
1.
2.

PLAXIS

Click the Create load button

in the side toolbar

Select the Create line load option

in the expanded menu to define a distributed load.
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3. Move the cursor to (43.0 20.0) and click move the cursor 5m to the right to (48.0 20.0) and click again. Rightclick to finish the drawing.
4. In the Selection explorer assign a value of -5 kN/m/m to the y-component of the load (qy,start,ref).

Figure 20: Components of the distributed load in the Selection explorer

2.5 Generate the mesh
In order to generate the mesh, follow these steps:
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Medium (default).
3. Click the View mesh button
to view the mesh.

Figure 21: The generated mesh
4. Click the Close tab to close the Output program.
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2.6 Define and perform the calculation
In practice, the construction of an excavation is a process that can consist of several phases. First, the wall is
installed to the desired depth. Then some excavation is carried out to create space to install an anchor or a strut.
Then the soil is gradually removed to the final depth of the excavation. Special measures are usually taken to
keep the water out of the excavation. Props may also be provided to support the retaining wall.
In PLAXIS 2D, these processes can be simulated with the Staged construction loading type available in the
General subtree of the Phases window. It enables the activation or deactivation of weight, stiffness and strength
of selected components of the finite element model. Note that modifications in the Staged construction mode of
the program are possible only for this type of loading. The current tutorial explains the use of this powerful
calculation option for the simulation of excavations.

2.6.1 Initial phase
1. Click the Staged construction tab to proceed with the definition of calculation phases.
The initial phase has already been created.
2. Keep its calculation type as K0 procedure. Make sure all the soil volumes are active and all the structural
elements and load are inactive.

2.6.2 Phase 1: External load
1. In the Phases explorer click the Add phase button
to create a new phase.
The default settings are valid for this phase. In the model the full geometry is active except for the wall,
interfaces, strut and load.
2. Click the Select multiple objects button in the side toolbar. In the appearing menu select Select line >
Select plates.
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3. In the drawing area define a rectangle that includes all the plate elements.

4. Right-click the wall in the drawing area and select the Activate option from the context menu.
The wall is now visible in the color that is specified in the material dataset.
5. Right-click the distributed load to activate it and select the Activate option from the appearing menu.
The load has been defined in the Structures mode as -5 kN/m/m. The value can be checked in the Selection
explorer.
6. Make sure all the interfaces in the model are active.
Note: The selection of an interface is done by right-clicking the corresponding geometry line and subsequently
selecting the corresponding interface (positive or negative) from the context menu.

2.6.3 Phase 2: First excavation stage
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1.

Click the Add phase button
in the Phases explorer.
A new calculation phase appears in the Phases explorer. Note that the program automatically presumes that
the current phase should start from the previous one and that the same objects are active.
Note: To copy the settings of the parent phase, select the phase in the Phases explorer and then click the Add
phase button. Note that the settings of the parent phase are not copied when it is specified by selecting it in
the Start from phase drop-down menu in the Phases window.

2. The default settings are valid for this phase. In the Staged construction mode all the structure elements
except the fixed-end anchor are active.
3. In the drawing area right-click the top right cluster and select the Deactivate option in the appearing menu.
The model for the first excavation phase looks like this:

Figure 22: Model view for the first excavation phase

2.6.4 Phase 3: Installation of a strut
1.

Click the Add phase button
in the Phases explorer.
2. Activate the strut.
The strut turns black to indicate it is active.

2.6.5 Phase 4: Second (submerged) excavation stage
1.

PLAXIS

Click the Add phase button

to add a new phase.
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2. Deactivate the second cluster from the top on the right side of the mesh. It should be the topmost active
cluster.
Note: Note that in PLAXIS 2D the pore pressures are not automatically deactivated when deactivating a soil
cluster. Hence, in this case, the water remains in the excavated area and a submerged excavation is simulated.
The result is this model:

Figure 23: Model view for the second excavation phase

2.6.6 Phase 5: Third excavation stage
In the final calculation stage the excavation of the last clay layer inside the pit is simulated.
1.

Click the Add phase button
to add a new phase.
2. Deactivate the third cluster from the top on the right hand side of the mesh.
The model for the phase looks like this:
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Figure 24: Model view for the third excavation phase
The calculation definition is now complete.

2.6.7 Execute the calculation
Before starting the calculation it is suggested that you select nodes or stress points for a later generation of loaddisplacement curves or stress and strain diagrams. To do this, follow the steps given below.
1. Click the Select points for curves button
in the side toolbar.
The connectivity plot is displayed in the Output program and the Select points window is activated.
2. Select some nodes on the wall at points where large deflections can be expected (e.g. 50.0 10.0). The nodes
located near that specific location are listed. Select the convenient one by checking the box in front of it in the
list.
3. Close the Select points window.
4. Click on the Update tab to close the Output program and go back to the Input program.
5. Click the Calculate button
to calculate the project.
During a Staged construction calculation phase, a multiplier called ΣMstage is increased from 0.0 to 1.0. This
parameter is displayed in the calculation info window. As soon as ΣMstage has reached the value 1.0, the
construction stage is completed and the calculation phase is finished. If a Staged construction calculation
finishes while ΣMstage is smaller than 1.0, the program will give a warning message. The most likely reason for
not finishing a construction stage is that a failure mechanism has occurred, but there can be other causes as well.
See the for more information about Staged construction.

2.7 View the calculation results

PLAXIS

45

PLAXIS 2D - Tutorial Manual

Submerged construction of an excavation
View the calculation results
In addition to the displacements and the stresses in the soil, the Output program can be used to view the forces
in structural objects. To examine the results of this project, follow these steps:

2.7.1 Displacements and stresses
To view displacements and stresses, follow these steps:
1. Click the final calculation phase in the Calculations window.
2. Click the View calculation results button
on the toolbar.
As a result, the Output program is started, showing the deformed mesh (scaled up) at the end of the selected
calculation phase, with an indication of the maximum displacement:

Figure 25: Deformed mesh after the third excavation stage
Note:
In the Output program, the display of the loads, fixities and prescribed displacements applied in the model
can be toggled on/off by clicking the corresponding options in the Geometry menu.
3. Select the menu Deformations > Incremental displacements > |Δu|.
The plot shows colour shadings of the displacement increments, which indicates the forming of a mechanism
of soil movement behind the wall.
4. Click the Arrows button
in the toolbar.
The plot shows the displacement increments of all nodes as arrows. The length of the arrows indicates the
relative magnitude.
5. Select the menu Stresses > Principal effective stresses > Effective principal stresses.
The plot shows the effective principal stresses at the three middle stress points of each soil element with an
indication of their direction and their relative magnitude. Note that the Center principal stresses button is
selected in the toolbar. The orientation of the principal stresses indicates a large passive zone under the
bottom of the excavation and a small passive zone behind the strut.
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Figure 26: Principal stresses after excavation

2.7.2 Shear forces and bending moments
To plot the shear forces and bending moments in the wall follow the steps given below.
1. Double-click the wall.
A new window is opened showing the axial force.
2. Select the menu Forces > bending moment M.
The bending moment in the wall is displayed with an indication of the maximum moment:

Figure 27: Bending moments in the wall
3. Select Shear forces Q from the Forces menu.
The plot now shows the shear forces in the wall.
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Note: The Window menu may be used to switch between the window with the forces in the wall and the
stresses in the full geometry. This menu may also be used to Tile or Cascade the two windows, which is a
common option in a Windows environment.
4. Select the first window (showing the effective stresses in the full geometry) from the Window menu. Doubleclick the strut.
The strut force (in kN) is shown in the displayed table.
5. Click the Curves manager button on the toolbar.
As a result, the Curves manager window pops up.
6. Click New to create a new chart.
The Curve generation window pops up.
7. For the x-axis select the point A from the drop-down menu. In the tree select Deformations - Total
displacements - |u|.
8. For the y-axis keep the Project option in the drop-down menu. In the tree select Multiplier - ΣMstage.
9. Click OK to accept the input and generate the load-displacement curve.
As a result the curve is plotted:

Figure 28: Load-displacement curve of deflection of wall
The curve shows the construction stages. For each stage, the parameter ΣMstage changes from 0.0 to 1.0. The
decreasing slope of the curve in the last stage indicates that the amount of plastic deformation is increasing. The
results of the calculation indicate, however, that the excavation remains stable at the end of construction.
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Dry excavation using a tie back wall
This example involves the dry construction of an excavation. The excavation is supported by concrete diaphragm
walls. The walls are tied back by prestressed ground anchors.
PLAXIS 2D allows for a detailed modelling of this type of problem. It is demonstrated in this example how
ground anchors are modelled and how prestressing is applied to the anchors. Moreover, the dry excavation
involves a groundwater flow calculation to generate the new water pressure distribution. This aspect of the
analysis is explained in detail.
Objectives
•
•
•
•

Modelling ground anchors.
Generating pore pressures by groundwater flow.
Displaying the contact stresses and resulting forces in the model.
Scaling the displayed results.

Geometry
The excavation is 20 m wide and 10 m deep. 16 m long concrete diaphragm walls of 0.35 m thickness are used to
retain the surrounding soil. Two rows of ground anchors are used at each wall to support the walls. The anchors
have a total length of 14.5 m and an inclination of 33.7°(2:3). On the left side of the excavation a surface load of
10 kN/m2 is taken into account.
The relevant part of the soil consists of three distinct layers. From the ground surface to a depth of 23 m there is
a fill of relatively loose fine sandy soil. Underneath the fill, down to a minimum depth of 15 m, there is a more or
less homogeneous layer consisting of dense well-graded sand. This layer is particular suitable for the installation
of the ground anchors. The underlying layer consists of loam and lies to a large depth. 15 m of this layer is
considered in the model.
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Ground anchor
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4m
3m
5m

Final excavation level

Loam

Figure 29: Excavation supported by tie back walls

3.1 Create new project
1.
2.
3.
4.
5.

Start the Input program and select Start a new project from the Quick start dialog box.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-Node).
Set the model Contour to xmin = 0.0 m, xmax = 100.0 m, ymin = 0.0 m, ymax = 30.0 m.
Keep the default values for units and the constants and press OK to close the Project properties window.

3.2 Define the soil stratigraphy
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Add three soil layers to the borehole. Locate the ground level at y = 30 m by assigning 30 to the Top level of
the uppermost layer. The bottom levels of the layers are located at 27, 15 and 0 m, respectively.
3. Set the Head to 23 m.
The layer stratigraphy looks like this:
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Figure 30: The Modify soil layers window

3.3 Create and assign material data sets
Three data sets need to be created. The materials have the following properties:
Table 6: Soil and interface properties
Parameter

Name

Silt

Sand

Loam

Unit

General
Material model

Model

Hardening soil Hardening soil Hardening soil

-

Type of material behaviour

Type

Drained

Drained

Drained

-

Soil unit weight above phreatic level

γunsat

16

17

17

kN/m3

Soil unit weight below phreatic level

γsat

20

20

19

kN/m3

Secant stiffness in standard drained
triaxial test

E50ref

2.0 · 104

3.0 · 104

1.2 · 104

kN/m2

Tangent stiffness for primary oedometer
loading

Eoedref

2.0 · 104

3.0 · 104

8.0 · 103

kN/m2

Unloading / reloading stiffness

Eurref

6.0 · 104

9.0 · 104

3.6 · 104

kN/m2

m

0.5

0.5

0.8

-

Parameters

Power for stress-level dependency of
stiffness
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Parameter

Name

Silt

Sand

Loam

Unit

cref'

1.0

0.0

5.0

kN/m2

Friction angle

φ'

30

34

29

°

Dilatancy angle

ψ

0.0

4.0

0.0

°

Poisson's ratio

νur'

0.2

0.2

0.2

-

K0-value for normal consolidation

K0nc

0.5

0.4408

0.5152

-

Data set

-

USDA

USDA

USDA

-

Model

-

Soil type

-

Silt

Sand

Loam

-

< 2μm

-

6.0

4.0

20.0

%

2μm - 50μm

-

87.0

4.0

40.0

%

50μm - 2mm

-

7.0

92.0

40.0

%

Flow parameters - Use defaults

-

From data set

From data set

From data set

-

Manual

Manual

Rigid

-

Rinter

0.65

0.70

1.0

-

-

Automatic

Automatic

Automatic

-

Over-consolidation ratio

OCR

1.0

1.0

1.0

-

Pre-overburden pressure

POP

0.0

0.0

25.0

kN/m2

Cohesion (constant)

Groundwater

Van Genuchten Van Genuchten Van Genuchten

-

Interfaces
Interface strength
Strength reduction factor
Initial
K0 determination

1. Define three data sets for soil and interfaces with the parameters given in Table 6 (on page 51).
2. Assign the material data sets to the corresponding soil layers (Figure 30 (on page 51)).

3.4 Define the structural elements
The creation of diaphragm walls, excavation levels, ground anchor and surface load is described below.
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1. Click the Structures tab to proceed with the input of structural elements in the Structures mode.

3.4.1 To define the diaphragm wall and interfaces:
A diaphragm wall with the following material properties has to be defined:
Table 7: Material properties of the diaphragm wall (plate)
Parameter

Name

Value

Unit

Material type

-

Elastic

-

Isotropic

-

Yes

-

EA1

1.2 · 10 7

kN/m

Bending stiffness

EI

1.2 · 10 5

kNm2/m

Weight

w

8.3

kN/m/m

Poisson's ratio

ν

0.15

-

Prevent punching

-

Yes

-

Axial stiffness

1. In the Structures mode, model the diaphragm walls as plates passing through (40.0 30.0) - (40.0 14.0) and
(60.0 30.0) - (60.0 14.0).
2. Multi-select the plates in the model.
3. In the Selection explorer click on Material.
The view will change displaying a drop-down menu and a plus button next to it:

Figure 31: Material assignment in the Selection explorer
4. Click the Add button .
A new empty material set is created for plates.
5. Define the material data set for the diaphragm walls according to the properties are listed in Table 7 (on page
53). The concrete has a Young's modulus of 35 GN/m2 and the wall is 0.35 m thick.
6. Assign positive and negative interfaces to the geometry lines created to represent the diaphragm walls.
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3.4.2 To define the excavation levels:
The soil is excavated in three stages. The first excavation layer corresponds to the bottom of the silt layer and it
is automatically created. To define the remaining excavation stages:
1. Define the second excavation phase by drawing a line through (40.0 23.0) and (60.0 23.0).
2. Define the third excavation phase by drawing a line through (40.0 20.0) and (60.0 20.0).

3.4.3 Defining the ground anchor
A ground anchor can be modelled by a combination of a node-to-node anchor and an embedded beam. The
embedded pile simulates the grouted part of the anchor whereas the node-to-node anchor simulates the free
length. In reality there is a complex three-dimensional state of stress around the grout body which cannot be
simulated in a 2D model.
The coordinates and material properties of the anchor and grout body are listed in the tables below.
Table 8: Node to node anchor coordinates
Anchor location

Name

First point

Second point

Top

Left

(40.0 27.0)

(31.0 21.0)

Right

(60.0 27.0)

(69.0 21.0)

Left

(40.0 23.0)

(31.0 17.0)

Right

(60.0 23.0)

(69.0 17.0)

Bottom

Table 9: Properties of the anchor rod (node-to-node anchor)
Parameter

Name

Value

Unit

Material type

-

Elastic

-

Axial stiffness

EA

5.0 · 10 5

kN

Out-of-plane spacing

Ls

2.5

m

Name

First point

Second point

Left

(31.0 21.0)

(28.0 19.0)

Table 10: Grout coordinates
Anchor location
Top
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Anchor location

Name

First point

Second point

Right

(69.0 21.0)

(72.0 19.0)

Left

(31.0 17.0)

(28.0 15.0)

Right

(69.0 17.0)

(72.0 15.0)

Name

Value

Unit

Material type

-

Elastic

-

Stiffness

E

7.07 · 106

kN/m2

Unit weight

γ

0

kN/m3

Beam type

-

Predefined

-

Predefined beam type

-

Solid circular beam

-

Diameter

D

0.3

m

Lspacing

2.5

m

Tskin, start, max

400

kN/m

Tskin, end, max

400

kN/m

Fmax

0

kN

Default values

Yes

-

Bottom

Table 11: Properties of the grout body (embedded beam rows)
Parameter

Pile spacing
Skin resistance

Base resistance
Interface stiffness factor
1.
2.
3.
4.
5.
6.

PLAXIS

Define the node-to-node anchors
according to Table 8 (on page 54).
Create an Anchor material data set according to the parameters specified in Table 9 (on page 54).
Multi-select the anchors in the drawing area. Assign the material data set by selecting the corresponding
option in the Material drop-down menu in the Selection explorer.
Define the grout body using the Embedded beam row button according to Table 10 (on page 54).
Create the Grout material data set according to the parameters specified in Table 11 (on page 55) and assign
it to the grout body.
Set the Behaviour of the embedded beam rows to Grout body
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Figure 32: Embedded beam rows in the Selection explorer
The connection with the anchor will be automatically established.
7. Multi-select (keep <Ctrl> pressed while selecting) the top node-to-node anchors and embedded beams.
Right-click and select the Group option in the context menu.
8. In the Model explorer expand the Groups subtree.
Note that a group is created composed of the elements of the top ground anchors.
9. Click on Group_1 in the Model explorer and type a new name (e.g GroundAnchor_Top).
10. Follow the same steps to create a group and to rename the bottom ground anchors.
Although the precise stress state and interaction with the soil cannot be modelled with this 2D model, it is
possible in this way to estimate the stress distribution, the deformations and the stability of the structure on a
global level, assuming that the grout body does not slip relative to the soil. With this model it is certainly not
possible to evaluate the pullout force of the ground anchor.

3.4.4 To define the distributed load:
1.

Create a line load

between (28.0 30.0) and (38.0 30.0).

3.5 Generate the mesh
In order to generate the mesh, follow these steps:
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
in the side toolbar. Use the default option for the Element distribution
parameter (Medium).
3. Click the View mesh button
to view the mesh.
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Figure 33: The generated mesh

3.6 Define and perform the calculation
The calculation of this project consists of six phases. In the initial phase (Phase 0), the initial stresses are
generated. In Phase 1, the walls are constructed and the surface loads are activated. In Phase 2, the first 3 m of
the pit is excavated without connection of anchors to the wall. At this depth the excavation remains dry. In Phase
3, the first anchor is installed and pre-stressed. Phase 4 involves further excavation to a depth of 7 m. At this
depth the excavation still remains dry. In Phase 5, the second anchor is installed and pre-stressed. Phase 6 is a
further excavation to the final depth of 10 m including the dewatering of the excavation.
Before defining the calculation phases, the water levels to be considered in the calculation can be defined in the
Flow conditions mode. The water level is lowered in the final excavation phase. At the side boundaries, the
groundwater head remains at a level of 23.0 m. The bottom boundary of the problem should be closed. The flow
of groundwater is triggered by the fact that the pit is pumped dry. At the bottom of the excavation the water
pressure is zero, which means that the groundwater head is equal to the vertical level (head = 20.0 m). This
condition can be met by drawing a new general phreatic level and performing a groundwater flow calculation.
Activating the interfaces during the groundwater flow calculation prevents flow through the wall.

3.6.1 Initial phase
The initial stress field is generated by means of the K0 procedure using the default K0-values in all clusters
defined automatically by the program.
1. Proceed to the Staged construction mode.
2. Initially, all structural components and loads are inactive. Hence, make sure that the plates, the node-to-node
anchors, the embedded beam rows and the surface loads are deactivated.
3. In the Phases explorer double-click the initial phase. The default parameters for the initial phase will be
used. The Phreatic option is selected as Pore pressure calculation type. Note that when the pore pressures
are generated by phreatic level, the full geometry of the defined phreatic level is used to generate the pore
pressures.
4. Click OK to close the Phases window.
5. In the Model explorer expand the Model conditions subtree.
6. Expand the Water subtree.
The water level created according to the head value specified in the borehole, (BoreholeWaterLevel_1), is
automatically assigned to GlobalWaterLevel.
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Figure 34: Configuration of the initial phase

3.6.2 Phase 1: Activation of wall and load
1. Click the Add phase button
to create a new phase.
2. In the Staged constructions mode activate all walls and interfaces by clicking on the checkbox in front of
them in the Model explorer.
The active elements in the project are indicated by a green check mark.
3. Activate the distributed load.
4. After selecting the line load assign a value of -10 to qy,start,ref in the Selection explorer:

Figure 35: Line load in the Selection explorer
The model for the phase 1 in the Staged construction mode is displayed as:

Figure 36: Configuration of Phase 1 in the Staged construction mode

3.6.3 Phase 2: First excavation
1.

PLAXIS

Click the Add phase button

in the Phases explorer to add a new phase.
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2. In the Staged construction mode de-activate the upper cluster of the excavation
The model for the first excavation phase looks like this:

Figure 37: Configuration of Phase 2 in the Staged construction mode

3.6.4 Phase 3: First anchor row
1.

Click the Add phase button
in the Phases explorer.
2. Activate the upper ground anchors by clicking on the checkbox in front of GroundAnchors_Top under the
Groups subtree in the Model explorer.
3. Multi-select the top node-to-node anchors.
4. In the Selection explorer set the Adjust prestress parameter to True and assign a pre-stress force of 500
kN.
Note: A pre-stress force is exactly matched at the end of a finished staged construction calculation and turned
into an anchor force. In successive calculation phases the force is considered to be just an anchor force and
can therefore further increase or decrease, depending on the development of the surrounding stresses and
forces.

The model for the phase 3 in the Staged construction mode looks like this:

Figure 38: Configuration of Phase 3 in the Staged construction mode

3.6.5 Phase 4: Second excavation
1.

PLAXIS

Click the Add phase button

to add a new phase.
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2. Deactivate the second cluster of the excavation.
The model for the phase 4 in the Staged construction mode is displayed:

Figure 39: Configuration of Phase 4 in the Staged construction mode
Note that the anchors are not pre-stressed anymore.

3.6.6 Phase 5: Second anchor row
1.

to add a new phase.
Click the Add phase button
2. Activate the lower ground anchors.
3. Select the bottom node-to-node anchors.
4. In the Selection explorer set the Adjust prestress parameter to True and assign a pre-stress force of 1000
kN.
The model for the phase 5 in the Staged construction mode is displayed:

Figure 40: Configuration of Phase 5 in the Staged construction mode

3.6.7 Phase 6: Final excavation
1.

Click the Add phase button
to add a new phase.
2. In the Phases window, within General > Pore pressure calculation type select the Steady state
groundwater flow option . The default values of the remaining parameters are valid.
3. Deactivate the third cluster of the excavation.
4. Click the Flow conditions tab to display the corresponding mode.
5. In the Model explorer expand the Attributes library.

PLAXIS

60

PLAXIS 2D - Tutorial Manual

Dry excavation using a tie back wall
Define and perform the calculation
6. Expand the Water levels subtree.
7. Click the Create water level button
in the side toolbar and draw a new phreatic level. Start at (0.0 23.0)
and draw the phreatic level through (40.0 20.0), (60.0 20.0) and end in (100.0 23.0).
8. In the Model explorer expand the User water levels subtree. Click on UserWaterLevel_1 and type
LoweredWaterLevel to rename the water level created in the Flow conditions mode.

Figure 41: Water levels in the Model explorer
9. In the Model explorer expand Model conditions > GroundwaterFlow. The default boundary conditions are
valid.

Figure 42: The GroundwaterFlow subtree under the Model conditions in the Model explorer
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10. In the Water subtree assign the LoweredWaterLevel to GlobalWaterLevel.
The model and the defined water levels are displayed:

Figure 43: Configuration of Phase 6 in the Flow conditions mode
Note: Note that for Groundwater flow (steady or transient) the intersection points of the water level with the
active model boundaries are important. The program calculates flow boundary conditions in terms of a
groundwater head corresponding to the water level. The 'internal' part of the water level is not used and will be
replaced by the phreatic level resulting from the groundwater flow calculation. Hence, the water level tool is just
a convenient tool to create boundary conditions for a flow calculation.

3.6.8 Execute the calculation
1. Click the Select points for curves button
in the side toolbar.
2. Select some characteristic points for curves (for example the connection points of the ground anchors on the
diaphragm wall, such as (40.0 27.0) and (40.0 23.0)).
3. Click the Calculate button
to calculate the project.
4.

After the calculation has finished, save the project by clicking the Save button

.

3.7 Results
The figures below show the deformed meshes at the end of calculation phases 2 to 6.

Figure 44: Deformed mesh (scaled up 50.0 times) - Phase 2
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Figure 45: Deformed mesh (scaled up 50.0 times) - Phase 3

Figure 46: Deformed mesh (scaled up 50.0 times) - Phase 4

Figure 47: Deformed mesh (scaled up 50.0 times) - Phase 5

Figure 48: Deformed mesh (scaled up 50.0 times) - Final phase
The figure below shows the effective principal stresses in the final situation. The passive stress state beneath the
bottom of the excavation is clearly visible. It can also be seen that there are stress concentrations around the
grout anchors.
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Figure 49: Principal effective stresses (final stage)
The figure below shows the bending moments in the diaphragm walls in the final state. The two dips in the line
of moments are caused by the anchor forces.

Figure 50: Bending moments in the diaphragm walls in the final stage
The anchor force can be viewed by double clicking the anchor. When doing this for the results of the third and
the fifth calculation phase, it can be checked that the anchor force is indeed equal to the specified pre-stress
force in the calculation phase they are activated. In the following phases this value might change due to the
changes in the model.
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In this tutorial an Ultimate Limit State (ULS) calculation will be defined and performed for the dry excavation
using a tie back wall (Dry excavation using a tie back wall (on page 49)). The same geometry model will be used.
The Design approaches feature is introduced in this example. This feature allows for the use of partial factors
for loads and model parameters after a serviceability calculation has already been performed.
Objective
• Using Design approaches

4.1 Define the geometry
In order to define a design approach:
1. Open the project created in Dry excavation using a tie back wall (on page 49) and save it under a different
name.
2. Select the menu Soil > Design approaches or Structures > Design approaches.
The corresponding window is displayed.
3. Click the Add button.
A new design approach is added in the list.
4. In this example the design approach 3 of the Eurocode 7 will be used. This design approach involves partial
factors for loads and partial factors for materials (strength). Click the design approach in the list and specify a
representative name (ex: 'Eurocode 7 - DA 3').
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Figure 51: Partial factors for loads

Figure 52: Partial factors for materials
5. In the lower part of the window the partial factors can be defined for loads and materials. Set the partial
factor for Variable unfavourable to 1.3.
6. Click the Materials tab.
7. Assign a value of 1.25 to Effective friction angle and Effective cohesion.
8. Click the Materials... button. The Material sets window pops up.
9. Open the Loam material data set. Note that the view has changed. In the current view it is possible to assign
factors to different soil parameters, as well as to see the effect of these factors on the soil parameters.
10. Click the Parameters tab. In the Parameters tabsheet select the corresponding labels for c'ref and φ'.
11. Do the same for the remaining soil data sets.
12. Close the Design approaches window.
Note:
Note that a partial factor for ϕ and ψ applies to the tangent of ϕ and ψ respectively.
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4.2 Define and perform the calculation
There are two main schemes to perform design calculations in relation to serviceability calculations (see Design
approaches in the Reference Manual). The first approach is used in this tutorial.

4.2.1 Changes to all phases
1.
2.
3.
4.
5.

Proceed to the Staged construction mode.
In the Phases explorer click the phase Phase_1.
Add a new phase.
Double-click the newly added phase to open the Phases window.
In the General subtree of the Phases window select the defined design approach in the corresponding dropdown menu.
6. In the Model explorer expand the Line loads and all the subtrees under it.
7. Select the Variable unfavourable option in the LoadFactorLabel drop-down menu of the static component
of the load.

Figure 53: Assignment of factor label to loads in the Selection explorer
8. Follow the same steps to define ULS phases for all the remaining SLS phases. Make sure that the Phase 7
starts from Phase 1, Phase 8 from Phase 2, Phase 9 from Phase 3 and so on.

PLAXIS

67

PLAXIS 2D - Tutorial Manual

Dry excavation using a tie back wall - ULS
Results

4.2.2 Execute the calculation
1. Click the Select points for curves button
in the side toolbar.
2. Select some characteristic points for curves (for example the connection points of the ground anchors on the
diaphragm wall, such as (40.0 27.0) and (40.0 23.0)).
3. Click the Calculate button
to calculate the project.
4.

After the calculation has finished, save the project by clicking the Save button

.

4.3 Results
The results obtained for the design approach phases can be evaluated in Output. The figure below displays the
ΣMstage - |u| plot for the node located at (40.0 27.0).

Figure 54: ΣMstage - |u| plot for the ULS phases
If the ULS calculations have successfully finished, the model complies with the corresponding design approach. If
there are doubts about this due to excessive deformations, an additional Safety calculation may be considered
using the same design approach, which should then result in a stable ΣMsf value larger than 1.0. Note that if
partial factors have been used it is not necessary that ΣMsf also includes a safety margin. Hence, in this case ΣMsf
just larger that 1.0 is enough.
The figure below displays the ΣMsf - |u| plot for the Safety calculations of the Phase 6 and the corresponding
ULS phase (Phase 12). It can be concluded that the situation complies with the design requirements.
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Figure 55: ΣMsf - |u| plot for the last calculation phase and the corresponding ULS phase
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Construction of a road embankment
The construction of an embankment on soft soil with a high groundwater level leads to an increase in pore
pressure. As a result of this undrained behaviour, the effective stress remains low and intermediate
consolidation periods have to be adopted in order to construct the embankment safely. During consolidation the
excess pore pressures dissipate so that the soil can obtain the necessary shear strength to continue the
construction process.
This tutorial concerns the construction of a road embankment in which the mechanism described above is
analysed in detail. In the analysis three new calculation options are introduced, namely a consolidation analysis,
an updated mesh analysis and the calculation of a safety factor by means of a safety analysis (phi/c-reduction).
Objectives
•
•
•
•
•

Consolidation analysis
Modelling drains
Change of permeability during consolidation
Safety analysis (phi-c reduction)
Updated mesh analysis (large deformations)

Geometry
The embankment is 16.0 m wide and 4.0 m high. The slopes have an inclination of 1:3. The problem is
symmetric, so only one half is modelled (in this case the right half is chosen). The embankment itself is
composed of loose sandy soil. The subsoil consists of 6.0 m of soft soil. The upper 3.0 m is peat and the lower 3.0
m is clay. The phreatic level is located 1 m below the original ground surface. Under the soft soil layers there is a
dense sand layer of which 4.0 m are considered in the model.
12 m

16 m

12 m

Road embankment

4m

Peat

3m

Clay

3m
Dense sand

Figure 56: Situation of a road embankment on soft soil
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5.1 Create new project
1.
2.
3.
4.
5.

Start PLAXIS 2D by double clicking the icon of the Input program
.
Click Start a new project.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet make sure that Model is set to Plane strain and that Elements is set to 15-Noded.
Set the model Contour to xmin = 0.0 m, xmax = 60.0 m, ymin = -10.0 m and ymax = 4.0.

5.2 Define the soil stratigraphy
The sub-soil layers are defined using a borehole. The embankment layers are defined in the Structures mode.
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.

Figure 57: Soil layer distribution
2. Define three soil layers as shown in the following figure:
3. The water level is located at y = -1 m. In the borehole column specify a value of -1 to Head.

5.3 Create and assign material data sets
A number of material set are needed for this tutorial. The properties of the materials are as follows:
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Table 12: Material properties of the sand and clay layer and the interfaces
Parameter

Symbol Embankment

Sand

Peat

Clay

Unit

General
Material model

-

Hardening
soil

Hardening
soil

Soft soil

Soft soil

-

Drainage type

-

Drained

Drained

Undrained
(A)

Undrained
(A)

-

Soil unit weight above phreatic
level

γunsat

16

17

8

15

kN/m3

Soil unit weight below phreatic
level

γsat

19

20

12

18

kN/m3

Initial void ratio

einit

0.5

0.5

2.0

1.0

-

Modified compression index

λ*

-

-

0.15

0.05

-

Modified swelling index

κ*

-

-

0.03

0.01

-

Secant stiffness in standard
drained triaxial test

E50ref

2.5 · 104

3.5 · 104

-

-

kN/m2

Tangent stiffness for primary
oedometer loading

Eoedref

2.5· 104

3.5 · 104

-

-

kN/m2

Unloading / reloading stiffness

Eurref

7.5· 104

1.05 · 105

-

-

kN/m2

m

0.5

0.5

-

-

-

cref'

1.0

0.0

2.0

1.0

kN/m2

Friction angle

φ'

30

33

23

25

°

Dilatancy angle

ψ

0.0

3.0

0

0

°

Yes

Yes

Yes

Yes

Yes

-

Data set

-

USDA

USDA

USDA

USDA

-

Model

-

Van
Genuchten

Van
Genuchten

Van
Genuchten

Van
Genuchten

-

Parameters

Power for stress-level
dependency of stiffness
Cohesion (constant)

Advanced: Set to default
Groundwater
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Parameter

Symbol Embankment

Sand

Peat

Clay

Unit

Soil type

-

Loamy sand

Sand

Clay

Clay

-

> 2μm

-

6.0

4.0

70.0

70.0

%

2μm - 50μm

-

11.0

4.0

13.0

13.0

%

50μm - 2mm

-

83.0

92.0

17.0

17.0

%

Use defaults

-

From data
set

From data
set

None

From data
set

-

Horizontal permeability

kx

3.499

7.128

0.1

0.04752

m/day

Vertical permeability

ky

3.499

7.128

0.05

0.04752

m/day

Change in permeability

ck

1 · 1015

1 · 1015

1.0

0.2

-

-

Rigid

Rigid

Rigid

Rigid

-

Rinter

1.0

1.0

1.0

1.0

-

-

Automatic

Automatic

Automatic

Automatic

-

Overconsolidation ratio

OCR

1.0

1.0

1.0

1.0

-

Pre-overburden pressure

POP

0.0

0.0

5.0

0.0

kN/m2

Interfaces
Interface strength
Strength reduction factor
Initial
K0 determination

To create the material sets, follow these steps:
1.

Click the Materials button
to open the Material sets window.
2. Create soil material data sets according to Table 12 (on page 72) and assign them to the corresponding layers
in the borehole (see Figure 57 (on page 71)).
3. Close the Modify soil layers window and proceed to the Structures mode to define the embankment and
drains.

Note: The initial void ratio (einit) and the change in permeability (ck) should be defined to enable the modelling
of a change in the permeability in a consolidation analysis due to compression of the soil. This option is
recommended when using advanced models.

5.4 Define the construction
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The embankment and the drains are defined in the Structures mode.
1. Click the Structures tab to proceed with the input of structural elements in the Structures mode.

5.4.1 To define the embankment:
1. Click the Create soil polygon button
in the side toolbar and select the Create soil polygon option.
2. Define the embankment in the drawing area by clicking on (0.0 0.0), (0.0 4.0), (8.0 4.0) and (20.0 0.0).
3. Right-click the created polygon and assign the Embankment data set to the soil polygon.

Figure 58: Assignment of a material dataset to a soil cluster in the drawing area
4. To define the embankment construction level click the Cut polygon button
a cutting line by clicking on (0.0 2.0) and (14.0 2.0).
The embankment cluster is split into two sub-clusters.

in the side toolbar and define

5.4.2 To define the drains
In this project the effect of the drains on the consolidation time will be investigated by comparing the results
with a case without drains. Drains will only be active for the calculation phases in the case with drains.
1. Click the Create hydraulic conditions button in the side toolbar and select the Create drain option in the
appearing menu.

2. Drains are defined in the soft layers (clay and peat; y = 0.0 to y = -6.0). The distance between two consecutive
drains is 2 m. Considering the symmetry, the first drain is located at 1 m distance from the model boundary.
10 drains will be created in total. The head is defined at 0.0 m.
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Figure 59: Final geometry of the model
Note:
The modelling of drains in a plane strain model actually involves the use of an equivalent (lateral) permeability
in the surrounding soil based on the drain pattern. The latter has been omitted in this simplified example. More
information can be in found in literature1.

5.5 Generate the mesh
In order to generate the mesh, follow these steps:
1. Proceed to Mesh mode.
2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Medium (default).
3. Click the View mesh button
to view the mesh.

Figure 60: The generated mesh
4. Click the Close tab to close the Output program.

5.6 Define and perform the calculation
The embankment construction is divided into two phases. After the first construction phase a consolidation
period of 30 days is introduced to allow the excess pore pressures to dissipate. After the second construction
phase another consolidation period is introduced from which the final settlements may be determined. Hence, a
total of four calculation phases have to be defined besides the initial phase.

1

Achtergronden bij numerieke modellering van geotechnische constructies, deel 2. CUR 191. Stichting CUR,
Gouda Indraratna, B.N., Redana, I.W., Salim, W. (2000), Predicted and observed behaviour of soft clay
foundations stabilised with vertical drains. Proc. GeoEng. 2000, Melbourne.
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5.6.1 Initial phase: Initial conditions
In the initial situation the embankment is not present.
The remaining active geometry is horizontal with horizontal layers, so the K0 procedure can be used to
calculate the initial stresses.

Figure 61: Configuration of the initial phase
The initial water pressures are fully hydrostatic and based on a general phreatic level located at y = -1. Note that
a phreatic level is automatically created at y = -1, according to the value specified for Head in the borehole. In
addition to the phreatic level, attention must be paid to the boundary conditions for the consolidation analysis
that will be performed during the calculation process. Without giving any additional input, all boundaries except
for the bottom boundary are draining so that water can freely flow out of these boundaries and excess pore
pressures can dissipate. In the current situation, however, the left vertical boundary must be closed because this
is a line of symmetry, so horizontal flow should not occur. The remaining boundaries are open because the
excess pore pressures can be dissipated through these boundaries. In order to define the appropriate
consolidation boundary conditions, follow these steps:
1. In the Model explorer expand the Model conditions subtree.
2. Expand the GroundwaterFlow subtree and set BoundaryXMin to Closed and BoundaryYMin to Open.

Figure 62: The boundary conditions of the problem
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5.6.2 Consolidation analysis
A consolidation analysis introduces the dimension of time in the calculations. In order to correctly perform a
consolidation analysis a proper time step must be selected. The use of time steps that are smaller than a critical
minimum value can result in stress oscillations.
The consolidation option in PLAXIS 2D allows for a fully automatic time stepping procedure that takes this
critical time step into account. Within this procedure there are three main possibilities:
Consolidate for a predefined period, including the effects of changes to the active geometry (Staged
construction).
Consolidate until all excess pore pressures in the geometry have reduced to a predefined minimum
value (Minimum excess pore pressure).
Consolidate until a specified degree of saturation is reached (Degree of consolidation).

The first two possibilities will be used in this exercise. To define the calculation phases, follow these steps:

Phase 1:
(the way calculation phases are presented here is different than in other chapters) The first calculation stage is a
Consolidation analysis, Staged construction.
1. Click the Add phase button
to create a new phase.
2.
In the Phases window select the Consolidation option
from the Calculation type drop-down menu in
the General subtree.
3.
Make sure that the Staged construction option
is selected for the Loading type.
4. Enter a Time interval of 2 days. The default values of the remaining parameters will be used.
5. In the Staged construction mode activate the first part of the embankment.

Figure 63: Configuration of the phase 1

Phase 2:
The second phase is also a Consolidation analysis, Staged construction. In this phase no changes to the
geometry are made as only a consolidation analysis to ultimate time is required.
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1. Click the Add phase button
to create a new phase.
2.
In the Phases window select the Consolidation option
from the Calculation type drop-down menu in
the General subtree.
3.
Make sure that the Staged construction option
is selected for the Loading type.
4. Enter a Time interval of 30 days. The default values of the remaining parameters will be used.

Phase 3:
1. Click the Add phase button
to create a new phase.
2.
In the Phases window select the Consolidation option
from the Calculation type drop-down menu in
the General subtree.
3.
Make sure that the Staged construction option
is selected for the Loading type.
4. Enter a Time interval of 1 day. The default values of the remaining parameters will be used.
5. In the Staged construction mode activate the second part of the embankment.

Figure 64: Configuration of the phase 3

Phase 4:
The fourth phase is a Consolidation analysis to a minimum excess pore pressure.
1. Click the Add phase button
to create a new phase.
2.
In the General subtree select the Consolidation option
as calculation type.
3.
in the Loading type drop-down menu and accept the
Select the Minimum excess pore pressure option
default value of 1 kN/m2 for the minimum pressure. The default values of the remaining parameters will be
used.

5.6.3 Execute the calculation
Before starting the calculation it is suggested that you select nodes or stress points for a later generation of loaddisplacement curves or stress and strain diagrams. To do this, follow the steps given below.
1. Click the Select points for curves button
in the side toolbar.
2. As the first point, select the toe of the embankment (point at (20.00,0.00)).
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3. The second point will be used to plot the development (and decay) of excess pore pressures. To this end, a
point somewhere in the middle of the soft soil layers is needed, close to (but not actually on) the left
boundary (point at (0.25, -3.00)).
4. Click the Calculate button
to calculate the project.
During a consolidation analysis the development of time can be viewed in the upper part of the calculation info
window.

Figure 65: Calculation progress displayed in the Active tasks window
In addition to the multipliers, a parameter Pexcess,max occurs, which indicates the current maximum excess pore
pressure. This parameter is of interest in the case of a Minimum excess pore pressure consolidation analysis,
where all pore pressures are specified to reduce below a predefined value.

5.7 Results
After the calculation has finished, select the third phase and click the View calculation results button

.

The Output window now shows the deformed mesh after the undrained construction of the final part of the
embankment. Considering the results of the third phase, the deformed mesh shows the uplift of the embankment
toe and hinterland due to the undrained behaviour.

Figure 66: Deformed mesh after undrained construction of embankment (Phase 3)
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1. Select the menu Deformations > Incremental displacements > |Δ u|.
2. Select the menu View > Arrows option in the menu or click the corresponding button
display the results arrows.

in the toolbar to

On evaluating the total displacement increments, it can be seen that a failure mechanism is developing:

Figure 67: Displacement increments after undrained construction of embankment
1. Press <Ctrl + 7> to display the developed excess pore pressures (see Appendix C of the Reference Manual for
more shortcuts). They can also be displayed by selecting the menu Stresses > Pore pressures > P excess.
2.
Click the Center principal directions button
. The principal directions of excess pressures are displayed
at the center of each soil element. The results are displayed in the following figure.

Figure 68: Excess pore pressures after undrained construction of embankment
It is clear that the highest excess pore pressure occurs under the embankment centre.
1. Select Phase 4 in the drop down menu.
2. Click the Contour lines button
in the toolbar to display the results as contours.
3.
or the corresponding option in the View menu to define the position of
Use the Draw scanline button
the contour line labels.
It can be seen that the settlement of the original soil surface and the embankment increases considerably during
the fourth phase. This is due to the dissipation of the excess pore pressures (= consolidation), which causes
further settlement of the soil. The figure below shows the remaining excess pore pressure distribution after
consolidation. Check that the maximum value is below 1.0 kN/m2.

Figure 69: Excess pore pressure contours after consolidation to Pexcess < 1.0 kN/m2
The Curves manager can be used to view the development, with time, of the excess pore pressure under the
embankment. In order to create such a curve, follow these steps:
1. Create a new curve by clicking the Curves manager button
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2. For the x-axis, select the Project option from the drop-down menu and select Time in the tree.
3. For the y-axis select the point in the middle of the soft soil layers (Point B) from the drop-down menu. In the
tree select Stresses > Pore pressure > p excess.
4. Select the Invert sign option for the y-axis.
5. Click OK.
A curve similar to the following one should appear:

Figure 70: Development of excess pore pressure under the embankment
The figure above clearly shows the four calculation phases. During the construction phases the excess pore
pressure increases with a small increase in time while during the consolidation periods the excess pore pressure
decreases with time. In fact, consolidation already occurs during construction of the embankment, as this
involves a small time interval. From the curve it can be seen that more than 50 days are needed to reach full
consolidation.
Save the chart before closing the Output program.

5.8 Safety analysis
In the design of an embankment it is important to consider not only the final stability, but also the stability
during the construction. It is clear from the output results that a failure mechanism starts to develop after the
second construction phase.
It is interesting to evaluate a global safety factor at this stage of the problem, and also for other stages of
construction.
In structural engineering, the safety factor is usually defined as the ratio of the collapse load to the working load.
For soil structures, however, this definition is not always useful. For embankments, for example, most of the
loading is caused by soil weight and an increase in soil weight would not necessarily lead to collapse. Indeed, a
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slope of purely frictional soil will not fail in a test in which the self weight of the soil is increased (like in a
centrifuge test). A more appropriate definition of the factor of safety is therefore:
Safety factor =

Smaximum available
Sneeded for equilibrium

Where S represents the shear strength. The ratio of the true strength to the computed minimum strength
required for equilibrium is the safety factor that is conventionally used in soil mechanics. By introducing the
standard Coulomb condition, the safety factor is obtained:
Safety factor =

c − σn tan(φ )
cr − σn tan(φn )

Where c and φ are the input strength parameters and σn is the actual normal stress component.
The parameters cr and φr are reduced strength parameters that are just large enough to maintain equilibrium.
The principle described above is the basis of the method of Safety that can be used in PLAXIS 2D to calculate a
global safety factor. In this approach the cohesion and the tangent of the friction angle are reduced in the same
proportion:
c
cr

=

tan(φ )
tan(φr )

= ΣMsf

The reduction of strength parameters is controlled by the total multiplier ΣMsf. This parameter is increased in a
step-by-step procedure until failure occurs. The safety factor is then defined as the value of ΣMsf at failure,
provided that at failure a more or less constant value is obtained for a number of successive load steps.
The Safety calculation option is available in the Calculation type drop-down menu in the General tabsheet. If
the Safety option is selected the Loading input on the Parameters tabsheet is automatically set to
Incremental multipliers.
To calculate the global safety factor for the road embankment at different stages of construction, follow these
steps:
1. Select Phase 1 in the Phases explorer.
2.
Add a new calculation phase.
3. Double-click on the new phase to open the Phases window.
4. In the Phases window the selected phase is automatically selected in the Start from phase drop-down
menu.
5.
as calculation type.
In the General subtree, select Safety
6.
The Incremental multipliers option
is already selected in the Loading input box. The first increment of
the multiplier that controls the strength reduction process, Msf, is set to 0.1.
7.
in the Pore pressure calculation type
Note that the Use pressures from the previous phase option
drop-down menu is automatically selected and grayed out indicating that this option cannot be changed
8. In order to exclude existing deformations from the resulting failure mechanism, select the Reset
displacements to zero option in the Deformation control parameters subtree.
9. In the Numerical control parameters subtree deselect Use default iter parameters and set the number of
Max steps to 50.
The first safety calculation has now been defined.
10. Follow the same steps to create new calculation phases that analyse the stability at the end of each
consolidation phase.
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Figure 71: Phases explorer displaying the Safety calculation phases
Note:
The default value of Max steps in a Safety calculation is 100. In contrast to a Staged construction calculation,
the specified number of steps is always fully executed. In most Safety calculations, 100 steps are sufficient to
arrive at a state of failure. If not, the number of steps can be increased to a maximum of 1000.
For most Safety analyses Msf = 0.1 is an adequate first step to start up the process. During the calculation
process, the development of the total multiplier for the strength reduction, ΣMsf, is automatically controlled by
the load advancement procedure.

5.8.1 Evaluation of results
Additional displacements are generated during a Safety calculation. The total displacements do not have a
physical meaning, but the incremental displacements in the final step (at failure) give an indication of the likely
failure mechanism.
In order to view the mechanisms in the three different stages of the embankment construction:
1.

Select one of these phases and click the View calculation results button
.
2. Select the menu Incremental displacements > Deformations > |Δu|.
3. Change the presentation from Arrows to Shadings
. The resulting plots give a good impression of the
failure mechanisms. The magnitude of the displacement increments is not relevant.
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Figure 72: Shadings of the total displacement increments indicating the most applicable failure mechanism of the
embankment in the final stage
The safety factor can be obtained from the Calculation info option of the Project menu. The Multipliers
tabsheet of the Calculation information window represents the actual values of the load multipliers. The value
of ΣMsf represents the safety factor, provided that this value is indeed more or less constant during the previous
few steps.
The best way to evaluate the safety factor, however, is to plot a curve in which the parameter ΣMsf is plotted
against the displacements of a certain node. Although the displacements are not relevant, they indicate whether
or not a failure mechanism has developed.
In order to evaluate the safety factors for the three situations in this way, follow these steps:
1. Click the Curves manager button in the toolbar.
2. Click New in the Charts tabsheet.
3. In the Curve generation window, select the embankment toe (Point A) for the x-axis. Select Deformations >
Total displacements > |u|.
4. For the y-axis, select Project > Multipliers > ΣMsf. The Safety phases are considered in the chart.
5. Right-click on the chart and select the Settings option in the appearing menu. The Settings window pops up.
6. In the tabsheet corresponding to the curve click the Phases button.
7. In the Select phases window select Phase 5:

Figure 73: The Select phases window
8. Click OK to close the Select phases window.
9. In the Settings window change the titles of the curve in the corresponding tabsheet.
10. Click the Add curve button and select the From current project... option in the appearing menu. Define
curves for phases 6, 7 and 8 by following the described steps.
11. In the Settings window click the Chart tab to open the corresponding tabsheet.
12. In the Chart tabsheet specify the chart name.
13. Set the scaling of the x-axis to Manual and set the value of Maximum to 1:
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14.
15.
16.
17.

Figure 74: The Chart tabsheet in the Settings window
Click Apply to update the chart according to the changes made and click OK to close the Settings window.
To modify the location of the legend right-click on the legend.
In the context menu select View > Legend in chart.
The legend can be relocated in the chart by dragging it. The plot is shown as:

Figure 75: Evaluation of safety factor
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The maximum displacements plotted are not relevant. It can be seen that for all curves a more or less constant
value of Σ Msf is obtained. Hovering the mouse cursor over a point on the curves, a box showing the exact value
of ΣMsf can be obtained.

5.9 Using drains
In this section the effect of the drains in the project will be investigated. Four new phases will be introduced
having the same properties as the first four consolidation phases. The first of these new phases should start from
the initial phase. The differences in the new phases are:
• The drains should be active in all the new phases. Activate them in the Staged construction mode.
• The Time interval in the first three of the consolidation phases (9 to 11) is 1 day. The last phase is set to
Minimum excess pore pressure and a value of 1.0 kN/m2 is assigned to the minimum pressure (|P-stop|).
Follow these steps:
1. After the calculation is finished, save the project, then select the last phase and click the View calculation
. The Output window now shows the deformed mesh after the drained construction of the
results button
final part of the embankment. In order to compare the effect of the drains, the excess pore pressure
dissipation in the second point can be used.
2. Click the Curves manager button
to open the Curves manager.
3. In the Chart tabsheet double-click Chart 1 (pexcess of the second point (at (0.25,-3.00)) versus time). The
chart is displayed. Close the Curves manager.
4. Double-click the curve in the legend at the right of the chart. The Settings window pops up.
5. Click the Add curve button and select the From current project ... option in the appearing menu. The Curve
generation window pops up.
6. Select the Invert sign option for y-axis and click OK to accept the selected options.
7. In the chart a new curve is added and a new tabsheet corresponding to it is opened in the Settings window.
Click the Phases button. From the displayed window select the Initial phase and the last four phases
(drains) and click OK.
8. In the Settings window change the titles of the curves in the corresponding tabsheets.
9. In the Chart tabsheet specify the chart name.
10. Click Apply to preview the generated curve and click OK to close the Settings window. The chart gives a
clear view of the effect of drains in the time required for the excess pore pressures to dissipate:
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Figure 76: Effect of drains
Note:
Instead of adding a new curve, the existing curve can be regenerated using the corresponding button in the
Curves settings window.

5.10 Updated mesh and updated water pressures analysis
As can be seen from the output of the Deformed mesh at the end of consolidation (stage 4), the embankment
settles about one meter since the start of construction. Part of the sand fill that was originally above the phreatic
level will settle below the phreatic level.
As a result of buoyancy forces the effective weight of the soil that settles below the water level will change,
which leads to a reduction of the effective overburden in time. This effect can be simulated in PLAXIS 2D using
the Updated mesh and Updated water pressures options. For the road embankment the effect of using these
options will be investigated.
1. Select the initial phase in the Phases explorer.
2. Add a new calculation phase.
3. Define the new phase in the same way as Phase 1. In the Deformation control parameters subtree check
the Updated mesh and Updated water pressures options.
4. Define the other 3 phases in the same way.
When the calculation has finished, compare the settlements for the two different calculation methods.
1. In the Curve generation window select time for the x-axis and select the vertical displacement (uy) of the
point in the middle of the soft soil layers (point at (0.25,-3.00)) for the y-axis.
2. In this curve the results for Initial phase and phases from 1 to 4 will be considered.
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3. Add a new curve to the chart.
4. In this curve the results for Initial phase and phases from 13 to 16 will be considered. The resulting chart is
shown below.

Figure 77: Effect of updated mesh and water pressures analysis on resulting settlements
It can be seen that the settlements are less when the Updated mesh and Updated water pressures options are
used (red curve). This is partly because the Updated mesh procedure includes second order deformation effects
by which changes of the geometry are taken into account, and partly because the Updated water pressures
procedure results in smaller effective weights of the embankment. This last effect is caused by the buoyancy of
the soil settling below the (constant) phreatic level. The use of these procedures allows for a realistic analysis of
settlements, taking into account the positive effects of large deformations.
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Settlements due to tunnel construction
In this tutorial the construction of a shield tunnel in medium soft soil and the influence on a pile foundation is
considered. A shield tunnel is constructed by excavating soil at the front of a tunnel boring machine (TBM) and
installing a tunnel lining behind it. In this procedure the soil is generally over-excavated, which means that the
cross sectional area occupied by the final tunnel lining is always less than the excavated soil area. Although
measures are taken to fill up this gap, one cannot avoid stress re-distributions and deformations in the soil as a
result of the tunnel construction process. To avoid damage to existing buildings or foundations on the soil above,
it is necessary to predict these effects and to take proper measures. Such an analysis can be performed by means
of the finite element method. This tutorial shows an example of such an analysis.
Objectives
• Modelling of the tunnel boring process
• Modelling undrained behaviour using the Undrained (B) option
Geometry
The tunnel considered in this tutorial has a diameter of 5.0 m and is located at an average depth of 20 m.
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Figure 78: Geometry of the tunnel project with an indication of the soil layers

6.1 Create new project
To create the new project, follow these steps:
1.
2.
3.
4.
5.

Start the Input program and select Start a new project from the Quick start dialog box.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-Noded).
Set the model Contour to xmin = 0.0 m, xmax = 35.0 m, ymin = -30.0 m and ymax = 3.0 m.
Keep the default values for units and constants and press OK to close the Project properties window.

6.2 Define the soil stratigraphy
The soil profile indicates four distinct layers: The upper 13 m consists of soft clay type soil with stiffness that
increases approximately linearly with depth. Under the clay layer there is a 2.0 m thick fine sand layer. This layer
is used as a foundation layer for old wooden piles on which traditional brickwork houses were built. The pile
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foundation of such a building is modelled next to the tunnel. Displacements of these piles may cause damage to
the building, which is highly undesirable. Below the sand layer there is a 5.0 m thick deep loamy clay layer.
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.

Figure 79: The soil stratigraphy in the Modify soil layers window
2. Create the soil stratigraphy as shown in the following figure:
3. Keep the Head in the borehole to 0.0 m.

6.3 Create and assign material data sets
Four data sets need to be created for the clay and sand layers.
For the upper clay layer the stiffness and shear strength increase with depth. Therefore values for E'inc and su,inc
are entered in the Advanced subtree. The values of E'ref and su,ref become the reference values at the reference
level yref. Below yref the actual values of E' and su increase with depth according to:
E ′(y) = Eref ′ + Einc ′(yref − y)
su (y) = su,ref + su,inc (yref − y)
The data sets of the two lower soil layers include appropriate parameters for the tunnel interfaces. In the other
data sets the interface properties just remain at their default values. Enter four data sets with the properties as
listed in Table 13 (on page 92) and assign them to the corresponding clusters in the geometry model.
The layers have the following properties:
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Table 13: Material properties of soil in the tunnel project
Parameter

Name

Clay

Sand

Deep clay

Deep sand

Unit

Material model

-

MohrCoulomb

Hardening
soil

MohrCoulomb

HS small

-

Type of material behaviour

-

Undrained
(B)

Drained

Undrained
(B)

Drained

-

Soil unit weight above phreatic level

γunsat

15

16.5

16

17

kN/m3

Soil unit weight below phreatic level

γsat

18

20

18.5

21

kN/m3

Young's modulus at reference level

E'

3.4 · 103

-

9.0 · 103

-

kN/m2

Secant stiffness in standard drained
triaxial test

E50ref

-

2.5 · 104

-

4.2 · 104

kN/m2

Tangent stiffness for primary
oedometer loading

Eoedref

-

2.5 · 104

-

4.2 · 104

kN/m2

Unloading / reloading stiffness

Eurref

-

7.5 · 104

-

1.26 · 105

kN/m2

m

-

0.5

-

0.5

-

Cohesion (constant)

cref'

-

0

-

0

kN/m2

Undrained shear strength at reference
level

su,ref

5

-

40

-

kN/m2

Friction angle

φ'

-

31

-

35

°

Dilatancy angle

ψ

-

1.0

-

5

°

Shear strain at which Gs = 0.722 G0

γ0.7

-

-

-

1.3 · 10-4

-

Shear modulus at very small strains

G0ref

-

-

-

1.1 · 105

kN/m2

Poisson's ratio

νur'

0.33

0.3

0.33

0.3

-

Young's modulus inc.

Einc'

400

-

600

-

kN/m3

Reference level

yref

3.0

-

-12

-

m

Undrained shear strength inc.

su,inc

2

-

3

-

kN/m2

General

Parameters

Power for stress-level dependency of
stiffness
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Parameter

Name

Clay

Sand

Deep clay

Deep sand

Unit

yref

3.0

-

-12

-

m

Permeability in horizontal direction

kx

1 · 10-4

1.0

1 · 10-2

0.5

m/day

Permeability in vertical direction

ky

1 · 10-4

1.0

1 · 10-2

0.5

m/day

-

Rigid

Rigid

Manual

Manual

-

Rinter

1.0

1.0

0.7

0.7

-

-

Manual

Automatic

Manual

Automatic

-

Lateral earth pressure coefficient

K0,x

0.60

0.485

0.60

0.4264

-

Over-consolidation ratio

OCR

-

1.0

-

1.0

-

Pre-overburden pressure

POP

-

0.0

-

0.0

-

Reference level
Groundwater

Interfaces
Interface strength
Strength reduction factor
Initial
K0 determination

To create the material sets, follow these steps:
1.

Click the Materials button
in the Modify soil layers window.
2. Create data sets under the Soil and interfaces set type according to the information given in Table 13 (on
page 92).

6.4 Define the structural elements
The tunnel and the building are defined as structural elements.

6.4.1 Define the tunnel
The tunnel considered here is the right half of a circular tunnel. After generating the basic geometry, follow these
steps to design the circular tunnel:
1. In the Structures mode click the Create tunnel button
drawing area.
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The Tunnel designer window pops up displaying the General tabsheet of the Cross section mode.
Select the Circular option in the Shape type drop-down menu.
Select the Define right half option in the Whole or half tunnel drop-down menu.
In the Offset to begin point group set Axis 2 to -2.5. No change is required for the orientation axes.
Click the Segments tab to proceed to the corresponding tabsheet.
A segment is automatically created. A new box is shown under the segment list where the properties of the
segment can be defined.
6. In the Segment box set Radius to 2.5 m.
The generated segment is shown:
2.
3.
4.
5.

Figure 80: The geometry of the tunnel segment
Note: In the tunnel as considered here the segments do not have a specific meaning as the tunnel lining is
homogeneous and the tunnel will be constructed at once. In general, the meaning of segments becomes
significant when:
• It is desired to excavate or construct the tunnel (lining) in different stages.
• Different tunnel segments have different lining properties.
• One would consider hinge connections in the lining (hinges can be added after the design of the tunnel in
the general drawing area).
• The tunnel shape is composed of arcs with different radii (for example NATM tunnels).
7. Click the Properties tab to proceed to the corresponding tabsheet.
8. Right-click the segment in the display area and select the menu Create > Create plate option in the
appearing menu.
9. In Tunnel Designer go to the Material property in the Selection explorer and click the plus button

to
create a new material dataset. Specify the material parameters for lining according to the following table:

Table 14: Material properties of the plates
Parameter
Material behaviour

PLAXIS

Symbol

Lining

Building

Unit

-

Elastic

Elastic

-
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Parameter

Symbol

Lining

Building

Unit

Isotropic

-

Yes

Isotropic

-

Axial stiffness

EA

1.4 · 107

1 · 1010

kN/m

Bending stiffness

EI

1.43 · 105

1 · 1010

kNm2/m

Weight

w

8.4

25

kN/m/m

Poisson's ratio

ν

0.15

0.0

-

Prevent punching

-

No

No

-

Note: A tunnel lining consists of curved plates (shells). The lining properties can be specified in the material
database for plates. Similarly, a tunnel interface is nothing more than a curved interface.
10. Right-click the segment in the display area and select the Create negative interface option in the appearing
menu.
11. Right-click the segment in the display area and select the Create line contraction option in the appearing
menu. In the polycurve box specify a value of 0.5% for Cref. The tunnel model is shown in the following figure.

Figure 81: Tunnel model in the Properties mode
Note:
• A Cref value of 0.5% corresponds to a volume loss of 0.5% of the tunnel volume. The actual strain that is
applied to the line is half the applied contraction. Hence, the resulting liner contraction is 0.25%.
• The entered value of contraction is not always fully applied, depending on the stiffness of the surrounding
clusters and objects.
12. Click on Generate to include the defined tunnel in the model.
13. Close the Tunnel designer window.
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6.4.2 Define building
The building itself will be represented by a stiff plate founded on piles.
1. From the side bar, select Create line > Create plate and draw a plate from (5.0 3.0) to (15.0 3.0),
representing the building.
2. Create a material set for the building according to Table 15 (on page 96) and assign it to the plate.
3. From the side bar, select Create line > Create embedded beam row and draw two piles (embedded
beam rows) from (5.0 3.0) to (5.0 -11.0) and from (15.0 3.0) to (15.0 -11.0).
4. Create a material set for the foundation piles according to the table below and assign it to the foundation
piles.
Table 15: Material properties of piles
Parameter

Name

Foundation piles

Unit

Material type

-

Elastic

-

Stiffness

E

1.0 · 107

kN/m2

Unit weight

γ

24.0

kN/m3

Beam type

-

Predefined

-

Predefined beam type

-

Solid circular beam

-

Diameter

-

0.25

m

Lspacing

3.0

m

Axial skin resistance

-

Linear

-

Skin resistance at top

Tskin, start, max

1.0

kN/m

Skin resistance at bottom

Tskin, end, max

100.0

kN/m

-

Unlimited

-

Fmax

100.0

kN

-

Default

-

Pile spacing

Lateral resistance
Base resistance
Interface stiffness factors

Note: In the Standard fixities option, a plate that extends to a geometry boundary that is fixed in at least one
direction obtains fixed rotations, whereas a plate that extends to a free boundary obtains a free rotation.
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6.5 Generate the mesh
The default global coarseness parameter (Medium) can be accepted in this case. Note that the structural
elements (plate and embedded beams) are internally automatically refined by a factor of 0.25.
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Medium (default).
3. Click the View mesh button
to view the mesh.

Figure 82: The generated mesh
4. Click the Close tab to close the Output program.

6.6 Define and perform the calculation
To simulate the construction of the tunnel it is clear that a staged construction calculation is needed.
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6.6.1 Initial phase
1. Proceed to the Staged construction mode to proceed with the definition of the calculation phases.
2. The initial phase has already been introduced. Keep its calculation type as K0 procedure. The water
pressures can be generated on the basis of a general phreatic level at a level of y = 0.0 m as already defined in
the borehole. Make sure that the building, foundation piles and tunnel lining are deactivated.

6.6.2 Phase 1: Building
The first calculation phase is used to activate the building.
1. Click the Add phase button
to create a new phase.
2. In the Phases window rename the phase as Building.
3. In the Deformation control parameters subtree select the Ignore undr. behaviour (A,B) option. The
default values of the remaining parameters are valid for this phase.
4. In the drawing area activate the plate and the foundation piles.

6.6.3 Phase 2: Tunnel
1. Click the Add phase button
to create a new phase.
2. In the Phases window select the Reset displacements to zero option in the Deformation control
parameters subtree.
3. In Staged construction multi-select the clusters inside the tunnel. In the Selection explorer deactivate the
two soil clusters and set the Water conditions to Dry.
4. Activate the tunnel lining and the negative interfaces. Note that contraction is not active in this phase.

6.6.4 Phase 3: Contraction
1. Click the Add phase button
to create a new phase.
2. Multi-select the plates. In the Selection explorer activate the contraction.
Note:
• For a more realistic model, different properties should be defined for the lining in this phase and in the final
one.
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• The contraction of the tunnel lining by itself does not introduce forces in the tunnel lining. Eventual changes
in lining forces as a result of the contraction procedure are due to stress redistributions in the surrounding
soil or to changing external forces.

6.6.5 Phase 4: Grouting
At the tail of the tunnel boring machine (TBM), grout is injected to fill up the gap between the TBM and the final
tunnel lining. The grouting process is simulated by applying a pressure on the surrounding soil.
1. Click the Add phase button
to create a new phase.
2. In the Staged construction mode deactivate the tunnel lining (plates, negative interfaces and contraction).
3. Multi-select the clusters inside the tunnel. In the Selection explorer activate WaterConditions.
4. Select the User-defined option in the Condition drop-down menu and set pref to -230 kN/m2. The pressure
distribution in the tunnel is constant.

6.6.6 Phase 5: Final lining
1. Click the Add phase button
to create a new phase.
2. In the Staged construction set the clusters inside the tunnel to Dry.
3. Activate the tunnel lining (plates) and the negative interfaces in the tunnel.

6.6.7 Execute the calculation
1. Click the Select points for curves button
in the side toolbar.
2. Select some characteristic points for load-displacement curves (for example the corner point at the ground
surface above the tunnel and the corner points of the building).
3. Click the Calculate button
to calculate the project.
4.

After the calculation has finished, save the project by clicking the Save button

.

6.7 Results
After the calculation, select the last calculation phase and click the View calculation results button. The Output
program is started, showing the deformed meshes at the end of the calculation phases:
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Figure 83: Deformed mesh after construction of the tunnel (Phase 5; scaled up 20.0 times)
As a result of the second calculation phase (removing soil and water out of the tunnel) there is some settlement
of the soil surface and the tunnel lining shows some deformation. In this phase the axial force in the lining is the
maximum axial force that will be reached. The lining forces can be viewed by double clicking the lining and
selecting force related options from the Force menu. The plots of the axial forces and bending moment are
scaled by factors of 5·10-3 and 0.2 respectively.
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Figure 84: Axial forces and Bending moments in the lining after the second phase
The plot of effective stresses, shows that arching occurs around the tunnel. This arching reduces the stresses
acting on the tunnel lining. As a result, the axial force in the final phase is lower than that after the second
calculation phase.

Figure 85: Effective principal stresses after the construction of the tunnel
To display the tilt of the structure:
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1. Click the Distance measurement button
in the side toolbar.
2. Click the node located at the left corner of the structure (5.0 3.0).
3. Click the node located at the right corner of the structure (15.0 3.0).
The Distance measurement information window is displayed where the resulting tilt of the structure is given:

Figure 86: Distance measurement information window
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Excavation of an NATM tunnel
This tutorial illustrates the use of PLAXIS 2D for the analysis of the construction of a NATM tunnel. The NATM is
a technique in which ground exposed by excavation is stabilised with shotcrete to form a temporary lining.
Objectives
• Modelling the construction of an NATM tunnel using the Deconfinement method.
• Using Gravity loading to generate initial stresses.
Geometry
The geometry of the tunnel project looks like this:

28 m

8m

7m

7m

50 m

(-7 35)

(-50 24)

5m

Top layer

(-14 30)

6m

(-22 24)
Clay - Siltstone

13 m
(-50 11)

y

Clay - Limestone

11 m

x

(-50 0)

Figure 87: Geometry of the project

7.1 Create a new project
To create a new project, follow these steps:
1.
2.
3.
4.

PLAXIS

Start the Input program and select Start a new project from the Quick start dialog box.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet make sure that Model is set to Plane strain and that Elements is set to 15-Noded.
Define the limits for the soil contour as xmin = -50.0 m, xmax = 50.0 m, ymin = 0.0 m and ymax = 35.0 m.
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7.2 Define the soil stratigraphy
The basic stratigraphy will be created using the Borehole feature. In the model 11 m of the Clay-limestone layer
is considered. The bottom of this layer is considered as reference in y direction (ymin = 0).
To define the soil stratigraphy:
1. Click the Create borehole button
and create the first borehole at x = -22.0.
2. In the Modify soil layers window create three soil layers.
a. The layer number 1 has a depth equal to zero in Borehole_1. Assign 24.00 to Top and Bottom.
b. The layer number 2 lies from Top = 24.00 to Bottom = 11.00.
c. The layer number 3 lies from Top = 11.00 to Bottom = 0.00.
3. Click the Boreholes button at the bottom of the Modify soil layers window.
4. In the appearing menu select the Add option.
The Add borehole window pops up.
5. Specify the location of the second borehole (x = -14.0).
6. Note that the soil layers are available for Borehole_2.
a. The layer number 1 has a depth equal to zero in Borehole_2. However as the depth of layer 2 is higher,
assign 30.00 to Top and Bottom of the layer 1.
b. The layer number 2 lies from Top = 30.00 to Bottom = 11.00.
c. The layer number 3 lies from Top = 11.00 to Bottom = 0.00.
7. Create a new borehole (Borehole_3) at x = -7.0.
8. In Borehole_3:
a. The layer number 1 has a non-zero thickness and lies from Top = 35.00 to Bottom = 30.00.
b. The layer number 2 lies from Top = 30.00 to Bottom = 11.00.
c. The layer number 3 lies from Top = 11.00 to Bottom = 0.00.
9. In all the boreholes the water level is located at y = 0 m.
10. Specify the soil layer distribution as shown in Figure 88 (on page 105).
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Figure 88: Soil layer distribution

7.3 Create and assign material data sets
Three material sets need to be created for the soil layers.
Note that the layering of the model left from the first borehole is based on Borehole_1 and the layering right
from the last borehole is based on Borehole_3. Hence, no borehole is needed at x = -50 m or x = 50 m.
The layers have the following properties:
Table 16: Material properties of the soil layers
Name

Top layer

Clay-siltstone

Clay-limestone

Unit

Material model

-

Hardening soil

Hoek-Brown

Hoek-Brown

-

Type of material behaviour

-

Drained

Drained

Drained

-

Soil unit weight above phreatic level

γunsat

20

25

24

kN/m3

Soil unit weight below phreatic level

γsat

22

25

24

kN/m3

Initial void ratio

einit

0.5

0.5

0.5

-

E50ref

4.0·104

-

-

kN/m2

Parameter
General

Parameters
Secant stiffness in standard drained
triaxial test
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Parameter

Name

Top layer

Clay-siltstone

Clay-limestone

Unit

Tangent stiffness for primary
oedometer loading

Eoedref

4.0·104

-

-

kN/m2

Unloading / reloading stiffness

Eurref

1.2·105

-

-

kN/m2

m

0.5

-

-

-

Young's modulus

Erm'

-

1.0·106

2.5·106

kN/m2

Poisson's ratio

νur'

0.2

0.25

0.25

-

Uniaxial compressive strength

σci

-

2.5·104

5.0·104

kN/m2

Material constant for the intact rock

mi

-

4.0

10.0

-

Geological Strength Index

GSI

-

40.0

55.0

-

D

-

0.2

0.0

-

cref'

10.0

-

-

kN/m2

φ'

30

-

-

°

Dilatancy parameter

ψmax

-

30.0

35.0

°

Dilatancy parameter

σψ

-

400

1000

kN/m2

-

Rigid

Manual

Rigid

-

Rinter

1.0

0.5

1.0

-

Power for stress-level dependency of
stiffness

Disturbance factor
Cohesion
Friction angle

Interfaces
Interface strength
Strength reduction factor

1. Create soil material data sets according to Table 16 (on page 105) and assign them to the corresponding
layers (Figure 88 (on page 105)).
2. Close the Modify soil layers window and proceed to the Structures mode to define the structural elements.

7.4 Define the tunnel
1. In the Structures mode click the Create tunnel button
in the side toolbar and click on (0.0 16.0) in the
drawing area to specify the location of the tunnel.
The Tunnel designer window pops up.
2. The default shape option (Free) will be used. The default values of the rest of the parameters defining the
location of the tunnel in the model are valid as well.
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3. Click on the Segments tab.
4.
Click the Add section button
in the side toolbar. In the segment info box
a. Set the Segment type to Arc.
b. Set Radius to 10.4 m
c. Set the Segment angle to 22°.
5. The default values of the remaining parameters are valid.
6.
Click the Add section button
to add a new arc segment.
a. Set Radius to 2.4 m.
b. Set the Segment angle to 47°.
c. The default values of the remaining parameters are valid.
7.

8.

Click the Add section button
to add a new arc segment.
a. Set Radius to 5.8 m.
b. Set the Segment angle to 50°.
c. The default values of the remaining parameters are valid.
Click the Extend to symmetry axis option
to complete the right half of the tunnel.
A new arc segment is automatically added closing the half of the tunnel.

9.

to complete the tunnel. Four new arc segment are automatically added
Click the Symmetric close button
closing the tunnel.
10. Click on the Subsections tab.
11.
Click the Add button
to add a new subsection. This subsection will be used to separate the top heading
(upper excavation cluster) from the invert (lower excavation cluster).
a. Set Offset 2 to 3 m.
b. Select the Arc option from the Segment type drop-down menu.
c. Set Radius to 11 m.
d. Segment angle to 360°.
12.
Click the Select multiple objects button
and select all the geometric entities in the slice.
13.
Click the Intersect button
.
14. Delete the part of the subsection outside of the slice by selecting it in the display area and clicking the Delete
button
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Figure 89: Segments in the tunnel cross section
15. Proceed to the Properties mode.
16. Multi-select the polycurves in the display area and select the Create plate option in the appearing menu.
17. Press <Ctrl + M> to open the Material sets window. Create a new material dataset for the created plates
according to Table 17 (on page 108).
Table 17: Material properties of the plates
Name

Lining

Unit

Material type

-

Elastic

-

Isotropic

-

Yes

-

EA1

6.0·106

kN/m

Bending stiffness

EI

2.0·104

kNm2/m

Weight

w

5.0

kN/m/m

Poisson's ratio

ν

0.15

-

Prevent punching

-

No

-

Parameter

Axial stiffness

18. Multi-select the created plates and in the Selection explorer, assign the material Lining to the selected
plates.
19. Assign negative interfaces to the lines defining the shape of the tunnel (not the excavation levels).
The final tunnel view in the Tunnel designer window is given in this figure:
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Figure 90: Final tunnel
20. Click on Generate to update the tunnel in the model and click Close.

7.5 Generate the mesh
The default global coarseness parameter (Medium) can be accepted in this case.
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Medium (default).
3. Click the View mesh button
to view the mesh.

Figure 91: The generated mesh
4. Click the Close tab to close the Output program.

7.6 Define and perform the calculation
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To simulate the construction of the tunnel a staged construction calculation is needed in which the tunnel lining
is activated and the soil clusters inside the tunnel are deactivated. The calculation phases are Plastic analyses,
Staged construction. The three-dimensional arching effect is emulated by using the so-called β-method. The
idea is that the initial stresses pk acting around the location where the tunnel is to be constructed are divided
into a part (1-β) pk that is applied to the unsupported tunnel and a part Deconfinement method that is applied
to the supported tunnel.
To apply this method in PLAXIS 2D, one can use the Deconfinement option, which is available for each deactivated soil cluster in the model explorer. Deconfinement is defined as the aforementioned factor (1-β). For
example, if 60% of the initial stresses in a de-activated soil cluster should disappear in the current calculation
phase (so the remaining 40% is to be considered later), it means that the Deconfinement (1-β) parameter of
that inactive cluster should be set to 0.6. The value of Deconfinement can be increased in subsequent
calculation phases until it reaches 1.0.
To define the calculation process follow these steps:

7.6.1 Initial phase
1. Click on the Staged construction tab to proceed with the definition of the calculation phases.
2. The initial phase has already been introduced. Note that the soil layers are not horizontal. It is not
recommended in this case to use the K0 procedure to generate the initial effective stresses. Instead Gravity
will be used. This option is available in the General subtree of the Phases window.
loading
3. Water will not be considered in this example. The general phreatic level should remain at the model base.
4. Make sure that the tunnel is inactive.

7.6.2 Phase 1: First tunnel excavation (deconfinement)
1. Click the Add phase button
to create a new phase.
2. In the Staged construction mode deactivate the upper cluster in the tunnel. Do NOT activate the tunnel
lining.
3. While the de-activated cluster is still selected, in the Selection explorer set Deconfinement(1 - β) to 60 %.
The model for Phase 1 is displayed in the figure below.

Figure 92: Configuration of Phase 1
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7.6.3 Phase 2: First (temporary) lining
1. Click the Add phase button
to create a new phase.
2. In the Staged construction mode, activate the lining and interfaces of the part of the tunnel excavated in the
previous phase.
3. Select the de-activated cluster. In the Selection explorer set Deconfinement to 100 %.

Figure 93: Configuration of Phase 2

7.6.4 Phase 3: Second tunnel excavation (deconfinement)
1. Click the Add phase button
to create a new phase.
2. In the Staged construction mode deactivate the lower cluster (invert) and the temporary lining in the
middle of the tunnel.
3. While the lower de-activated cluster is still selected, set in the Selection explorer Deconfinement to 60%.

Figure 94: Configuration of Phase 3

7.6.5 Phase 4: Second (final) lining
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1. Click the Add phase button
to create a new phase.
2. Activate the remaining lining and interfaces.
All the plates and interfaces around the full tunnel are active.
3. Select the lower de-activated cluster. In the Selection explorer set Deconfinement to 100 %.

Figure 95: Configuration of Phase 4

7.6.6 Execute the calculation
1. Click the Select points for curves button
in the side toolbar.
2. Select a node at the slope crest point and the tunnel crest. These points might be of interest to evaluate the
deformation during the construction phases.
3. Click the Calculate button
to calculate the project.
4.

After the calculation has finished, save the project by clicking the Save button

.

7.7 Results
After the calculation, select the last calculation phase and click the View calculation results button. The Output
program is started, showing the deformed mesh at the end of the calculation phases:

Figure 96: The deformed mesh at the end of the final calculation phase
To display the bending moments resulting in the tunnel:
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1.

To select the lining of all the tunnel sections, click the corresponding button
in the side toolbar and drag
the mouse to define a rectangle where all the tunnel sections are included. Select the Plate option in the
appearing window:

and click View.
Note that the tunnel lining is displayed in the Structures view.
2. From the Forces menu select the Bending moment M option. The result, scaled by a factor of 0.5 is
displayed in the figure below.

Figure 97: Resulting bending moments in the NATM tunnel
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Cyclic vertical capacity and stiffness of circular
underwater footing
This tutorial illustrates how to calculate the vertical bearing capacity and vertical stiffness of a circular stiff
underwater footing (e.g. one of the footings of a jacket structure) exposed to cyclic loading during a storm. The
storm is idealised by a distribution of load parcels with different magnitude. The cyclic accumulation tool is used
to obtain soil parameters for the UDCAM-S model . The example considers a circular concrete footing with a
radius of 11 m, placed on an over-consolidated clay layer.
The procedure for establishing non-linear stress-strain relationships and calculating load-displacement curves
of a foundation under a cyclic vertical load component is presented. The analysis of the circular footing is
performed with a 2D axisymmetric model. The soil profile consists of clay with an overconsolidation ratio, OCR,
of 4, submerged unit weight of 10 kN/m3 and an earth pressure coefficient, K0, of 1. The (static) undrained shear
strength from anisotropically consolidated triaxial compression tests has a constant value with a depth of suC =
130 kPa. The maximum shear modulus, Gmax, of the clay is 67275 kPa. The cyclic behaviour of the soil is based on
contour diagrams for Drammen clay (Andersen, Kleven & Heien, 1988 2) assuming that the behaviour is
representative of the actual clay.

8.1 Objectives
• Obtain the UDCAM-S model input parameters by running the cyclic accumulation procedure, determining the
stress-strain curves and optimising the material model parameters.
• Calculate the total cyclic vertical bearing capacity.
• Calculate the vertical stiffness accounting for cyclic loading for both the total and the cyclic component.

8.2 Geometry
The soil properties and footing geometry are shown in the figure below.

2

Andersen, K.H., Kleven, A., Heien, .D. (1988). Cyclic soil data for design of gravity structures. Journal of
Geotechnical Engineering, 517–539.

PLAXIS

114

PLAXIS 2D - Tutorial Manual

Cyclic vertical capacity and stiffness of circular underwater footing
Create new project

1m
D = 22 m
OCR = 4
suc
= 130 kPa
Gmax = 67275 kPa

γ' = 10 kPa
w = 52 %
Ip = 27 %

Figure 98: Geometry of the project

8.3 Create new project
To create a new project, follow these steps:
1. Start the Input program and select Start a new project from the Quick select dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. In the Model tabsheet make sure that
a. Model is set to Axisymmetry and that
b. Elements is set to 15-Noded.
4. Define the limits for the model contour as
a. xmin = 0.0 m, xmax = 40.0 m
b. ymin = -30.0 m and ymax = 0.0 m

8.4 Define the soil stratigraphy
The sub-soil layers are defined using a borehole.
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Create a single soil layer with top level at 0.0 m and bottom level at -30.0m.
3. For simplicity, water is not taken into account in this example. The groundwater table is therefore set below
the bottom of the model, and the soil weight is based on the effective (underwater) weight.
4. In the borehole column specify a value of -50.00 for Head.
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Figure 99: Soil layer

8.5 Create and assign material data sets
Three material data sets need to be created; two for the clay layer (Clay - total load and Clay - cyclic load) and
one for the concrete foundation.
Open the Material sets window.

8.5.1 Material: Clay - total load
The model parameters for this material will be determined by the cyclic accumulation and optimisation tool.
The other properties are as shown in the following table:
Table 18: Material properties
Name

Clay - total load

Unit

Identification

-

Clay - total load

-

Material model

-

UDCAM-S model

-

Drainage type

-

Undrained (C)

-

γunsat

10

kN/m3

Parameter
General

Soil unit weight above phreatic level
To create the material set, follow these steps:

1. Create a new soil material data set: Choose Soil and interfaces as the Set type and click the New button.
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2. On the General tab enter the values according to Table 18 (on page 116).
3. Proceed to the Parameters tab.
Instead of entering the model parameters in this tab sheet, we will run the cyclic accumulation and optimisation
tool. This procedure consists of three steps.
Click the Cyclic accumulation and optimisation tool button on the Parameters tab:

Figure 100: Cyclic accumulation and optimisation tool
A new window opens:

Figure 101: Cyclic accumulation tool window
The three steps of the cyclic accumulation and optimisation procedure are represented by the three tab sheets
(Cyclic accumulation, Stress-strain curves and Parameter optimisation) in the window.

Cyclic accumulation
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The purpose of this step is to determine the equivalent number of undrained cycles of the peak load, Neq, for a
given soil contour diagram and load distribution.
The following storm composition data will be used:
Table 19: Composition of cyclic vertical load for a 6-hour design storm
#

Load ratio

N cycles

1

0.02

2371

2

0.11

2877

3

0.26

1079

4

0.40

163

5

0.51

64

6

0.62

25

7

0.75

10

8

0.89

3

9

1.0

1

1. Select an appropriate contour diagram from Select contour diagram data in the Cyclic accumulation tab.
In this case, select Drammen clay, OCR = 4.
Note: For more information about contour diagrams, see Andersen (2015) 3 and Reference Manual, Cyclic
accumulation and optimisation tool.
2. The load ratios and number of cycles from the storm composition can be entered in the empty table. The
storm composition is given in Table 19 (on page 118) (Jostad, Torgersrud, Engin & Hofstede, 2015) 4 as the
cyclic vertical load normalized with respect to the maximum cyclic vertical load (Load ratio) and the number
of cycles (N cycles). It is here assumed that the cyclic shear stress history in the soil is proportional to the
maximum cyclic vertical load of the footing. The table should be entered such that the smallest load ratio is at
the top and the highest load ratio is at the bottom.
Note: The design storm is a load history that is transformed into parcels of constant cyclic load. Each parcel
corresponds to a number of cycles at a constant amplitude determined from the time record of the load
component. See Reference Manual, Cyclic accumulation and optimisation tool, for more information.
When you've entered the load parcels in the table, the Load ratio vs N cycles graph will show a graphic
representation of the data. For the data given here and the logarithmic scale turned on, it will look like the
graph below.
3

4

Andersen, K.H. (2015). Cyclic soil parameters for offshore foundation design, volume The 3rd ISSMGE
McClelland Lecture of Frontiers in Offshore Geotechnics III. Meyer (Ed). Taylor & Francis Group, London, ISFOG
2015. ISBN 978-1-138-02848-7.
Jostad, H.P., Torgersrud, Ø., Engin, H.K., Hofstede, H. (2015). A fe procedure for calculation of fixity of jack-up
foundations with skirts using cyclic strain contour diagrams. City University London, UK.
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Figure 102: Load ratio vs N cycles graph (logarithmic scale)
3. Click Calculate to calculate the equivalent number of cycles Neq.
The selected contour diagram is plotted together with the shear stress history for a scaling factor where the
soil fails (here defined at 15% shear strain) at the last cycle (Figure 103 (on page 119)) and the loci of endpoints of the stress history for different scaling factors. The calculated equivalent number of cycles
corresponds to the value on the x-axis at the last point of the locus of end-points and is equal to 6.001.

Figure 103: Cyclic accumulation in PLAXIS 2D

Stress-strain curves
The purpose of this tab is to obtain non-linear stress-strain curves for a given (calculated) Neq and given cyclic
over average shear stress ratio (here taken equal to the ratio between cyclic and average vertical load during the
storm).
1. Go to the Stress-strain curves tab.
2. For the Neq determination, keep the default option From cyclic accumulation. The calculated equivalent
number of cycles is adopted from the previous tab.
3. Keep the Soil behaviour as Anisotropic, and the Scaling factor, DSS and Scaling factor, TX as 1.
Note:
• Cyclic strength can be scaled based on available soil specific cyclic strength.
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• If the plasticity index and/or water content of the soil is different from Drammen clay, the cyclic strength
can be scaled by applying a scaling factor different from 1 (see Andersen, 2015 5 for details).
4. Set the cyclic to average shear stress ratio for DSS, triaxial compression and triaxial extension, describing the
inclination of the stress path, to appropriate values. In this example, the following input values are selected to
obtain strain compatibility at failure, i.e. the same cyclic and average shear strain for the different stress
paths at failure.
a. cyclic to average ratio for DSS (Δτcyc/Δτ)DSS = 1.1,
b. triaxial compression (Δτcyc/Δτ)TXC = 1.3 and
c. extension (Δτcyc/Δτ)TXE = -6.3
5. Select the load type of interest, Total load case is selected for this first material.
DSS and triaxial contour diagrams are plotted together with stress paths described by the cyclic to average
ratios (Figure 104 (on page 120)). Notice that the shear stresses are normalised with respect to the static
undrained shear strength in compression. The extracted stress-strain curves are plotted below the contour
diagrams.
6. Click Calculate to produce the corresponding normalised stress-strain curves below the contour diagrams.
See Figure 104 (on page 120) for the outcome.

Figure 104: Stress-strain curves for total load

Parameter optimisation
5

Andersen, K.H. (2015). Cyclic soil parameters for offshore foundation design, volume The 3rd ISSMGE
McClelland Lecture of Frontiers in Offshore GeotechnicsIII. Meyer (Ed). Taylor & Francis Group, London, ISFOG
2015. ISBN978-1-138-02848-7.
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The purpose of the optimisation is to obtain a set of parameters for the UDCAM-S model.
The parameter ranges and the results you will see after the optimisation are shown in the following table:
Table 20: Parameter ranges and results after optimization
Parameter

Name

Min value

Max value

Optimised
value

Unit

Ratio of the initial shear modulus to the
degraded shear strength at failure in triaxial
compression

Gmax / τC

400.0

480.0

420.4

-

Shear strain at failure in triaxial compression

γfC

6.0

8.0

6.431

%

Shear strain at failure in triaxial extension

γfE

5.0

8.0

7.873

%

γfDSS

8.0

12.0

11.97

%

Ratio of the cyclic compression shear strength
over the undrained static compression shear
strength

τC / SuC

1.14

1.16

1.152

-

Ratio of the cyclic DSS shear strength over the
undrained static compression shear strength

τDSS / SuC

0.89

0.91

0.9051

-

Ratio of the cyclic extension shear strength over
the undrained static compression shear
strength

τE / SuC

0.62

0.64

0.6208

-

Reference degraded shear strength at failure in
the triaxial compression test

τCref

-

-

149.7

-

Reference depth

yref

-

-

0.000

m

Increase of degraded shear strength at failure in
the triaxial compression test with depth

τCinc

-

-

0.000

kN/m2
/m

Ratio of the degraded shear strength at failure
in the triaxial extension test to the degraded
shear strength in the triaxial compression test

τE / τC

-

-

0.5389

-

Initial mobilisation of the shear strength with
respect to the degraded TXC shear strength

τ0 / τC

-

-

2.332E-3

-

Ratio of the degraded shear strength at failure
in the direct simple shear test to the degraded
shear strength in the triaxial compression test

τDSS / τC

-

-

0.7858

-

Shear strain at failure in direct simple shear

Use the following steps to calculate the optimised values.
1. Click the Parameter optimisation tab.
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2. Enter the parameters of the clay in the Static properties. Set suCref to 130.0 and K0 determination to Manual
and set K0 to 1.0.
3. Propose minimum and maximum values for the parameters listed in Table 20 (on page 121).
Note:
In the optimisation, set minimum and maximum values of C / SuC, τDSS / SuC, and τE / SuC close to the results
from the strain interpolation if one wants to keep these values.
Calculate Gmax / τC by dividing Gmax from soil properties with results for (τC / SuC) · SuC.
Set the minimum and maximum values close to this value.
4. Click Calculate to obtain optimised parameters (Figure 105 (on page 122) and column Optimised value of
Table 20 (on page 121)).
After a few seconds, the optimal values are shown in the corresponding column in the Parameter ranges
table. Based on these values, the optimised parameters are calculated and listed in the right-hand table.

Figure 105: Optimised parameters for total load
The resulting stress-strain curves from test simulations with the UDCAM-S model using the optimised
parameters are shown together with the target points from the contour diagrams.
5. When the calculation has finished, save the application state of the Cyclic accumulation and optimisation tool.
The saved data will be used when creating another material. To save the application state, press the Save
at the top of the window. Save the state under the file name optimised_total.json.
button
6. Copy the optimised material parameters: Press the Copy parameters button and go back to the SoilUDCAM-S window describing the material.
7.
Click the Paste material button
.
The values in the Parameters tab are replaced with the new values.
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Figure 106: Copy parameters into Clay total material
8. Go to the Initial tab and set K0 to 1 by setting K0 determination to Manual, check K0,x = K0,z (default) and set
K0,x to 1.
9. Click OK to close the created material.
10. Assign the Clay - total load material set to the soil layer in the borehole.

8.5.2 Material: Clay - cyclic load
Create a material for the second clay. Some information from the Clay - total load material will be reused. The
optimisation of the parameters has to be recalculated though, based on other conditions.
The parameter ranges and the results you will see after the optimisation are shown in the following table:
Table 21: Parameter ranges and results after optimisation
Parameter

Name

Min value

Max value

Optimised
value

Unit

Ratio of the initial shear modulus to the
degraded shear strength at failure in triaxial
compression

Gmax / τC

700.0

800.0

703.2

-

Shear strain at failure in triaxial compression

γfC

1.0

3.0

2.966

%

Shear strain at failure in triaxial extension

γfE

1.0

3.0

2.699

%
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Parameter

Name

Min value

Max value

Optimised
value

Unit

Shear strain at failure in direct simple shear

γfDSS

1.0

3.0

2.946

%

Ratio of the cyclic compression shear strength
over the undrained static compression shear
strength

τC / SuC

0.66

0.67

0.6667

-

Ratio of the cyclic DSS shear strength over the
undrained static compression shear strength

τDSS / SuC

0.47

0.49

0.4787

-

Ratio of the cyclic extension shear strength over
the undrained static compression shear
strength

τE / SuC

0.57

0.59

0.5790

-

Reference degraded shear strength at failure in
the triaxial compression test

τCref

-

-

86.67

-

Reference depth

yref

-

-

0.000

m

Increase of degraded shear strength at failure in
the triaxial compression test with depth

τCinc

-

-

0.000

kN/m2
/m

Ratio of the degraded shear strength at failure
in the triaxial extension test to the degraded
shear strength in the triaxial compression test

τE / τC

-

-

0.8684

-

Initial mobilisation of the shear strength with
respect to the degraded TXC shear strength

τ0 / τ C

-

-

0.000

-

Ratio of the degraded shear strength at failure
in the direct simple shear test to the degraded
shear strength in the triaxial compression test

τDSS / τC

-

-

0.7181

-

Use the following steps to calculate the optimised values.
1. Copy the Clay - total load material.
2. Enter Clay - cyclic load for the identification.
3. Go to the Parameters tab.
Like for the first material, also here the parameters will be determined using the Cyclic accumulation and
optimisation tool.
4. Click the Cyclic accumulation and optimisation tool button on the Parameters tab to open the tool.
5.
and choose the application state optimised_total.json that was saved
Click the Open file button
after optimisation of the first material.
All tabs will be filled with data.
6. Leave the Cyclic accumulation tab as is.
7. Go to the Stress-strain curves tab, set load type to Cyclic load.
8. Press Calculate and let the calculation finish.
The stress-strain curves are shown:
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9.
10.
11.
12.

PLAXIS

Figure 107: Stress-strain curves for cyclic load
Go to the Parameter optimisation tab. Accept the notification about resetting the optimisation tab to get
updated values.
Make sure that suCref is set to 130.0 and set K0 determination to Automatic.
Modify the minimum and maximum values for the Parameter ranges, see Table 21 (on page 123) for values.
Click Calculate to get the optimised parameters.
The optimised parameters are shown in the figure below and are also listed in the column 'Optimised value'
in Table 21 (on page 123).
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Figure 108: Optimised parameters for cyclic load
13. Save the application state under the file name optimised_cyclic.json.
14. Copy the optimised material parameters: Click the Copy parameters button and go back to the Soil-UDCAMS window.
15.
.
Click the Paste material button
The values in the Parameters tab are replaced with the new values.
16. Click OK to close the created material.

8.5.3 Material: Concrete
Create a new material for the concrete foundation.
1.
2.
3.
4.

Choose Soil and interfaces as the Set type and click the New button.
Enter Concrete footing for the Identification and select Linear elastic as the Material model.
Set the Drainage type to Non-porous.
Enter the properties of the layer:
a. a unit weight of 24 kN/m3,
b. Young's modulus of 30E6 kN/m2 and
c. a Poisson's ratio of 0.1.
5. Click OK to close the created material.
6. Click OK to close the Material sets window.
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8.6 Define the structural elements
The concrete foundation and interfaces have to be defined.

8.6.1 Define the concrete foundation
1. Click the Structures tab to proceed with the input of structural elements in the Structures model.
2. Select the Create soil polygon feature in the side toolbar and click on (0.0, 0.0), (11.0, 0.0), (11.0, -1.0) and
(0.0, -1.0).
Note: Do not yet assign the Concrete footing material to the polygon.

8.6.2 Define the interfaces
Create an interface to model the interaction of the foundation and the surrounding soil. Extend the interface half
a meter into the soil. Make sure the interface is at the outer side of the footing (inside the soil). The interface is
created in two parts.
1. Click Create interface to create the upper part from (11.0, -1.0) to (11.0, 0.0), Figure 109 (on page 128).
2. Click Create interface to create the lower part (between foundation and soil) from (11.0, -1.5) to (11.0, -1.0),
Figure 109 (on page 128).
3. The upper part interface (between the foundation and the soil) is modeled with a reduced strength of 30%.
a. Make a copy of the Clay - total load material and name it Clay - total load - interface .
b. Reduce the interface strength by setting Rinter to 0.3 and

c. assign this to the upper part of the interface.
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4. For Phase 3 (Calculate vertical cyclic stiffness), another material with reduced strength is needed.
a. Make a copy of the Clay - cyclic load material and name it Clay - cyclic load - interface.
b. Reduce the interface strength by setting Rinter to 0.3.
c. Do not assign this yet. It will be assigned when defining Phase 3.
5. For the interface material extended into the soil, full soil strength is applied (Rinter = 1.0), as implicitly defined
in the original clay material Clay - total load. Keep the default setting Material mode: From adjacent soil.

Figure 109: Geometry of the model

8.6.3 Define a vertical load
In order to calculate the cyclic vertical capacity and stiffness, a vertical load is applied at the top of the
foundation.
1. Define a distributed load by selecting Create line load and click (0.0, 0.0) and (11.0, 0.0).
2. In the Selection explorer set the value of qy,start,ref to -1000 kN/m/m.

8.7 Generate the mesh
1. Proceed to the Mesh mode.
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2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Medium (default).
3. Click the View mesh button
to view the mesh.

Figure 110: The generated mesh
4. Click the Close tab to close the Output program.

8.8 Define and perform the calculation
The calculation consists of the following phases:
• In the Initial phase, the initial stress conditions are generated by the K0 procedure, using the default values.
• In Phase 1 the footing is activated by assigning the Concrete material to the corresponding polygon. The
interfaces are also activated.
• In Phase 2 the total cyclic vertical bearing capacity and stiffness are calculated.
• In Phase 3 the cyclic vertical bearing capacity and stiffness are computed.

8.8.1 Initial phase
1. Proceed to Staged construction mode.
2. In the Phases explorer double-click the initial phase.
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3. Make sure that Calculation type is set to K0 procedure.
4. Click OK to close the Phases window.

8.8.2 Phase 1: Footing and interface activation
1. Click the Add phase button
to create a new phase.
2. Phase 1 starts from the Initial phase.
3. Activate the footing by assigning the Concrete footing material to the corresponding polygon.
4. Activate the interfaces as well.

8.8.3 Phase 2: Bearing capacity and stiffness
In Phase 2 the total cyclic vertical bearing capacity and stiffness are calculated. The vertical bearing capacity is
obtained by increasing the vertical load (stress) until failure. The stiffness is calculated as the force divided by
the displacement.
1. Click the Add phase button
to create a new phase.
2. Phase 2 starts from Phase 1.
3. In the Phases window go to the Deformation control parameters subtree and select the Reset
displacements to zero option and Reset small strain.
4. Activate the line load.

8.8.4 Phase 3: Calculate vertical cyclic stiffness
In Phase 3, which also starts from Phase 1, the vertical cyclic stiffness is calculated by activating the Clay - cyclic
load material. The vertical bearing capacity is obtained by increasing the vertical load (stress) until failure.
1. Click the Add phase button
to create a new phase.
2. In the Phases window set the Start from phase to Phase 1.
3. Go to the Deformation control parameters subtree and select the Reset displacements to zero option and
Reset small strain. Close this window.
4. Replace the soil material with the Clay - cyclic load.
5. Assign the material Clay - cyclic load - interface material to the upper part of the interface. The material
mode of the lower part of the interface remains From adjacent soil.
6. Activate the line load.
The calculation definition is now complete.
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8.8.5 Execute the calculation
Before starting the calculation it is recommended to select nodes or stress points for a later generation of loaddisplacement curves or stress and strain diagrams.
To do this, follow these steps:
1. Click the Select points for curves button
in the side toolbar.
The connectivity plot is displayed in the Output program and the Select points window is activated.
2. Select a node at the bottom of the footing (0.0, 0.0). Close the Select points window.
3. Click on the Update tab to close the Output program and go back to the Input program.
4. Click the Calculate button
to calculate the project.

8.9 Results
8.9.1 Total load cyclic vertical bearing capacity
Applied vertical stress (load): qy = -1000 kN/m2
Failure at: qy = 719.1 kN/m2(Figure 111 (on page 131))
Total vertical bearing capacity: Vcap = qy · Area = 719.1 kN/m2 · π · (11 m)2 = 273.35 MN

Figure 111: Load displacement curve for total load
For comparison, the static vertical bearing capacity (using the static undrained shear strength) is found to be
228.1 MN. The reason for the larger vertical bearing capacity is that the shear strengths increase due to the
higher strain rate during wave loading, compared to the value obtained from standard monotonic laboratory
tests, and this effect is larger than the cyclic degradation during the storm.
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8.9.2 Cyclic load cyclic vertical bearing capacity
Applied vertical stress (load): qy = -1000 kN/m2
Failure at: qy = 458.1 kN/m2(Figure 112 (on page 132))
Total vertical bearing capacity:
Vcap = qy · Area = 458.1 kN/m2 · π · (11 m)2 = 174.14 MN

Figure 112: Load displacement curve for cyclic load

8.9.3 Vertical stiffness
The vertical stiffness (accounting for cyclic loading) is calculated as ky = Fy / uy for both the total and the cyclic
component. The total vertical displacement includes accumulated vertical displacements during the storm. Load
versus stiffness is shown in the following image:

Figure 113: Vertical load versus stiffness for total and cyclic load components
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This example concerns the stability of a reservoir dam under conditions of drawdown. Fast reduction of the
reservoir level may lead to instability of the dam due to high pore water pressures that remain inside the dam.
To analyse such a situation using the finite element method, a fully coupled flow-deformation analysis is
required. Time-dependent pore pressure is coupled with deformations development and used in a stability
analysis. This example demonstrates how coupled analysis and stability analysis can interactively be performed
in PLAXIS 2D.
Objectives
• Defining time-dependent hydraulic conditions (Flow functions)
• Defining transient flow conditions using water levels
Geometry
The dam to be considered is 30 m high and the width is 172.5 m at the base and 5 m at the top. The dam consists
of a clay core with a well graded fill at both sides. The normal water level behind the dam is 25 m high. A
situation is considered where the water level drops 20 m. The normal phreatic level at the right hand side of the
dam is 10 m below ground surface.
50 m

77.5 m

5m

37.5 m

90 m

25 m

Fill

5m

Core
y

30 m
Fill
x

Subsoil

30 m

120 m

20 m

120 m

Figure 114: Geometry of the project

9.1 Create new project
To create the new project, follow these steps:
1. Start the Input program and select Start a new project from the Quick start dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
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3. Keep the default units and constants and set the model Contour to:
a. xmin = -130.0 m, xmax = 130.0 m
b. ymin = -30.0 m and ymax = 30.0 m

9.2 Define the soil stratigraphy
In order to define the underlying foundation soil, a borehole needs to be added and material properties must be
assigned. A layer of 30 m overconsolidated silty sand is considered as sub-soil in the model.
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Add a soil layer extending from ground surface (y = 0.0) to a depth of 30 m (y = -30.0).

9.3 Create and assign material data sets
Three material data sets need to be created for the soil layers.
The layers have the following properties:
Table 22: Material properties of the dam and subsoil
Parameter

Name

Core

Fill

Subsoil

Unit

Material model

Model

MohrCoulomb

MohrCoulomb

MohrCoulomb

-

Type of material behaviour

Type

Undrained (B)

Drained

Drained

-

Soil unit weight above phreatic level

γunsat

16.0

16.0

17.0

kN/m3

Soil unit weight below phreatic level

γsat

18.0

20.0

21.0

kN/m3

E'

1.5·103

2.0·104

5.0·104

kN/m2

Poisson's ratio

νur'

0.35

0.33

0.3

-

Cohesion

cref'

-

5.0

1.0

kN/m2

Undrained shear strength

su,ref

5.0

-

-

kN/m2

φ'

-

31

35.0

°

General

Parameters
Young's modulus

Friction angle
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Parameter

Name

Core

Fill

Subsoil

Unit

ψ

-

1.0

5.0

°

Young's modulus inc.

Einc'

300

-

-

kN/m2/
m

Reference level

yref

30

-

-

m

Undrained shear strength inc.

su,inc

3.0

-

-

kN/m2

Data set

-

Hypres

Hypres

Hypres

-

Model

-

Van
Genuchten

Van
Genuchten

Van
Genuchten

-

Subsoil /Topsoil

-

Subsoil

Subsoil

Subsoil

-

Type

-

Very fine

Coarse

Coarse

-

None

None

None

-

Dilatancy angle

Groundwater

Flow parameters - Use defaults
Horizontal permeability

kx

1.0·10-4

1.00

0.01

m/day

Vertical permeability

ky

1.0·10-4

1.00

0.01

m/day

To create the material sets, follow these steps:
1.

Open the Material sets window.
2. Create data sets under the Soil and interfaces set type according to the information given in Table 22 (on
page 134). Note that the Thermal, Interfaces and Initial tabsheets are not relevant (no thermal properties,
no interfaces or K0 procedure are used).
3. Assign the Subsoil material dataset to the soil layer in the borehole.

9.4 Define the dam
The dam will be defined in the Structures mode.
1.

Click the Polygon button
and (-2.5 30.0).

to define a polygon. Specify points located at (-80.0 0.0), (92.5 0.0), (2.5 30.0)

2. Click the Cut polygon button
to create the sub-clusters in the dam. Define two cutting lines from (-10.0
0.0) to (-2.5 30.0) and from (10.0 0.0) to (2.5 30.0).
3. Assign the corresponding material datasets to the soil clusters.
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9.5 Generate the mesh
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
in the side toolbar. For the Element distribution parameter, use the
option Fine.
3. Click the View mesh button
to view the mesh.

Figure 115: The generated mesh
4. Click the Close tab to close the Output program.

9.6 Define and perform the calculation
The following cases will be considered:
•
•
•
•

A long term situation with water level at 25 m
A quick drop of the water level from 25 to 5 m
A slow drop of the water from 25 to 5 m
A long term situation with water level at 5 m

In addition to Initial phase, the calculation consists of eight phases. In the initial phase, initial stresses and
initial pore water pressures of the dam under normal working conditions are calculated using Gravity loading.
For this situation the water pressure distribution is calculated using a steady-state groundwater flow
calculation. The first and second phases both start from the initial phase (i.e. a dam with a reservoir level at 25
m) and the water level is lowered to 5 m. A distinction is made in the time interval at which this is done (i.e.
different speeds of water level reduction; rapid drawdown and slow drawdown). In both cases the water
pressure distribution is calculated using a fully coupled flow-deformation analysis. The third calculation phase
also starts from the initial phase and considers the long-term behaviour of the dam at the low reservoir level of 5
m, which involves a steady-state groundwater flow calculation to calculate the water pressure distribution.
Finally, for all the water pressure situations the safety factor of the dam is calculated by means of phi-c
reduction.
Note that only the water conditions will be defined for different calculation phases. The model requires no
changes in the geometry. Water levels can be defined in the Flow conditions mode.
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9.6.1 Initial phase: Gravity loading
By default the initial phase is added in the Phases explorer.
1.
2.
3.
4.
5.

Proceed to the Flow conditions mode by clicking the corresponding tab.
Activate Fill and Core.
In the Phases explorer double-click Initial phase.
In the General subtree specify the name of the phase (e.g. High reservoir).
Select the Gravity loading option

as calculation type.

6.

Select the Steady state groundwater flow option
as Pore pressure calculation type.
7. Uncheck the Ignore suction option in the Deformation control parameters subtree.
The Phases window is displayed.

Figure 116: The Phases window
8. Click OK to close the Phases window.
Note: Note that by default Undrained behaviour (A) and (B) are ignored for a Gravity loading calculation
type. The corresponding option is available in the Deformation control parameters subtree in the Phases
window
9.

Define the water level corresponding to the level of water in the reservoir prior to the drawdown. The
water level consists of four points; starting at the very left side at a level of 25 m above the ground surface
(-132.0 25.0); the second point is just inside the dam at a level of 25 m (-10.0 25.0); the third point is near the
dam toe (93.0 -10.0) and the forth point just outside the right boundary at a level of 10 m below the ground
surface (132.0 -10.0).
Note: Straight lines can be defined by keeping the Shift key pressed while defining the geometry.
The defined water level is shown in the figure:
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Figure 117: High water level in the reservoir
10. Right-click the created water level and select the Make global option in the appearing menu.
Note that the global water level can also be specified by selecting the corresponding option in the
GlobalWaterLevel menu in the Water subtree in the Model conditions.
11. In the Model explorer expand the Attributes library.
12. Expand the Water levels subtree. The levels created in the Flow conditions mode are grouped under User
water levels.
13. Expand the User water levels subtree.
The created water level can be seen named as UserWaterLevel_1. The location of the water levels in Model
explorer is shown in the figure:

Figure 118: Water levels in Model explorer
14. Double-click on the created water level and rename it as ' FullReservoir_steady'. This is a distinctive name
that satisfies the naming requirements (no invalid characters).
15. Expand the Model conditions subtree.
16. Expand the GroundWaterFlow subtree.
Note that by default the boundary at the bottom of the model is set to Closed. This is relevant for this
example.
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Figure 119: GroundwaterFlow boundary conditions in Model explorer

9.6.2 Phase 1: Rapid drawdown
In this phase rapid drawdown of the reservoir level is considered.
1. Click the Add phase button
to create a new phase.
2. In the Phases explorer double-click the newly added phase.
The Phases window is displayed.
3. In the General subtree specify the name of the phase (e.g. Rapid drawdown). Note that the High reservoir
phase is automatically selected in the Start from phase drop-down menu.
4.
Select the Fully coupled flow-deformation option
as calculation type.
5. Assign a value of 5 days to the Time interval parameter.
6. Make sure that the Reset displacements to zero and Reset small strain options are selected in the
Deformation control parameters subtree.
7. Click OK to close the Phases window.
8. Due to the global nature of the water levels, if an attribute is assigned to a water level in the model it will
affect it in all phases. The water level in this phase has the same geometry with the one previously defined,
however it is time dependent and a function needs to be assigned to it. As a result, it is required to create a
new water level with the same geometry and different attributes. In Model explorer right-click on
FullReservoir_Steady and select the Duplicate option in the appearing menu.
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A copy of the water level is created.
9. Rename the newly created water level as 'FullReservoir_Rapid'.
The behaviour of the water levels can be described by specifying Flow functions. Note that Flow functions
are global entities and are available under the Attributes library in Model explorer.
To define the flow functions:
a. Right-click the Flow functions option in the Attributes library in the Model explorer and select the
Edit option in the appearing menu. The Flow functions window is displayed.
b. In the Head functions tabsheet add a new function by clicking the corresponding button . The new
function is highlighted in the list and options to define the function are displayed.
c. Specify a proper name to the function for the rapid drawdown (e.g. Rapid).
d. Select the Linear option from the Signal drop-down menu.
e. Specify a time interval of 5 days.
f. Assign a value of -20 m to ΔHead, representing the amount of the head decrease.
A graph is displayed showing the defined function.
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10.
11.
12.
13.

Figure 120: The flow function for the rapid drawdown case
g. Click OK to close the Flow functions window.
In the Model explorer right-click on FullReservoir_Rapid and select the Use as global water level option
in the appearing menu.
Expand the FullReservoir_Rapid subtree. Note that the water level is composed of 3 water segments. Select
the water segment in the upstream shoulder (left from the dam, at the reservoir side).
Expand the subtree of the selected segment and select the Time dependent option for the
TimeDependency parameter.
Select the Rapid option for the HeadFunction parameter.
The following figure shows the selected water segment in Model explorer.

Figure 121: Properties of the lowering water segment
14. In the Water subtree under the Model conditions in the Model explorer note that the new water level
(FullReservoir_Rapid) is assigned to GlobalWaterLevel.
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The configuration of the phase is shown in the following figure.

Figure 122: Configuration of the rapid drawdown phase
Note that the shadow under the water level segment in the upstream shoulder indicates the variation of the
water level during the phase.

9.6.3 Phase 2: Slow drawdown
In this phase the drawdown of the reservoir level is performed at a lower rate.
1. Select the High reservoir phase in the Phases explorer.
2. Click the Add phase button
to create a new phase.
3. In Phases explorer double-click the newly added phase. The Phases window is displayed.
4. In the General subtree specify the name of the phase (e.g. Slow drawdown). The High reservoir phase is
automatically selected for the Start from phase parameter.
5.
Select the Fully coupled flow deformation option
as calculation type.
6. Assign a value of 50 days to the Time interval parameter.
7. Make sure that the Reset displacements to zero and Reset small strain options are selected in the
Deformation control parameters subtree. The Ignore suction option is unchecked by default.
8. Click OK to close the Phases window.
9. Create a new duplicate of the high water level. The newly created water level will be used as Global water
level in the slow drawdown phase. Even though the water level in this phase has the same geometry as the
previously defined ones, the flow function for the time dependency is different.
10. Rename the newly created water level as 'FullReservoir_Slow'.
11.
Add a new flow function following the steps described for the previous phase.
a. Specify a proper name to the function for the slow drawdown (e.g. Slow).
b. Select the Linear option from the Signal drop-down menu.
c. Specify a time interval of 50 days.
d. Assign a value of -20 m to ΔHead, representing the amount of the head decrease. A graph is displayed
showing the defined function.
e. Click OK to close the Flow functions window.
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Figure 123: The flow function for the slow drawdown case
12. In the Model explorer right-click on FullReservoir_Slow and select the Use as global water level option in
the appearing menu.
13. Expand the FullReservoir_Slow subtree. Select the water segment in the upstream shoulder (left from the
dam, at the reservoir side).
The segment selected in Model explorer is indicated by a red colour in the model.
14. Expand the subtree of the selected segment and select the Time dependent option for the
TimeDependency parameter.
15. Select the Slow option for the HeadFunction parameter.
In the Water subtree under the Model conditions in the Model explorer note that the new water level
(FullReservoir_Slow) is assigned to GlobalWaterLevel.

9.6.4 Phase 3: Low level
This phase considers the steady-state situation of a low reservoir level.
1. Select the High reservoir phase in the Phases explorer.
2. Click the Add phase button
to create a new phase.
3. In Phases explorer double-click the newly added phase.
The Phases window is displayed.
4. In the General subtree specify the name of the phase (e.g. Low level). The High reservoir phase is
automatically selected for the Start from phase parameter.
5.
is selected as calculation type.
Make sure that the Plastic option
6.
Make sure that the Steady state groundwater flow option
is selected as Pore pressure calculation
type
7. In the Deformation control subtree, select Ignore und. behaviour (A,B) and make sure that the Reset
displacements to zero and Reset small strain options are selected in the Deformation control
parameters subtree.
8. Uncheck the Ignore suction option in the Deformation control parameters subtree.
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9. Click OK to close the Phases window.
10.
Define the water level corresponding to the level of water in the reservoir after the drawdown. The water
level consists of four points; starting at the very left side at a level of 5 m above the ground the surface
(-132.0 5.0); the second point is inside the dam at a level of 5 m (-60.0 5.0); third point at (93.0 -10.0) and the
fourth point just outside the right boundary at a level of 10 m below the ground surface (132.0 -10.0).
11. Rename the newly created water level as 'LowLevel_Steady'.
12. In the Water subtree under the Model conditions in the Model explorer assign the new water level
(LowLevel_Steady) to GlobalWaterLevel.

Figure 124: Model for the low level case in the Flow conditions mode
All the defined water levels are shown in the following figure.

9.6.5 Phase 4 to 7
In Phases 4 to 7 stability calculations are defined for the previous phases.
1. Select the parent phase in the Phases explorer.
2. Click the Add phase button
to create a new phase. Proceed to the Phases window.
3. Set Calculation type to Safety .
4. In the Deformation control subtree, select Reset displacements to zero.
5. In the Numerical control parameters subtree, uncheck Use default iter parameter box and set the Max
steps parameter to 30 for Phase 4 and to 50 for phases 5 to 7.
6. In the Deformation control parameters subtree, check the Ignore suction option for all the safety
analyses.
Note: Taking suction into account in a Safety phase gives a higher factor of safety, hence ignoring suction in a
Safety phase is more conservative. In the Safety analysis of PLAXIS 2D, any unbalance due to changing from
suction to no suction is first solved before the factor of safety is determined. As a result, ΣMsf can decrease in
the first part of the calculation.
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Figure 125: The final view of Phases explorer

9.6.6 Execute the calculation
1. Proceed to the Staged construction mode.
2.
Select nodes located at the crest (-2.5 30.0) and at the toe of the dam (-80.0 0.0).
3. Click the Calculate button
to calculate the project and ignore the warnings regarding the influence of
suction in the Safety analysis..
4.

Save the project after the calculation has finished.

9.7 Results
The results of the four groundwater flow calculations in terms of pore pressure distribution are shown in the
figures below. Four different situations were considered:
• The steady-state situation with a high (standard) reservoir level.

Figure 126: Pore pressure distribution, (pactive), for high reservoir level
• The pore pressure distribution after rapid drawdown of the reservoir level
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Figure 127: Pore pressure distribution, (pactive), after rapid drawdown
• The pore pressure distribution after slow drawdown of the reservoir level

Figure 128: Pore pressure distribution, (pactive), after slow drawdown
• The steady-state situation with a low reservoir level

Figure 129: Pore pressure distribution, (pactive), for low reservoir level
Note:
The phreatic level can be smoother with a high refinement of the mesh in the core.
When the change of pore pressure is taken into account in a deformation analysis, some additional deformation
of the dam will occur. These deformations and the effective stress distribution can be viewed on the basis of the
results of the first four calculation phases. Here, attention is focused on the variation of the safety factor of the
dam for the different situations. Therefore, the development of ΣMsf is plotted for the phases 4 to 7 as a function
of the displacement of the dam crest point (-2.5 30.0), see .

PLAXIS

146

PLAXIS 2D - Tutorial Manual

Stability of dam under rapid drawdown
Results

Figure 130: Safety factors for different situations
Rapid drawdown of a reservoir level can reduce the stability of a dam significantly. Fully coupled flowdeformation and stability analysis can be performed with PLAXIS 2D to effectively analyse such situations.
Note:
By removing the suction in the safety analysis, an out-of-balance force is introduced at the beginning of the
calculation. Without the contribution of the suction, the ΣMsf can decrease in the first part of the calculation.
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Flow through an embankment

In this chapter the flow through an embankment will be considered. Flow takes place from the left side (river) to
the right side (polder). As a result seepage will take place at the right side of the embankment. The position of
the phreatic level depends on the river water level, which varies in time.
Objectives
• Performing Flow only analysis
• Using cross section curves
Geometry
The figure below shows the layout of the embankment problem where free surface groundwater flow occurs.
The crest of the embankment has a width of 2.0 m. Initially the water in the river is 1.5 m deep. The difference in
water level between the river and the polder is 3.5 m.
6m

2m

10 m

2m

3m

3m
5m

3m

y
1m

x

Figure 131: Geometry of the project

10.1 Create new project
To create a new project, follow these steps:
1.
2.
3.
4.

PLAXIS

Start the Input program and select Start a new project from the Quick select dialog box.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-Node).
Set the model dimensions to:
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a. xmin = 0.0 m, xmax = 23.0 m
b. ymin = 0.0 m and ymax = 6.0 m
5. Keep the default values for units, constants and the general parameters and click OK.
The Project properties window closes.

10.2 Define the soil stratigraphy
A number of boreholes has to be defined according to the information in the table below.
Table 23: Information on the boreholes in the model
Borehole number

Location (x)

Head

Top

Bottom

1

2.0

4.5

3.0

0.0

2

8.0

4.5

6.0

0.0

3

10.0

4.0

6.0

0.0

4

20.0

1.0

1.0

0.0

To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 2.
The Modify soil layers window pops up.
2. Specify the head value as 4.5.
3. Add a soil layer in the borehole. Set the top level to 3. No change is required for the bottom boundary of the
layer.
4. Create the rest of the required boreholes according to the information given in Table 23 (on page 149).

10.3 Create and assign material data set
A material data set needs to be created for the soil layer.
The sand layer has the following properties:
Table 24: Material properties of the embankment material (sand)
Parameter

Name

Sand

Unit

-

Linear elastic

-

General
Material model
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Parameter

Name

Sand

Unit

-

Drained

-

Soil unit weight above phreatic level

γunsat

20

kN/m3

Soil unit weight below phreatic level

γsat

20

kN/m3

E'

1.0·104

kN/m2

νur'

0.3

-

Data set

-

Standard

-

Soil Type

-

Medium fine

-

Flow parameters - Use defaults

-

From data set

-

Drainage type

Parameters
Young's modulus
Poisson's ratio
Groundwater

To create the material sets, follow these steps:
1.

Define the soil material according to the table above and assign the material dataset to the cluster. Skip
the Interfaces and Initial tabsheets as these parameters are not relevant.
2. After assigning the material to the soil cluster close the Modify soil layers window.

10.4 Generate the mesh
1. Proceed to the Mesh mode.
2. Select the lines as shown in the figure below. In Selection Explorer specify a Coarseness factor of 0.5.

3. Click the Generate mesh button
to generate the mesh.
The Mesh options window appears.
4. Select the Fine option in the Element distribution drop-down menu and generate the mesh.
5. Click the View mesh button
to view the mesh.
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Figure 132: The generated mesh
6. Click the Close tab to close the Output program.

10.5 Define and perform the calculation
In this project only the flow related behaviour will be analysed. The calculation process consists of three phases
that will be defined in the Staged construction mode. In the initial phase, the groundwater flow in steady state
is calculated for an average river level. In Phase 1, the transient groundwater flow is calculated for a harmonic
variation of the water level. In Phase 2, the calculation is similar as in Phase 1, but the period is longer.
Click the Staged construction tab to proceed to the corresponding mode. A global level is automatically created
according to the head values specified for each borehole (Table 23 (on page 149)). The model in the Staged
construction mode is shown in the figure below.

Figure 133: The model in the Staged construction mode
Note: Note that the 'internal' part of the global water level will be replaced by the result of the groundwater flow
calculation.

10.5.1 Initial phase
1.
2.
3.
4.
5.

PLAXIS

Double-click the initial phase in the Phases explorer.
In the General subtree select the Flow only option as the Calculation type.
The default values of the remaining parameters are valid for this phase. Click OK to close the Phases window.
In the Model explorer expand the Model conditions subtree.
In the Model conditions expand the GroundwaterFlow subtree. The default boundary conditions are
relevant for the initial phase. Check that only the bottom boundary is closed.
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Figure 134: The groundwater flow boundary conditions for the initial phase
6. In the Model explorer expand the Groundwater flow BCs subtree. The boundary conditions at the
extremities of the model are automatically created by the program and listed under the GWFlowBaseBC.
Note: Note that when the boundary conditions under the Groundwater flow BCs subtree are active, the
model conditions specified in the GroundwaterFlow are ignored.

10.5.2 Phase 1
1. Click the Add phase button
to create a new phase.
2. In the Phases explorer double-click the current phase.
3. In the General subtree select the Transient groundwater flow option as pore pressure calculation type.
4. Set the Time interval to 1.0 day.
5. In the Numerical control parameters subtree set the Max number of steps stored parameter to 50. The
default values of the remaining parameters will be used.
6. Click OK to close the Phases window.
7. Click the Select multiple objects button
in the side toolbar.
8.

Click Select lines > Select water boundaries.
9. Select the hydraulic boundaries as shown in the following figure.
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10.
11.
12.
13.
14.
15.

Right-click and click Activate.
In the Selection explorer set the Behaviour parameter to Head.
Set href to 4.5.
Select the Time dependent option in the Time dependency drop-down menu.
Click on the Head function parameter.

to add a new head function.
Click the Add button
16. In the Flow functions window select the Harmonic option in the Signal drop-down menu. Set the amplitude
to 1.0 m, the phase angle to 0° and the period to 1.0 day.

Figure 135: The flow function for the rapid case
17. Click OK to close the Flow functions window.

10.5.3 Phase 2
1. Click the Add phase button
to create a new phase.
2. In the Phases explorer double-click the current phase.
3. In the General subtree select the Initial phase in the Start from phase drop-down menu.
4. Select the Transient groundwater flow option as Pore pressure calculation type.
5. Set the Time interval to 10.0 day.
6. In the Numerical control parameters subtree set the Max number of steps stored parameter to 50. The
default values of the remaining parameters will be used.
7. Click OK to close the Phases window.
8. In the Selection explorer click on the Head function parameter.
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9. Click the Add button
to add a new head function.
10. In the Flow functions window select the Harmonic option in the Signal drop-down menu. Set the amplitude
to 1.0 m, the phase angle to 0° and the period to 10.0 day

Figure 136: The flow function for the slow case
11. Click OK to close the Flow functions window.

10.5.4 Execute the calculation
To select points to be considered in curves:
1. In the Staged construction mode click the Select point for curves button
in the side toolbar.
The Connectivity plot is displayed in the Output program.
2. In the Select points window select nodes located nearest to (0.0 3.0) and (8.0 2.5) to be considered in curves.
3. Click Update to close the output program.
4. Click the Calculate button
to calculate the project.
5.

Save the project after the calculation has finished.

10.6 Results
In the Output program the Create animation tool can be used to animate the results displayed in the Output
program. To create the animation follow these steps:
1. Click the menu Stresses > Pore pressures > Groundwater head.
2. Select the menu File > Create animation. The corresponding window pops up.
3. Define the name of the animation file and the location where it will be stored. By default the program names
it according to the project and stores it in the project folder. In the same way animations can be created to
compare the development of pore pressures or flow field.
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4. Deselect the Initial phase and Phase 2, such that only Phase 1 is included in the animations and rename the
animation accordingly. The Create animation window looks like this:

Figure 137: Create animation window
To view the results in a cross section:
1. Click the Cross section button

in the side toolbar.

The Cross section points window pops up and the start and the end points of the cross section can be
defined.
Draw a cross section through the points (2.0 3.0) and (20.0 1.0). The results in the cross section are displayed
in a new window.
2. In the Cross section view select the menu Stresses > Pore pressures > p active.
3.
Select the Cross section curves option
in the Tools menu. After the curves window pops up, select the
menu Selection style > Individual steps.
4. Select Phase 1. The variation of the results in the cross section is displayed in a new window.
5. Do the same for Phase 2. This may take about 30 seconds.
6. The variation of the results due to different time intervals in harmonic variation at a specific cross section can
be compared, see the figures below.
It can be seen that the slower variation of the external water level has a more significant influence on the pore
pressures in the embankment and over a larger distance.
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Figure 138: Active pore pressure variation in the cross section in Phase 1

Figure 139: Active pore pressure variation in the cross section in Phase 2
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Flow around a sheet pile wall
In this tutorial the flow around a sheetpile wall will be analysed. The geometry model of the tutorial Dry
excavation using a tie back wall (on page 49) will be used. The Well feature is introduced in this example.
Objectives
• Using wells

11.1 Create and assign material data set
The material parameters remain unchanged from the original project. The used groundwater parameters are
shown in the table below.
Table 25: Flow parameters
Name

Silt

Sand

Loam

Unit

Data set

-

USDA

USDA

USDA

-

Model

-

Van Genuchten

Van Genuchten

Van Genuchten

-

Soil - Type

-

Silt

Sand

Loam

-

< 2μm

-

6.0

4.0

20.0

%

2μm - 50μm

-

87.0

4.0

40.0

%

50μm - 2mm

-

7.0

92.0

40.0

%

Flow parameters - Use defaults

-

From data set

From data set

From data set

Parameter
Groundwater

To create the project:
1. Open the project defined in the tutorial Dry excavation using a tie back wall (on page 49).
2. Save the project under a different name (e.g. 'Flow around a sheet pile wall').
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11.2 Define the structural elements
1. In the Structures mode click the Create hydraulic conditions button
2. Select the Create well option
in the appearing menu.

in the side toolbar.

3. Draw the first well by clicking on (42.0 23.0) and (42.0 20.0).
4. Draw the second well by clicking on (58.0 23.0) and (58.0 20.0).

11.3 Generate the mesh
1. Proceed to the Mesh mode.
2. Select the cluster and two wells as shown in the figure below. In Selection Explorer specify a Coarseness
factor of 0.25.

Figure 140: Indication of the local refinement of the mesh in the model
3. Click the Generate mesh button
to generate the mesh. Use the default option for the Element
distribution parameter (Medium).
4. Click the View mesh button
to view the mesh.

Figure 141: The generated mesh
5. Click the Close tab to close the Output program.
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11.4 Define and perform the calculation
1. Proceed to the Staged construction mode. In this project only a groundwater flow analysis will be
performed.
2.
In the Phases explorer remove the existing phases (Phases 1 to 6).

11.4.1 Initial phase
In this phase the initial steady-state pore pressure distribution is considered. To define the initial phase:
1. In the General subtree of the Phases window select the Flow only option in the Calculation type dropdown menu.
2. The standard settings for the remaining parameters are valid for this phase.
3. The default groundwater flow boundary conditions are valid. Only the bottom boundary of the model
(BoundaryYMin) is Closed whereas the rest of the boundaries are Open.
4. The water level created according to the head specified in the borehole is assigned as GlobalWaterLevel.

11.4.2 Phase 1
In this phase the lowering of the phreatic level in the excavation down to y = 20 m. This corresponds to the final
excavation level in the project Dry excavation using a tie back wall (on page 49).
1. Click the Add phase button
to create a new phase.
2. In the Phases window the calculation type is by default defined as Flow only.
3. The default option (Steady state groundwater flow) will be used as Pore pressure calculation type.
4. In the Staged construction mode activate the interface elements along the wall.
5. Multi-select the wells in the model and activate them.
6. In the Selection explorer the behaviour of the wells is by default set to Extraction.
7. Set the discharge value to 0.7 m3/day/m.
8. Set the hmin value to 20.0m. This means that water will be extracted as long as the groundwater head at the
wall location is at least 20 m.
The figure below shows the parameters assigned to the wells in the Selection explorer

Figure 142: Well properties
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Note: Total discharge in Phase 1 is similar to the total outflow at the final excavation level as obtained from the
tutorial Dry excavation using a tie back wall (on page 49).

11.4.3 Execute the calculation
The definition of the calculation process is complete.
1. Click the Calculate button
to calculate the project.
2.
Save the project after the calculation has finished.

11.5 Results
To display the flow field:
1. Select the Phase 1 in the drop down menu.
2. Click the menu Stresses > Groundwater flow > |q|.
A scaled representation of the results (scale factor = 5.0 ) is shown:

Figure 143: The resulting flow field at the end of Phase 1
Click the menu Stresses > Pore pressures > p active. Compare the results with the ones of the Phase 6 of the
project defined in the tutorial Dry excavation using a tie back wall (on page 49).
In the following figure, the resulting active pore pressures when the water level in the excavation is at y = 20 m
is displayed for both projects.
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Figure 144: Comparison of the resulting active pore pressures
A: Active pore pressures (Phase 6 in the tutorial Dry excavation using a tie back wall (on page 49))
B: Active pore pressures (Phase 1 in the current project)
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Potato field moisture content

This tutorial demonstrates the applicability of PLAXIS 2D to agricultural problems. The potato field tutorial
involves a loam layer on top of a sandy base. The water level in the ditches remains unchanged. The precipitation
and evaporation may vary on a daily basis due to weather conditions. The calculation aims to predict the
variation of the water content in the loam layer in time as a result of time-dependent boundary conditions.
Objectives
• Defining precipitation
Geometry
Due to the symmetry of the problem, it is sufficient to simulate a strip with a width of 15.0 m, as indicated in the
image below. The thickness of the loam layer is 2.0 m and the sand layer is 3.0 m deep.

0.75m 1.25m

15m

15m

Precipitation

Precipitation

0.75m
0.50m

Loam

0.75m

Sand

Figure 145: Potato field geometry

12.1 Create new project
To create a new project, follow these steps:
1. Start the Input program and select Start a new project from the Quick select dialog box.
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2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. In the Model tabsheet keep the default options for Model (Plane strain), and Elements (15-Node).
4. Set the model dimensions to:
a. xmin = 0.0 m and xmax = 15.0 m
b. ymin = 0.0 m and ymax = 5.0 m
5. Keep the default values for units, constants and the general parameters and press OK.
The Project properties window closes.

12.2 Define the soil stratigraphy
Due to the geometry of the model, the options for snapping should be changed.
1.

Click the Snapping options button

in the bottom toolbar.

Figure 146: Modification of the Number of snap intervals
2. In the appearing window set the Number of snap intervals to 100.
3. Click OK to close the Snapping window.
To define the soil stratigraphy:
4. Click the Create borehole button
and create two boreholes located at x = 0.75 and x = 2.00 respectively.
5. In the Modify soil layers window add two soil layers.
6. In the first borehole set Top = 3.75 and Bottom = 3.00 for the uppermost soil layer. Set Bottom = 0 for the
lowest soil layer.
7. In the second borehole set Top = 5.00 and Bottom = 3.0 for the uppermost soil layer. Set Bottom = 0 for the
lowest soil layer.
8. For both boreholes the Head is located at y = 4.25.
The image below shows the soil stratigraphy defined in the Modify water levels window.
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Figure 147: Soil stratigraphy in the Modify soil layers window

12.3 Create and assign material data sets
Two material data sets need to be created for the soil layers.
The layers have the following properties:
Table 26: Material properties of the material
Name

Loam

Sand

Unit

Material model

-

Linear elastic

Linear elastic

-

Drainage type

-

Drained

Drained

-

Soil unit weight above phreatic level

γunsat

19

20

kN/m3

Soil unit weight below phreatic level

γsat

19

20

kN/m3

E'

1.0·103

1.0·104

kN/m2

νur'

0.3

0.3

-

Data set

-

Staring

Staring

-

Model

-

Van Genuchten

Van Genuchten

-

Parameter
General

Parameters
Young's modulus
Poisson's ratio
Groundwater
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Parameter

Name

Loam

Sand

Unit

Subsoil/Topsoil

-

Topsoil

Subsoil

-

Type

-

Clayey loam (B9)

Loamy sand (O2)

-

Flow parameters - Use defaults

-

From data set

From data set

-

To create the material sets, follow these steps:
1.

Create the material data sets according to Table 26 (on page 164).
2. Assign the material data set to the corresponding clusters in the model.

12.4 Generate the mesh
1. Proceed to the Mesh mode.
2. Multi-select the line segments composing the upper boundary of the model:

Figure 148: The upper boundary of the model
3. In the Selection explorer set the Coarseness factor parameter to 0.5.
4. Click the Generate mesh button
to generate the mesh. Use the default option for the Element
distribution parameter (Medium).
5. Click the View mesh button
to view the mesh.

Figure 149: The generated mesh
6. Click the Close tab to close the Output program.
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12.5 Define and perform the calculation
The calculation process consists of two phases. In the initial phase, the groundwater flow in steady state is
calculated. In Phase 1, the transient groundwater flow is calculated.

12.5.1 Initial phase
1. Proceed to the Staged construction mode. In this project only groundwater flow analysis will be performed.
2. In the Phases window select the Flow only option as the Calculation type in the General subtree.
3. The default values of the remaining parameters are valid for this phase. Click OK to close the Phases window.
4.
Right-click the bottom boundary of the model and select the Activate option in the appearing menu.
5. In the Selection explorer select the Head option in the Behaviour drop-down menu and set href to 3.0.

6. In the Model explorer expand the Model conditions subtree.
7. Expand the GroundwaterFlow subtree. Set BoundaryXMin and BoundaryXMax to Closed.
8. Expand the Water subtree. The borehole water level is assigned to GlobalWaterLevel.
Note: Note that the conditions explicitly assigned to groundwater flow boundaries are taken into account. In
this tutorial the specified Head will be considered for the bottom boundary of the model, NOT the Closed
condition specified in the GroundwaterFlow subtree under the Model conditions.

12.5.2 Transient phase
In the transient phase the time-dependent variation of precipitation is defined.
A discharge function with the following precipitation data will be defined.
Table 27: Precipitation data

PLAXIS

ID

Time [days]

Δ Discharge [m3/day/m]

1

0

0
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ID

Time [days]

Δ Discharge [m3/day/m]

2

1

1·10-2

3

2

3·10-2

4

3

0

5

4

-2·10-2

6

5

0

7

6

1·10-2

8

7

1·10-2

9

8

0

10

9

-2·10-2

11

10

-2·10-2

12

11

-2·10-2

13

12

-1·10-2

14

13

-1·10-2

15

14

0

16

15

0

1. Click the Add phase button
to create a new phase.
2. In General subtree of the Phases window select the Transient groundwater flow as Pore pressure
calculation type.
3. Set the Time interval to 15 days.
4. In the Numerical control parameters subtree set the Max number of steps stored to 250. The default
values of the remaining parameters will be used.
5. Click OK to close the Phases window.
6. Note: To define the precipitation data a discharge function should be defined.
In the Model explorer expand the Attributes library subtree.
7. Right-click on Flow functions and select the Edit option in the appearing menu. The Flow functions window
pops up.
8. In the Discharge functions tabsheet add a new function.
9. Specify a name for the function and select the Table option in the Signal drop-down menu.
10. Click the Add row button to introduce a new row in the table. Complete the data using the values given in the
Table 27 (on page 166).
The following image shows the defined function for precipitation.
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11.
12.
13.
14.

Figure 150: The Flow function window displaying the precipitation data and plot
Close the windows by clicking OK.
In the Model explorer expand the Precipitation subtree under Model conditions and activate it. The
default values for discharge (q) and condition parameters (ψmin = -1.0 m and ψmax = 0.1m) are valid.
For the precipitation select the Time dependent option in the corresponding drop-down menu and assign
the defined function.
In the Model explorer set DischargeFunction_1 under Discharge function.

Figure 151: Precipitation in the Model explorer
Note: Negative values of precipitation indicate evaporation.

12.5.3 Execute the calculation

PLAXIS

168

PLAXIS 2D - Tutorial Manual

Potato field moisture content
Results
1. Click the Calculate button
to calculate the project.
2.
Save the project after the calculation has finished.

12.6 Results
The calculation was focused on the time-dependent saturation of the potato field.
To view the results:
1. Click the menu Stresses > Groundwater flow > Saturation.
2. Double click the legend.
The Legend settings window pops up. Define the settings as shown:

Figure 152: Value for settings
3. The following figure shows the spatial distribution of the saturation for the last time step.
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Figure 153: Saturation field at day 15
4. Create an animation of the transient phase for a better visualisation of the results.
5. It is also interesting to create a vertical cross section at x = 4 m and draw cross section curves for pore
pressure and saturation.
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Dynamic analysis of a generator on an elastic
foundation
Using PLAXIS 2D, it is possible to simulate dynamic soil-structure interaction. Here the influence of a vibrating
source on its surrounding soil is studied. Oscillations caused by the generator are transmitted through the
footing into the subsoil.
The physical damping due to the viscous effects is taken into consideration via the Rayleigh damping. Also, due
to axisymmetry 'geometric damping' can be significant in attenuating the vibration.
The modelling of the boundaries is one of the key points. In order to avoid spurious wave reflections at the
model boundaries (which do not exist in reality), special conditions have to be applied in order to absorb waves
reaching the boundaries.
Objectives
•
•
•
•

Defining a Dynamic calculation
Defining dynamic loads
Defining dynamic boundary conditions (viscous)
Defining material damping by means of Rayleigh damping

Geometry
The vibrating source is a generator founded on a 0.2 m thick concrete footing of 1 m in diameter.
Generator
1m
Sandy clay

Figure 154: Generator founded on elastic subsoil

13.1 Create new project
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To create the new project, follow these steps:
1. Start the Input program and select Start a new project from the Quick select dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. Due to the three dimensional nature of the problem, an axisymmetric model is used. In the Model tabsheet
select the Axisymmetric option for Model and keep the default option for Elements (15-Noded).
4. Keep the default values for units and constants and set the model contour to:
a. xmin = 0.0 m and xmax = 20.0 m
b. ymin = 0.0 m and ymax = 20.0 m
Note: The model boundaries should be sufficiently far from the region of interest, to avoid disturbances due
to possible reflections. Although special measures are adopted in order to avoid spurious reflections (viscous
boundaries), there is always a small influence and it is still a good habit to put boundaries far away. In a
dynamic analysis, model boundaries are generally taken further away than in a static analysis.

13.2 Define the soil stratigraphy
The subsoil consists of one layer with a depth of 10 m. The ground level is defined at y = 0. Note that water
conditions are not considered in this example. To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
2. Create a soil layer extending from ground surface (y = 0.0) to a depth of 10 m (y = -10.0).
3. Keep the Head in the borehole at 0.0 m. This means that the sub-soil is fully saturated.

13.3 Create and assign material data sets
The soil layer consists of sandy clay, which is assumed to be elastic. Create a data set under the Soil and
interfaces set type according to the information given in Table 28 (on page 172). The specified Young's
modulus seems relatively high. This is because the dynamic stiffness of the ground is generally considerably
larger than the static stiffness, since dynamic loadings are usually fast and cause very small strains.
Table 28: Material properties of the material
Name

Value

Unit

Material model

-

Linear elastic

-

Drainage type

-

Drained

-

γunsat

20

kN/m3

Parameter
General

Soil unit weight above phreatic level
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Parameter

Name

Value

Unit

γsat

20

kN/m3

E'

5.0·104

kN/m2

νur'

0.3

-

-

Automatic

-

Soil unit weight below phreatic level
Parameters
Young's modulus
Poisson's ratio
Initial
K0 determination

Note: When using Mohr-Coulomb or linear elastic models the wave velocities Vp and Vs are calculated from the
elastic parameters and the soil weight. Vp and Vscan also be entered as input; the elastic parameters are then
calculated automatically. See also Elastic parameters and the Wave Velocity relationships in the Reference
Manual.

13.4 Define the structural elements
The generator is defined in the Structures mode.
The material properties of the footing are defined in the table below.
Table 29: Material properties
Parameter

Name

Value

Unit

Material type

-

Elastic

-

Isotropic

-

Yes

-

EA1

7.6·106

kN/m

Bending stiffness

EI

2.4·104

kNm2/m

Weight

w

5.0

kN/m/m

0.0

-

Mechanical

Axial stiffness

Poisson's ration

ν

Rayleigh a

-

0.0

-

Rayleigh b

-

0.0

-
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Parameter
Prevent punching
1.

Name

Value

Unit

-

No

-

Create a plate extending from (0.0 0.0) to (0.5 0.0) to represent the footing.

2.

Define a material data set for the footing according to the information given in Table 29 (on page 173).
The footing is assumed to be elastic and has a weight of 5 kN/m2.
3. Apply a distributed load on the footing to model the weight of the generator as well as the vibrations that it
produces. The actual value of the load will be defined later.
The model is shown below:

Figure 155: Model layout

13.5 Generate the mesh
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
to generate the mesh. Use the default option for the Element
distribution parameter (Medium).
3. Click the View mesh button
to view the mesh.
The resulting mesh is shown. Note that the mesh is automatically refined under the footing.
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Figure 156: The generated mesh
4. Click the Close tab to close the Output program.

13.6 Define and perform the calculation
The calculation consists of 4 phases and it will be defined in the Staged construction mode.

13.6.1 Initial phase
1. Click the Staged construction tab to proceed with the definition of the calculation phases.
2. The initial phase has already been introduced. The default settings of the initial phase will be used in this
tutorial.

13.6.2 Phase 1: Footing
1. Click the Add phase button
to create a new phase. The default settings of the added phase will be used for
this calculation phase.
2. Activate the footing.
3. Activate the static component of the distributed load. In the Selection explorer set qy,start,ref value to -8
kN/m/m. Do not activate the dynamic component of the load.
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Figure 157: Specification of the static load component in the Selection explorer

13.6.3 Phase 2: Start generator
In this phase, a vertical harmonic load, with a frequency of 10 Hz and amplitude of 10 kN/m2, is applied to
simulate the vibrations transmitted by the generator. Five cycles with a total time interval of 0.5 sec are
considered.
1. Click the Add phase button
to create a new phase.
2. In the General subtree in the Phases window, select the Dynamic option

as calculation type.
3. Set the Dynamic time interval parameter to 0.5 s.
4. In the Deformation control parameters subtree in the Phases window select the Reset displacements to
zero parameter. The default values of the remaining parameters will be used for this calculation phase.
5. In the Model explorer expand the Attributes library subtree.
6. Right-click the Dynamic multipliers subtree and select the Edit option from the appearing menu.
The Multipliers window pops up.
7. Click the Load multipliers tab.
8. Click the Add button
to introduce a multiplier for the loads.
9. Define a Harmonic signal with an Amplitude of 10, a Phase of 0° and a Frequency of 10 Hz and as shown:
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Figure 158: Definition of a Harmonic multiplier
10.
In the Selection explorer, activate the dynamic component of the load (DynLineLoad_1).
11. Specify the components of the load as (qx, start, ref, qy, start, ref) = (0.0, -1.0). Click Multiplier_y in the dynamic
load subtree and select the LoadMultiplier_1 option from the drop-down menu.

Figure 159: Specification of the dynamic load component in the Selection explorer
Note: The dynamic multipliers can be defined in the Geometry modes as well as in the Calculation modes.
12. Special boundary conditions have to be defined to account for the fact that in reality the soil is a semi-infinite
medium. Without these special boundary conditions the waves would be reflected on the model boundaries,
causing perturbations. To avoid these spurious reflections, viscous boundaries are specified at Xmax and
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Ymin. The dynamic boundaries can be specified in the Model explorer > Model conditions > Dynamics
subtree.

Figure 160: Boundary conditions for Dynamic calculations

13.6.4 Phase 3: Stop generator
1. Click the Add phase button
to create a new phase.
2. In the General subtree in the Phases window, select the Dynamic option

as calculation type.
3. Set the Dynamic time interval parameter to 0.5 s.
4. In the Staged construction mode deactivate the dynamic component of the surface load. Note that the static
load is still active. The dynamic boundary conditions of this phase should be the same as in the previous
phase.

13.6.5 Execute the calculation
1. Click the Select points for curves button
in the side toolbar and select nodes located at the ground
surface (ex: (1.4 0.0), (1.9 0.0), (3.6 0.0)) to consider in curves.
2. Click the Calculate button
to calculate the project.
3.

PLAXIS

After the calculation has finished, save the project by clicking the Save button

178

.

PLAXIS 2D - Tutorial Manual

Dynamic analysis of a generator on an elastic foundation
Results

13.6.6 Additional calculation with damping
In a second calculation, material damping is introduced by means of Rayleigh damping. Rayleigh damping can be
entered in the material data set. The following steps are necessary:
1. Save the project under another name.
2. Open the material data set of the soil.
3. In the General tabsheet click the box next to the Rayleigh α parameter.
Note that the display of the General tabsheet has changed displaying the Single DOF equivalence box.
4. In order to introduce 5% of material damping, set the value of the ξ parameter to 5% for both targets and set
the frequency values to 1 and 10 for the Target 1 and Target 2 respectively.
5. Click on one of the definition cells of the Rayleigh parameters. The values of α and β are automatically
calculated by the program.

Figure 161: Input of Rayleigh damping
6. Click OK to close the data base.
7. Check whether the phases are properly defined (according to the information given before) and start the
calculation.

13.7 Results
The Curve generator feature is particularly useful for dynamic analysis. You can easily display the actual
loading versus time (input) and also displacements, velocities and accelerations of the pre-selected points versus
time. The evolution of the defined multipliers with time can be plotted by assigning Dynamic time to the x-axis
and uy to the y-axis.
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The figure below shows the response of the pre-selected points at the surface of the structure. It can be seen that
even with no damping, the waves are dissipated which can be attributed to the geometric damping.

Figure 162: Vertical displ.- time on the surface at different distances to the vibrating source (without damping)
The presence of damping is clear in the following figure.

Figure 163: Vertical displ.- time on the surface at different distances to the vibrating source (with damping)
It can be seen that the vibration is totally seized when some time is elapsed after the removal of the force (at t =
0.5 s). Also, the displacement amplitudes are lower. Compare the curves without and with damping.
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It is possible in the Output program to display displacements, velocities and accelerations at a particular time, by
choosing the appropriate option in the Deformations menu. The figure below shows the total accelerations in
the soil at the end of phase 2 (t = 0.5 s).

Figure 164: Acceleration (|a|) in the soil at the end of phase 2 (with damping)
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Pile driving

Pile driving is a dynamic process that causes vibrations in the surrounding soil. Moreover, excess pore pressures
are generated due to the quick stress increase around the pile.
In this example focus is put on the irreversible deformations below the pile. In order to simulate this process
most realistically, the behaviour of the sand layer is modelled by means of the Hardening Soil model with smallstrain stiffness.
Geometry
This example involves driving a concrete pile through an 11 m thick clay layer into a sand layer. The pile has a
diameter of 0.4 m.

Pile Ø 0.4 m

Clay

Sand

11 m

7m

Figure 165: Pile driving situation

14.1 Create new project
To create the new project, follow these steps:
1. Start the Input program and select Start a new project from the Quick start dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
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3. In the Model tabsheet select the Axisymmetry option for Model and keep the default option for Elements
(15-Noded).
4. Keep the default values for units and constants and set the model Contour to:
a. xmin = 0.0 m and xmax = 30.0 m
b. ymin = 0.0 m and ymax = 18.0 m

14.2 Define the soil stratigraphy
The subsoil is divided into an 11 m thick clay layer and a 7 m thick sand layer. The phreatic level is assumed to
be at the ground surface. Hydrostatic pore pressures are generated in the whole geometry according to this
phreatic line. To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
2. Create two soil layers extending from y = 18.0 to y = 7.0 and from y = 7.0 to y = 0.0.
3. Set the Head in the borehole at 18.0 m.

14.3 Create and assign material data sets
The clay layer is modelled with the Mohr-Coulomb model. The behaviour is considered to be Undrained (B). An
interface strength reduction factor is used to simulate the reduced friction along the pile shaft.
In order to model the non-linear deformations below the tip of the pile in a right way, the sand layer is modelled
by means of the Hardening Soil model with small-strain stiffnessmall. Because of the fast loading process, the
sand layer is also considered to behave undrained. The short interface in the sand layer does not represent soilstructure interaction. As a result, the interface strength reduction factor should be taken equal to unity (rigid).
The layers have the following properties:
Table 30: Material properties of the material
Parameter

Symbol

Clay

Sand

Pile

Unit

Material model

Model

Mohr-Coulomb

HS small

Linear elastic

-

Type of material behaviour

Type

Undrained (B)

Undrained (A)

Non-porous

-

Soil unit weight above phreatic
level

γunsat

16

17

24

kN/m3

Soil unit weight below phreatic
level

γsat

18

20

-

kN/m3

General
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Parameter

Symbol

Clay

Sand

Pile

Unit

Young's modulus (constant)

E'

5.0·103

-

3·107

kN/m2

Secant stiffness in standard
drained triaxial test

E50ref

-

5.0·104

-

kN/m2

Tangent stiffness for primary
oedometer loading

Eoedref

-

5.0·104

-

kN/m2

Unloading / reloading stiffness

Eurref

-

1.5·105

-

kN/m2

Power for stress-level dependency
of stiffness

m

-

0.5

-

-

Poisson's ratio

νur

0.3

0.2

0.1

-

Cohesion

c'ref

-

0

-

kN/m2

Undrained shear strength

su,ref

5.0

-

-

kN/m2

Friction angle

φ'

0

31.0

-

°

Dilatancy parameter

ψ

0

0

-

°

Shear strain at which Gs = 0.722
G0

γ0.7

-

1.0·10-4

-

-

Shear modulus at very small
strains

G0ref

-

1.2·105

-

kN/m2

Young's modulus inc.

E'inc

1.0·103

-

-

kN/m2

Reference level

yref

18

-

-

m

Undrained shear strength inc.

su,inc

3

-

-

kN/m2

Reference level

yref

18

-

-

m

Interface strength type

Type

Manual

Rigid

Rigid

-

Interface strength

Rinter

0.5

1.0

1.0

-

-

Automatic

Automatic

Automatic

-

K0,x

0.5000

0.4850

0.5000

-

Parameters

Interface

Initial
K0 determination
Lateral earth pressure coefficient
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1.

Create the material data sets according to Table 30 (on page 183).

14.4 Define the structural elements
The pile is defined as a column of 0.2 m width. The Interface elements are placed along the pile to model the
interaction between the pile and the soil. The interface should be extended to about half a meter into the sand
layer. Note that the interface should be defined only at the side of the soil. A proper modelling of the pile-soil
interaction is important to include the material damping caused by the sliding of the soil along the pile during
penetration and to allow for sufficient flexibility around the pile tip.
Note: Use the Zoom in feature to create the pile and the interface.

Pile
Interface
Clay
(0.0, 7.0)

(0.2, 7.0)
Extended interface
(0.2, 6.6)

Sand

Figure 166: Extended interface

14.4.1 Define the pile
To define the concrete pile:
1. Click the Structures tab to proceed with the input of structural elements in the Structures mode.
2.
Select the Create polygon feature
in the side toolbar and click on (0.0 18.0), (0.2 18.0), (0.2 7.0) and (0.0
7.0).
3.
Create a negative interface to model the interaction of the pile with the surrounding soil by clicking on
(0.2 6.6) and (0.2 18.0).
The pile is made of concrete, which is modelled by means of the linear elastic model considering non-porous
behaviour. In the beginning, the pile is not present, so initially the clay properties are also assigned to the pile
cluster.
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14.4.2 Define a load
In order to model the driving force, a distributed unit load is created on top of the pile. To create a dynamic load:
1.

Define a distributed load by clicking on Create load > Create line load from the tool bar and then on
(0.0 18.0) and (0.2 18.0).
2. The load components will be defined in the Selection explorer. Note that the static component of the load
will not be used in this project. The program will neglect the static components of the load if it (static load) is
not activated.
3. Expand the Dynamic load subtree and specify a unit load in the gravity direction.
4. Click the Multiplier_y drop down menu and click on the appearing plus button .

The Multipliers window pops up and a new load multiplier is automatically added.
5. Define a Harmonic signal with an Amplitude of 5000, a Phase of 0° and a Frequency of 50 Hz and as shown
in the figure below. During the pile driving phase, we will only consider half a cycle (0.01 s) of this signal.

Figure 167: Definition of an Harmonic multiplier
Note:
Note that dynamic multipliers can be defined by right-clicking the Dynamic multipliers subtree under
Attributes library in the Model explorer.
Note that dynamic multipliers are attributes and as such it is possible to define them in all the program's
modes.
The final geometry model is shown in the following figure:
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Figure 168: The geometry model

14.5 Generate the mesh
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
to generate the mesh. Use the default option for the Element
distribution parameter (Medium).
3. Click the View mesh button
to view the mesh.
The resulting mesh is shown. Note that the mesh is automatically refined under the footing.
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Figure 169: The generated mesh
4. Click the Close tab to close the Output program.

14.6 Define and perform the calculation
The calculation consists of 3 phases. In the Initial phase, the initial stress conditions are generated. In the Phase
1 the pile is created. In the Phase 2 the pile is subjected to a single stroke, which is simulated by activating half a
harmonic cycle of load. In the Phase 3 the load is kept zero and the dynamic response of the pile and soil is
analysed in time. The last two phases involve dynamic calculations.

14.6.1 Initial phase
Initial effective stresses are generated by the K0 procedure, using the default values. Note that in the initial
situation the pile does not exist and that the clay properties should be assigned to the corresponding cluster. The
phreatic level is assumed to be at the ground surface. Hydrostatic pore pressures are generated in the whole
geometry according to this phreatic line.

14.6.2 Phase 1: Pile activation
1. Click the Add phase button
to create a new phase.
2. In the General subtree in the Phases window, the Plastic option is selected as Calculation type.
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3. The Staged construction option is by default selected as Loading type.
4. In the Staged construction mode assign the pile properties to the pile cluster.
5. Activate the interface in the Clay layer. The model for the Phase 1 in the Staged construction mode is
displayed below.

Figure 170: Configuration of Phase 1 in the Staged construction mode

14.6.3 Phase 2: Pile driving
1. Click the Add phase button
to create a new phase.
2. In the General subtree in the Phases window, select the Dynamic option as Calculation type.
3. Set the Dynamic time interval to 0.01 s.
4. In the Deformation control parameters subtree select Reset displacements to zero.
5. In the Staged construction mode activate the dynamic component of the distributed load.
The activated dynamic component of the load in Selection explorer is shown in the figure below.
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Figure 171: The dynamic load component in the Selection explorer
6. Expand the subtree Model explorer > Model conditions > Dynamics.

Figure 172: Boundary conditions for Dynamic calculations
7. Specify viscous boundaries at xmax and ymin.
The result of this phase is half a harmonic cycle of the external load. At the end of this phase, the load is back to
zero.

14.6.4 Phase 3: Fading
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1. Click the Add phase button
to create a new phase.
2. In the General subtree in the Phases window, select the Dynamic option as Calculation type.
3. Set the Dynamic time interval to 0.19 s.
4. In the Staged construction mode de-activate the dynamic load.

14.6.5 Execute the calculation
1. Click the Select points for curves button
in the side toolbar and select a node at the top of the pile for
load displacement curves.
2. Click the Calculate button
to calculate the project.
3.

After the calculation has finished, save the project by clicking the Save button

.

14.7 Results
Figure 173 (on page 191) shows the settlement of the pile (top point) versus time. From this figure the following
observations can be made:
• The maximum vertical settlement of the pile top due to this single stroke is about 13 mm. However, the final
settlement is almost 10 mm.
• Most of the settlement occurs in phase 3 after the stroke has ended. This is due to the fact that the
compression wave is still propagating downwards in the pile, causing additional settlements.
• Despite the absence of Rayleigh damping, the vibration of the pile is damped due to soil plasticity and the fact
that wave energy is absorbed at the model boundaries.

Figure 173: Pile settlement vs. time
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When looking at the output of the second calculation phase (t = 0.01 s, i.e. just after the stroke), it can be seen
that large excess pore pressures occur very locally around the pile tip. This reduces the shear strength of the soil
and contributes to the penetration of the pile into the sand layer. The excess pore pressures remain also in the
third phase since consolidation is not considered.
Figure 174 (on page 192) shows the shear stresses in the interface elements at t = 0.01 s. The plot shows that
the maximum shear stress is reached all along the pile, which indicates that the soil is sliding along the pile.

Figure 174: Maximum shear stresses in the interface at t = 0.01 s
When looking at the deformed mesh of the last calculation phase (t = 0.2 s), it can also be seen that the final
settlement of the pile is about 10 mm. In order to see the whole dynamic process it is suggested to use the option
Create Animation to view a 'movie' of the deformed mesh in time. You may notice that the first part of the
animation is slower than the second part.
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Free vibration and earthquake analysis of a building
This example demonstrates the natural frequency of a five-storey building when subjected to free vibration and
earthquake loading. The two calculations employ different dynamic boundary conditions:
• In the free vibration, the Viscous boundary conditions are considered. This option is suitable for problems
where the dynamic source is inside the mesh.
• For the earthquake loading, the Free-field and Compliant base boundary conditions are considered. This
option is preferred for earthquake analysis, where the dynamic input is applied at the bottom of the model.
Objectives
•
•
•
•
•
•

Performing a Dynamic calculation
Defining dynamic boundary conditions (free-field, compliant base and viscous)
Defining earthquakes by means of dynamic multipliers
Modelling free vibration of structures
Modelling hysteretic behaviour by means of Hardening Soil model with small-strain stiffnessmall
Evaluating the natural frequency from Fourier spectrum

Geometry
The building consists of 5 floors and a basement. It is 10 m wide and 17 m high including basement. The total
height from the ground level is 5 x 3 m = 15 m and the basement is 2 m deep. A value of 5 kN/m2 is taken as the
weight of the floors and the walls. The building is constructed on a clay layer of 15 m depth underlain by a deep
sand layer. In the model, 25 m of the sand layer will be considered.
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y

15 m

x

2m

15 m

25 m

75

10

75

Figure 175: Geometry of the project

15.1 Create new project
To create the new project, follow these steps:
1.
2.
3.
4.

Start the Input program and select Start a new project from the Quick start dialog box.
In the Project tabsheet of the Project properties window, enter an appropriate title.
In the Model tabsheet keep the default options for Model (Plane strain) and Elements (15-Noded).
Keep the default units and constants and set the model Contour to:
a. xmin = -80.0 m and xmax = 80.0 m
b. ymin = -40.0 m and ymax = 15.0 m

15.2 Define the soil stratigraphy
The subsoil is divided into a 15 m thick clay layer and a 25 m thick sand layer. The phreatic level is assumed to
be at y = -15.0 m. Hydrostatic pore pressures are generated in the whole geometry according to this phreatic
line.
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Add two soil layers extending from y = 0.0 to y = -15.0 and from y = -15.0 to y = -40.
3. Set the Head in the borehole at -15.0 m.
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15.3 Create and assign material data sets
The upper layer consists of mostly clayey soil and the lower one is sandy. Both have Hardening Soil model with
small-strain stiffnessmall properties. The presence of the groundwater is neglected. The soil layers with
Hardening Soil model with small-strain stiffnessmall properties have inherent hysteretic damping.
•

Open the Material sets window.
• Create data sets under Soil and interfaces set type according to the information given in Table 31 (on page
195).
• Assign the material datasets to the corresponding soil layers in the borehole.
Table 31: Material properties
Parameter

Name

Upper clay layer Lower sand layer

Unit

General
Material model

-

HS small

HS small

-

Type of material behaviour

-

Drained

Drained

-

Soil unit weight above phreatic level

γunsat

16

20

kN/m3

Soil unit weight below phreatic level

γsat

20

20

kN/m3

Secant stiffness in standard drained triaxial test

E50ref

2.0·104

3.0·104

kN/m2

Tangent stiffness for primary oedometer loading

Eoedref

2.561·104

3.601·104

kN/m2

Unloading / reloading stiffness

Eurref

9.484·104

1.108·105

kN/m2

m

0.5

0.5

-

c'ref

10

5

kN/m2

Friction angle

φ'

18

28

°

Dilatancy angle

ψ

0

0

°

Shear strain at which Gs = 0.722 G0

γ0.7

1.2·10-4

1.5·10-4

-

Shear modulus at very small strains

G0ref

2.7·105

1.0·105

kN/m2

Poisson's ratio

ν'ur

0.2

0.2

-

Parameters

Power for stress-level dependency of stiffness
Cohesion

When subjected to cyclic shear loading, the Hardening Soil model with small-strain stiffnesswill show typical
hysteretic behaviour. Starting from the small-strain shear stiffness, G0ref, the actual stiffness will decrease with
increasing shear. The figures below display the Modulus reduction curves, i.e. the decay of the shear modulus
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with strain. The upper curve shows the secant shear modulus and the lower curve shows the tangent shear
modulus.
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Figure 176: Modulus reduction curves for the upper clayey layer
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Figure 177: Modulus reduction curve for the lower sandy layer
In the Hardening Soil model with small-strain stiffnessmall, the tangent shear modulus is bound by a lower limit,
Gur.
Gur =

Eur
2 (1 + νur )

The values of Gurref for the Upper clay layer and Lower sand layer and the ratio to G0ref are shown in the table
below. This ratio determines the maximum damping ratio that can be obtained.
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Table 32: Gur values and ratio to G0ref
Parameter

Upper clayey layer

Lower sandy layer

Unit

39517

41167

kN/m2

6.75

2.5

-

Gur
G0ref/Gur

The figures below show the damping ratio as a function of the shear strain for the material used in the model. A
more detailed description about the modulus reduction curve to the damping curve can be found in the
literature.6
0.2

Damping ratio

0.15

0.1

0.05

0.00001

0.0001

0.001

0.01

Cyclic shear strain

Figure 178: Damping curve for the upper clay layer
0.2

Damping ratio

0.15

0.1

0.05

0.00001

0.0001

0.001

0.01

Cyclic shear strain

Figure 179: Damping curve for the lower sand layer

6

Brinkgreve, R.B.J., Kappert, M.H., Bonnier, P.G. (2007). Hysteretic damping in small-strain stiffness model. In
Proc. 10th Int. Conf. on Comp. Methods and Advances in Geomechanics. Rhodes, Greece, 737-742.
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15.4 Define the structural elements
The structural elements of the model are defined in the Structures mode.

15.4.1 Define the building
The building consists of 5 floors and a basement. It is 10 m wide and 17 m high including the basement. A value
of 5 kN/m2 is taken as the weight of the floors and the walls. The total height from the ground level is 5 x 3 m =
15 m and the basement is 2 m deep.
The plates, representing the walls and the floors in the building, are considered to be linear elastic. Note that two
different material datasets are used, one for the basement and the other for the rest of the building. The physical
damping in the building is simulated by means of Rayleigh damping. A description of Rayleigh damping
parameters is given in the Reference Manual.
Table 33: Material properties of the building (plate properties)
Parameter

Name

Rest of building

Basement

Unit

Material type

-

Elastic

Elastic

-

Isotropic

-

Yes

Yes

-

EA1

9.0·106

1.2·107

kN/m

Bending stiffness

EI

6.75·104

1.6·105

kNm2/m

Weight

w

10

20

kN/m/m

Poisson's ratio

ν

0.0

0.0

-

Rayleigh α

-

0.2320

0.2320

-

Rayleigh β

-

8.0·10-3

8.0·10-3

-

Prevent punching

-

No

No

-

Axial stiffness

Table 34: Material properties of the node-to-node anchor
Parameter

Name

Column

Unit

Material type

Type

Elastic

-

Axial stiffness

EA

2.5· 106

kN

Lspacing

3.0

m

Out-of-plane spacing
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1.

Create the vertical walls of the building passing through (-5.0 0.0) to (-5.0 15.0) and through (5.0 0.0) to
(5.0 15.0).
2. Use the same feature to define the vertical walls of the basement passing through (-5.0 -2.0) to (-5.0 0.0) and
through (5.0 -2.0) to (5.0 0.0).
3. Define the floors and the basement of the building as plates passing through (-5.0 -2.0) to (5.0 -2.0), (-5.0 0.0)
to (5.0 0.0), (-5.0 3.0) to (5.0 3.0), (-5.0 6.0) to (5.0 6.0), (-5.0 9.0) to (5.0 9.0), (-5.0 12.0) to (5.0 12.0) and
(-5.0 15.0) to (5.0 15.0).
4.
Define the material datasets for the structural elements in the building according to Table 33 (on page
198).
5. Assign the Basement material dataset to the vertical plates (2) and the lowest horizontal plate (all under the
ground level) in the model.
6. Assign the rest of the building material dataset to the remaining plates in the model.
7.
Use the Node-to-node anchor feature to define the column at the centre of the building connecting
consecutive floors, (0.0 -2.0) to (0.0 0.0), (0.0 0.0) to (0.0 3.0), (0.0 3.0) to (0.0 6.0), (0.0 6.0) to (0.0 9.0), (0.0
9.0) to (0.0 12.0) and (0.0 12.0) to (0.0 15.0).
8. Define the properties of the anchor according to Table 34 (on page 198) and assign the material dataset to
the anchors in the model.
9.
Define an interface to model the interaction between soil and the building.

15.4.2 Define the loads
1. In order to model the driving force, a distributed unit load is created on top of the pile. To create a dynamic
load:
a.
Create a point loadat the top left corner of the building.
b. Specify the components of the load as (10.0 0.0).
2. The earthquake is modelled by imposing a prescribed displacement at the bottom boundary. To define the
prescribed displacement:
a.
Define a prescribed displacement at the bottom of the model, through (-80.0 -40.0) and (80.0 -40.0).
b. Set the x-component of the prescribed displacement to Prescribed and assign a value of 1.0. The ycomponent of the prescribed displacement is Fixed. The default distribution (Uniform) is valid.
3. To define the dynamic multipliers for the prescribed displacement:
a. Expand the Dynamic displacement.
b. Click the Multiplier_x drop down menu and click on the appearing plus button . The Multipliers
window pops up and a new displacement multiplier is automatically added.
c. From the Signal drop-down menu select the Table option.
d. The file containing the earthquake data is available in the PLAXIS Knowledge Base (tutorial Free vibration
and earthquake analysis of a building). Copy all the data to a text editor file (e.g. Notepad) and save the file
in your computer with the extension .smc.
e. In the Multipliers window click the Open button and select the saved .smc file. In the Import data
window select the Strong motion CD-ROM files option from the Parsing method drop-down menu and
press OK to close the window.
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f. Select the Acceleration option in the Data type drop-down menu.
g. Select the Drift correction options and click OK to finalize the definition of the multiplier.
The defined multiplier is displayed:

Figure 180: Dynamic multipliers window

15.4.3 Create interfaces on the boundary
Free-field and Compliant base boundaries require the creation of interface elements along the vertical and
bottom boundaries of the model in the Structures mode. The interface elements must be added inside the model,
else the Free-field and Compliant base boundary conditions are ignored. To define the interfaces:
1.

Click the Create interfaces on the boundary button to automatically generate the interfaces at the
boundary of the model.

The geometry of the model is shown in the following figure:

Figure 181: Geometry of the model
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15.5 Generate the mesh
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
to generate the mesh. Set the Element distribution to Fine.
3. Click the View mesh button
to view the mesh.
The resulting mesh is shown:

Figure 182: The generated mesh
4. Click the Close tab to close the Output program.

15.6 Define and perform the calculation
The calculation process consists of the initial conditions phase, simulation of the construction of the building,
loading, free vibration analysis and earthquake analysis.

15.6.1 Initial phase
1. Click on the Staged construction tab to proceed with definition of the calculation phases.
2. The initial phase has already been introduced. The default settings of the initial phase will be used in this
tutorial.
3. In the Staged construction mode check that the building and load are inactive.
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Figure 183: Initial phase

15.6.2 Phase 1: Building
1. Click the Add phase button
to create a new phase. The default settings of the added phase will be used for
this calculation phase.
2. In the Staged construction mode construct the building (activate all the plates, the interfaces and the
anchors) and deactivate the basement volume.

Figure 184: Construction of the building

15.6.3 Phase 2: Excitation
1. Click the Add phase button
to create a new phase (Phase_2).
2. In the Phases window select the Reset displacement to zero in the Deformation control parameters
subtree. The default values of the remaining parameters will be used in this calculation phase.
3. In the Staged construction mode activate the load. The value of the load is already defined in the Structures
mode.
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15.6.4 Phase 3: Free vibration
1. Click the Add phase button
to create a new phase (Phase_3).
2. In the Phases window select the Dynamic option
as Calculation type.
3.
4.
5.
6.

Set the Dynamic time interval parameter to 5 sec.
In the Staged construction mode release (deactivate) the point load.
In the Model explorer expand the Model conditions subtree.
Expand the Dynamics subtree. Check the boundary conditions BoundaryXMin, BoundaryXMax and
BoundaryYMin are viscous which is the default option.

Figure 185: Boundary conditions for Dynamic calculations
Note:
For a better visualisation of the results, animations of the free vibration and earthquake can be created. If
animations are to be created, it is advised to increase the number of the saved steps by assigning a proper value
to the Max steps saved parameter in the Parameters tabsheet of the Phases window.

15.6.5 Phase 4: Earthquake
1. Click the Add phase button
to create a new phase (Phase_4).
2. In the Phases window set the Start from phase option to Phase 1 (construction of building).
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3. Select the Dynamic option
as Calculation type.
4. Set the Dynamic time interval parameter to 20 sec.
5. Select the Reset displacement to zero in the Deformation control parameters subtree. The default values
of the remaining parameters will be used in this calculation phase.
6. In the Model explorer expand the Model conditions subtree.
7. Expand the Dynamics subtree. Set the BoundaryXMin and BoundaryXMax to Free-field. Set the
BoundaryYMin to Compliant base.

Figure 186: Boundary conditions for Dynamic calculations (Phase_4)
8. Interface elements do not need to be active to enable the use of Free-field or Compliant base boundaries.
9. In the Model explorer activate the Line displacements and its dynamic component. Make sure that the
value of ux,start,ref is set to 0.5 m. Considering that the boundary condition at the base of the model will be
defined using a Compliant base, the input signal has to be taken as half of the bedrock (within) motion.

15.6.6 Execute the calculation
1. Click the Select points for curves button
in the side toolbar and select a point at the top of the building
for curves (0.0 15.0).
2. Click the Calculate button
to calculate the project.
3.

After the calculation has finished, save the project by clicking the Save button

.

15.7 Results
The figure below shows the deformed structure at the end of the Phase 2 (application of horizontal load).
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Figure 187: Deformed mesh of the system
The figure below shows the time history of displacements of the selected points A (0 15) for the free vibration
phase. It may be seen from the figure that the vibration slowly decays with time due to damping in the soil and in
the building.

Figure 188: Time history of displacements at selected points
In the Fourier tabsheet of the Curve generation window select the Power (spectrum) and click OK to create
the plot. The plot is shown below. From this figure it can be evaluated that the dominant building frequency is
around 1 Hz.
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Figure 189: Frequency representation (spectrum)
The figure below shows the time history of the lateral acceleration of the selected points A (0 15) for the
earthquake phase (dynamic analysis). For a better visualisation of the results animations of the free vibration
and earthquake can be created.

Figure 190: Variation of acceleration in dynamic time
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Thermal expansion of a navigable lock

A navigable lock is temporarily 'empty' due to maintenance. After some time there is significant increase of the
air temperature, which causes thermal expansion of the inner side of the lock, while the soil-side of the concrete
block remains relatively cold. This leads to backward bending of the wall and, consequently, to increased lateral
stress in the soil behind the wall and increased bending moments in the wall itself.
Objectives
This example demonstrates the use of the Thermal module to analyse this kind of situations.
• Defining a thermal temperature function
• Use of thermal expansion
• Performing a fully coupled analysis for THM calculation

Excavation
10 m

5m

6m

Geometry

Concrete lock

16 m

12 m

Sand

50 m

Figure 191: Geometry of the project

16.1 Create new project
1. Start the Input program and select Start a new project from the Quick start dialog box.
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2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. In the Model tabsheet, the default options for Model and Elements are used for this project. Also the default
options for the units are used in this tutorial.
4. Set the model Contour to
a. xmin = 0.0 m and xmax = 25.0 m,
b. ymin = -16.0 m and ymax = 0.0 m.
5. Click OK to close the Project properties window.

16.2 Define the soil stratigraphy
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Create a single soil layer with top level at 0.0 m and bottom level at -16.0 m. Set the head at -4.0 m.

16.3 Create and assign material data sets
Two data sets need to be created; one for the sand layer and one for the concrete block.
1.

Open the Material sets window.
2. Define a data set for the Sand layer with the parameters given in Table 35 (on page 208), for the General,
Parameters, Groundwater, Thermal and Initial tabsheets.
3. Create another dataset for Concrete according to the Table 35 (on page 208).
4. Assign the material dataset Sand to the borehole soil layer.
Table 35: Material properties
Name

Sand

Concrete

Unit

Material model

-

HS small

Linear elastic

-

Drainage type

-

Drained

Non-porous

-

Soil unit weight above phreatic level

γunsat

20.0

24.0

kN/m3

Soil unit weight below phreatic level

γsat

20.0

-

kN/m3

Initial void ratio

einit

0.5

0.5

-

Parameter
General

Parameters
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Parameter

Name

Sand

Concrete

Unit

Young's modulus

E'

-

25· 106

kN/m2

Poisson's ratio

ν

-

0.15

-

Secant stiffness in standard drained triaxial test

E50ref

40· 103

-

kN/m2

Tangent stiffness for primary oedometer loading

Eoedref

40· 103

-

kN/m2

Unloading / reloading stiffness

Eurref

1.2· 105

-

kN/m2

m

0.5

-

-

cref'

2.0

-

kN/m2

Friction angle

φ'

32.0

-

°

Dilatancy angle

ψ

2.0

-

°

Shear strain at which Gs = 0.722 G0

γ0.7

0.1· 10-3

-

-

Shear modulus at very small strains

G0ref

8· 104

-

kN/m2

Data set

-

USDA

-

-

Model

-

Van Genuchten

-

-

Soil - Type

-

Sandy clay

-

-

Flow parameters - Use defaults

-

From data set

-

-

Specific heat capacity

cs

860

900

kJ/t/K

Thermal conductivity

λs

4.0·10-3

1.0·10-3

kW/m/
K

Solid thermal expansion

-

Linear

Linear

-

Soil density

ρs

2.6

2.5

t/m3

X-component of thermal expansion

αx

0.5·10-6

0.1·10-4

1/K

Y-component of thermal expansion

αy

0.5·10-6

0.1·10-4

1/K

Z-component of thermal expansion

αz

0.5·10-6

0.1·10-4

1/K

Power for stress-level dependency of stiffness
Cohesion

Groundwater

Thermal

Interfaces
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Parameter

Name

Sand

Concrete

Unit

-

Rigid

Manual

-

Rinter

1.0

0.67

-

-

Automatic

Automatic

-

Interface strength
Strength reduction factor
Initial
K0determination

16.4 Define the structural elements
The lock will be modelled as a concrete block during the staged construction.
1. Proceed to Structures mode.
2.
Click the Create soil polygon button
in the side toolbar and select the Create soil polygon option.
3. Define the lock in the drawing area by clicking on (0.0 -5.0), (5.0 -5.0), (5.0 0.0), (5.5 0.0), (6.0 -6.0), (0.0 -6.0)
and (0.0 -5.0).
Note:
The Snapping options can be selected, and the Spacing can be set to 0.5 to easily create the polygon.
The Concrete material will be assigned later in the Staged construction.
4. Click the Create line button in the side toolbar.
5. Select the Create thermal flow bc option in the expanded menu.
6. Create thermal boundaries at vertical boundaries and the bottom boundary (Xmin, Xmax and Ymin).
7. The vertical boundaries have the default option of Closed for the Behaviour.
8. Select the bottom boundary, in the Selection explorer set the Behaviour to Temperature.
9. Set the reference temperature, Tref to 283.4 K.

Figure 192: Thermal boundary condition in the Selection explorer
The geometry of the model is now complete.

PLAXIS

210

PLAXIS 2D - Tutorial Manual

Thermal expansion of a navigable lock
Generate the mesh

Figure 193: Geometry of the model

16.5 Generate the mesh
1. Proceed to the Mesh mode.
2. Select the polygon representing the concrete block, and in the Selection explorer set the Coarseness factor
to 0.25.
3. Click the Generate mesh button
to generate the mesh. The default element distribution of Medium is
used for this example.
4. Click the View mesh button
to view the mesh.
The resulting mesh is shown:
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Figure 194: The generated mesh
5. Click the Close tab to close the Output program.

16.6 Define and perform the calculation
The calculations for this tutorial is carried out in three phases. The concrete lock is activated in a plastic
calculation, after which the temperature increase is defined as a fully coupled flow deformation analysis.

16.6.1 Initial phase
1.
2.
3.
4.
5.

Click on the Staged construction tab to proceed with the definition of the calculation phases.
Double click on Initial phase in the Phases explorer.
The default options for Calculation type and Pore pressure calculation type are used in this example.
Select Earth gradient for the Thermal calculation type option and close the Phases window.
In the Staged construction activate the ThermalFlow under the Model conditions subtree and set the
value for Tref to 283 K. The default values for href and Earth gradient are valid.

Figure 195: Thermal flow in the Selection explorer
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Figure 196: Initial phase

16.6.2 Phase 1: Construction
1. Click the Add phase button
to create a new phase (Phase_1).
2. Double click on Phase_1 in the Phases explorer.
3. In the Phases window, enter an appropriate name for the phase ID and select Steady state groundwater
flow
as Pore pressure calculation type.
4. Set the Steady state thermal flow
for the Thermal calculation type.
5. Make sure that the Reset displacements to zero and Ignore suction options are selected.
6. In the Staged construction mode, assign the Concrete dataset to the created polygon which represents the
navigable lock.
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Figure 197: Assigning Concrete soil data set to the navigable lock
7. Right click the soil cluster which is cut-off by the polygon and select the option Deactivate
appearing menu.
8. In the Selection explorer, set the WaterConditions of this cluster to Dry.
9. Multi-select the vertical and bottom horizontal wall of the excavation.
10. In the Selection explorer, activate the Groundwater flow boundary condition.
11. Set the Behaviour to Head and the href to -5.0 m.
This will simulate an 'empty' lock.

from the

Figure 198: Groundwater flow boundary condition in the Selection explorer
12. In the Model explorer, activate all the Thermal flow boundary conditions.
13. In the Model explorer, activate the Model conditions > Climate condition.
14. Set the Air temperature to 283.0 K and the Surface transfer to 1.0 kW/m2/K.
This will define the thermal conditions at the ground surface and the inside of the lock.
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Figure 199: Model conditions for Phase_1
15. Deactivate the ThermalFlow option. This is because the thermal flow boundary conditions, including climate
condition, are used in a steady state thermal flow calculation, instead of the earth gradient option.
The following figure shows the model at the end of Phase_1

Figure 200: The model at the end of Phase_1

16.6.3 Phase 2: Heating
1. Click the Add phase button
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2. Double click on Phase_2 in the Phases explorer.
3. Set the Calculation type to Fully coupled flow deformation .
4. The Thermal calculation type is set to Use temperatures from previous phase

. This is to indicate that
temperature needs to be considered and that the initial temperature is taken from the previous phase.
5. The Time interval is set to 10 days.
6. Make sure that the Reset displacements to zero and Reset small strain options are selected in the
Deformation control parameters subtree. The Ignore suction option is unchecked by default.
7. A temperature function is defined for the Time dependency in Climate which is used for this phase. Follow
these steps to create a temperature function.
a. Right-click the Thermal functions option in the Attributes library in the Model explorer and select
Edit option in the appearing menu.
The Thermal functions window is displayed.
b. In the Temperature functions tabsheet add a new function by clicking on the corresponding button .
The new function is highlighted in the list and options to define the function are displayed.
c. The default option of Harmonic is used for this signal.
d. Assign a value of 15.0 for the Amplitude and 40 days for the Period.
A graph is displayed showing the defined function. Since the time interval of the phase is 10 days, only a
quarter of a temperature cycle is considered in this phase, which means that after 10 days the
temperature has increased by 15 K.

Figure 201: The temperature function
e. Click OK to close the Thermal functions window.
8. Expand the subtree Model conditions in the Model explorer.
9. In the Climate option, set the Time dependency to Time dependent and assign the temperature function
which was created.
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Figure 202: Model conditions for Phase_2
The calculation definition is now complete.

16.6.4 Execute the calculation
Before starting the calculation it is suggested that you select nodes or stress points for a later generation of
curves.
1. Click the Select points for curves button
in the side toolbar and select some characteristic points for
curves (for example at the top of the excavation, (5.0, 0.0)).
2. Click the Calculate button
to calculate the project and ignore the warnings regarding different stress
type used in the Fully coupled flow deformation analysis.
3.

After the calculation has finished, save the project by clicking the Save button

.

16.7 Results
In the Phases explorer, select the Initial phase and click the View calculation results button on the toolbar. In
the Output program, select the menu Stresses > Heat flow > Temperature.
The figure below shows the initial temperature distribution, which is obtained from the reference temperature
at the ground surface and the earth gradient. This gives a temperature of 283.0 K at the ground surface and
283.4 at the bottom of the model.
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Figure 203: Initial temperature distribution
The figure below shows the temperature distribution obtained from Phase_1 using a steady-state thermal flow
calculation. In fact, the temperatures at the top and bottom are equal to the temperatures as defined in the
Initial phase; however, since the temperature at the ground surface is now defined in terms of Climate
conditions (air temperature), this temperature is also applied at the inner side of the lock and affects the
temperature distribution in the ground.

Figure 204: Steady-state temperature distribution in Phase_1
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The most interesting results are obtained in Phase_2 in which the air temperature in the Climate condition
increases gradually from 283 K to 298 K (defined by a quarter of a harmonic cycle with an amplitude of 15K).
The figure below shows the temperature at the ground surface as a function of time.

Figure 205: Temperature distribution in Point A as a function of time
As a result of the short increase in temperature at the inside of the concrete block, while the outer side (soil side)
remains 'cold', the wall will bend towards the soil. The figure below shows the deformed mesh at the end of
Phase_2.

Figure 206: Deformed mesh at the end of Phase_2
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As a result of this backward bending, the lateral stresses in the soil right behind the concrete block will increase,
tending towards a passive stress state.

Figure 207: Effective principal stresses at the end of Phase_2 in the Principal directions
Note: Note that the visualisation is different for Figure 207 (on page 220), because it displays the stresses in the
porous materials. This can be changed in View > Settings on the tab Results (see the Reference Manual for
more information).
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Freeze pipes in tunnel construction

This tutorial illustrates change in coupling of groundwater flow and thermal flow as a result of ground freezing.
A tunnel is constructed with the use of freeze pipes. By first installing freeze pipes in the soil, the soil freezes and
becomes watertight so that tunnel construction can take place. This method of construction requires a lot of
energy for the cooling of the soil, so by being able to model the cooling behaviour while groundwater flow is
present an optimal freezing system can be designed.
Objectives
• Modelling soil freezing, coupling between thermal flow and groundwater flow
• Modelling unfrozen water content.
• Using the command line for structure definition.
Geometry
In this tutorial a tunnel with a radius of 3.0 m will be constructed in a 30 m deep soil layer. A groundwater flow
from left to right is present, influencing the thermal behaviour of the soil. First the soil will be subjected to the
low temperatures of the freeze pipes, and once the soil has frozen sufficiently, tunnel construction can take
place. The latter is not included in this tutorial.
Because groundwater flow causes an asymmetric temperature distribution, the whole geometry needs to be
modelled, where in previous examples only half of the geometry was sufficient.
Y

X

15 m

30 m

42.5 m

Radius = 3.0 m

85 m

Figure 208: Geometry of the project
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17.1 Create new project
1. Start the Input program and select Start a new project from the Quick start dialog box.
2. In the Project tabsheet of the Project properties window, enter an appropriate title.
3. In the Model tabsheet, the default options for Model and Elements are used for this project. Also the default
options for the units are used in this tutorial. Note that the unit of Mass is set automatically to tonnes.
4. Set the model Contour to
a. xmin = 0.0 m and xmax = 85.0 m,
b. ymin = -30.0 m and ymax = 0.0 m.
5. In the Constants tabsheet, set Twater and Tref to 283 K, other constants keep their default values. A
description of constants can be found in the Reference Manual.
6. Click OK to close the Project properties window.

17.2 Define the soil stratigraphy
To define the soil stratigraphy:
1. Click the Create borehole button
and create a borehole at x = 0.
The Modify soil layers window pops up.
2. Create a single soil layer with top level at 0.0 m and bottom level at -30.0 m. Set the head at ground level (0.0
m).

17.3 Create and assign material data sets
1.

Click the Materials button
in the Modify soil layers window.
2. Define a data set for soil with the parameters given in Table 36 (on page 222), for the General, Parameters
and Groundwater tabsheets.
Table 36: Material properties
Name

Sand

Unit

Material model

-

Mohr-Coulomb

-

Type of material behaviour

-

Drained

-

Parameter
General
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Parameter

Name

Sand

Unit

Soil unit weight above phreatic level

γunsat

18.0

kN/m3

Soil unit weight below phreatic level

γsat

18.0

kN/m3

Initial void ratio

einit

0.5

-

Young's modulus

E'

1· 105

kN/m2

Poisson's ratio

ν

0.3

-

cref'

0.0

kN/m2

Friction angle

φ'

37.0

°

Dilatancy angle

ψ

0.0

°

Soil - Data set

-

Standard

-

Soil - Type

-

Medium

-

Flow parameters - Use defaults

-

None

-

Horizontal permeability

kx

1.00

m/day

Vertical permeability

ky

1.00

m/day

Change of permeability

ck

1.0· 1015

-

Specific heat capacity

cs

860

kJ/t/K

Thermal conductivity

λs

4.0·10-3

kW/m/K

Soil density

ρs

2.6

t/m3

X-component of thermal expansion

αx

5.0·10-6

1/K

Y-component of thermal expansion

αy

5.0·10-6

1/K

Z-component of thermal expansion

αz

5.0·10-6

1/K

Unfrozen water content

-

User defined (see table below)

-

Parameters

Cohesion

Groundwater

Thermal
Thermal

Interfaces
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Parameter

Name

Sand

Unit

Interface strength

-

Rigid

-

Thermal resistance

R

0

m2K/kW

-

Automatic

-

Initial
K0 determination

To model the amount of (fluid) water available to flow through the soil at certain temperatures, a curve for
unfrozen water content needs to be determined by defining a table with values for unfrozen water content at
certain temperatures. The same curve can be applied in other projects, hence the table can be saved and
loaded into the soil properties of other projects. For more information, refer to the Reference Manual.
3. Click the Thermal tab. Enter the values as given in the table below.
Table 37: Input for unfrozen water content curve for sand
#

Temperature [K]

Unfrozen water content [-]

1

273.0

1.00

2

272.0

0.99

3

271.6

0.96

4

271.4

0.90

5

271.3

0.81

6

271.0

0.38

7

270.8

0.15

8

270.6

0.06

9

270.2

0.02

10

269.5

0.00

4. Select the option User defined from the drop down menu for Unfrozen water content at the bottom of the
tabsheet.
5. Add rows to the table by clicking the Add row button . Complete the data using the values given in Table
37 (on page 224).
6. Enter the values for Interfaces and Initial tabsheets as given in Table 36 (on page 222).
7. Click OK to close the dataset.
8. Assign the material dataset to the soil layer.
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Note:
The table can be saved by clicking the Save button in the table. The file must be given an appropriate name. For
convenience, save the file in the same folder as the project is saved.

17.4 Define the structural elements
The freeze pipes are modelled by defining lines with a length similar to the freeze pipe diameter (10 cm),
containing a convective boundary condition. For simplicity, in this tutorial only 12 cooling elements are defined,
while in reality more elements may be implemented in order to achieve a sufficient share of frozen soil.
1. Proceed to Structures mode.
2. Click the Create line button in the side toolbar.
3. Click the command line and type "line 45.141 -13.475 45.228 -13.425". Press Enter to create the first
freezing pipe. For more information regarding command line, see Reference Manual.
4. Similarly create the remaining freeze pipes according to the following table.
Table 38: Coordinates of the end points of the freezing pipes, modelled as lines

PLAXIS

Line number

xpoint 1

ypoint 1

xpoint 2

ypoint 2

1

45.141

-13.475

45.228

-13.425

2

44.025

-12.359

44.075

-12.272

3

42.500

-11.950

42.500

-11.850

4

40.975

-12.359

40.925

-12.272

5

39.859

-13.475

39.772

-13.425

6

39.450

-15.000

39.350

-15.000

7

39.859

-16.525

39.772

-16.575

8

40.975

-17.641

40.925

-17.728

9

42.500

-18.050

42.500

-18.150

10

44.025

-17.641

44.075

-17.728

11

45.141

-16.525

45.228

-16.575

12

45.550

-15.000

45.650

-15.000
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Note:
A file containing the commands for the definition of the lines, is available in the PLAXIS 2D Knowledge Base
(LineCoordinatesCommands.p2dxlog in tutorial Freeze pipes in tunnel construction). This can be
downloaded and copied in the Commands runner, to get the pipes.
5.

Multi select the created lines using the Select lines option

from the side toolbar.

6. Right click the selected lines and select Thermal flow BC to create the thermal flow boundary conditions
for the freeze pipes.
7. For the selected freeze pipes, in the Selection explorer expand the subtree for the ThermalFlowBC.
8. The Behaviour is set to Convection, the Tfluid to 250 K and the Transfer coefficient to 1.0 kW/m2/K.
9. Click the Create line button in the side toolbar.
10. Select the Create thermal flow BC option
in the expanded menu. In the drawing area create a thermal
boundary condition from (0.0 0.0) to (85.0 0.0)
11.

Click the Create line button in the side toolbar, select the Create groundwater flow BC option
in the
expanded menu. In the drawing area create a groundwater flow boundary condition from (0.0 0.0) to (85.0
0.0).
12. Similarly follow the above steps to create thermal and groundwater flow boundary for the following lines
(85.0 0.0) to (85.0 -30.0); (85.0 -30.0) to (0.0 -30.0) and finally (0.0 -30.0) to (0.0 0.0).
PLAXIS 2D allows different types of Thermal boundary conditions to be applied. In this tutorial the freeze pipes
will be modelled as convective boundary conditions.
1. Multi select the created boundaries.
2. For the ThermalFlowBC, set the Behaviour to Temperature and Tref to 283 K.
To assign the groundwater boundary conditions, the following steps are followed:
1.
2.
3.
4.

Multi select the top and bottom boundary.
For the GWFlowBC, set the Behaviour to Closed.
Select the left boundary, set the Behaviour to Inflow with a qref value of 0.1 m/day.
The right boundary has the default behaviour of Seepage.

The tunnel is created with the help of the Tunnel designer. Because deformations are not considered in this
calculation, there is no need to assign a plate material to the tunnel. The generated tunnel will only be used for
generating a more dense and homogeneous mesh around the freezing pipes. The tunnel will not be activated
during any calculation phase, but PLAXIS 2D will detect the line elements and will generate the mesh according
to these elements. Changing the coarseness factor of the pipe elements will cause a denser, but not a more
homogeneous mesh.
1.
2.
3.
4.
5.

Click the Create tunnel button in the side toolbar and click on (42.5 -18) in the drawing area.
The option Circular is selected for Shape type. Note that the default option is Free.
The default option of Define whole tunnel is used in this example.
Proceed to the Segments tab and set Radius to 3.0 m to the two multi selected segments.
Click on Generate to generate the defined tunnel in the model. Close the Tunnel designer window.

The geometry of the model is shown in the figure below.
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Figure 209: Geometry of the model

17.5 Generate the mesh
1. Proceed to the Mesh mode.
2. Click the Generate mesh button
to generate the mesh. The default element distribution of Medium is
used for this example.
3. Click the View mesh button
to view the mesh.
The resulting mesh is shown:

Figure 210: The generated mesh
4. Click the Close tab to close the Output program.

17.6 Define and perform the calculation
The calculations for this tutorial are carried out in the Flow only mode.
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17.6.1 Initial phase
1.
2.
3.
4.
5.

Click on the Staged construction tab to proceed with the definition of the calculation phases.
Double click on Initial phase in the Phases explorer.
In the Phases window select the Flow only option from the Calculation type drop-down menu.
Choose the Earth gradient option for the Thermal calculation type.
In the Staged construction activate the ThermalFlow under the Model conditions subtree and set the
value for Tref to 283 K, href to 0 m and 0 K/m for the Earth gradient.

Figure 211: Initial phase

17.6.2 Phase 1: Transient calculation
1. Click the Add phase button
to create a new phase.
2. Double click the new phase in the Phases explorer.
3. In the Phases window, enter an appropriate name for the phase ID (e.g. Transient calculation).
4. Set Transient groundwater flow
as the option for the Pore pressure calculation type.
5. Set Transient thermal flow
as the option for the Thermal calculation type.
6. Set Time interval to 180 days and the Max number of steps stored to 100. This is to be able to view
intermediate time steps after the calculation.
7. In Staged construction mode, activate all the thermal boundary conditions by clicking the check box for the
Thermal flow BCs in the Model explorer.
8. In the Model explorer, activate the four groundwater flow boundary conditions corresponding to the left,
top, right and bottom boundary conditions in the Groundwater flow BCs subtree.
9. In the Model explorer, deactivate the ThermalFlow condition under the Model conditions subtree.
The calculation definition is now complete.
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17.6.3 Execute the calculation
Before starting the calculation it is suggested that you select nodes or stress points for a later generation of
curves.
1. Click the Select points for curves button
in the side toolbar. Select some characteristic points for curves
(for example between two freezing pipes and in the middle of the model).
2. Click the Calculate button
to calculate the project.
3.

After the calculation has finished, save the project by clicking the Save button

.

17.7 Results
Interesting results from this calculation can be the point in time when there is no groundwater flow in between
two freezing pipes, groundwater flow over the whole model and temperature distribution for both steady state
and transient calculations.
To view the results in the Output program:
1. Click the View calculation results button
on the toolbar.
2. Select the menu Stresses > Heat flow > Temperature.
3. The figure below shows the spatial distribution of the temperature for transient calculation in the final step.

Figure 212: Temperature distribution for transient phase
1. Select the menu Stresses > Groundwater flow > |q|.
2. Select the menu View > Arrows or click the corresponding button
arrows.

in the toolbar to display the results

In the Output program, it is possible to view the results for the intermediate saved steps. More information is
available in the Reference Manual. It is possible to view the progression of the freezing of the tunnel.
The figure below shows the distribution of the of groundwater flow field for an intermediate step for the
transient calculation (around 80 days).
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Figure 213: Groundwater flow field for transient phase for an intermediate step (tapprox 38 days)
The figure below shows the groundwater flow field for the last time step for the transient flow calculation. Here
it is clearly noticeable that the entire tunnel area is frozen and no flow occurs.

Figure 214: Groundwater flow field after 180 days
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